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XXXXXXXXXXXXXX EMAIL was in 

my freshman year of college in 

1988. I attended Dartmouth, and 

we had a system named BlitzMail. 

Every student was granted an email 

address and access to the system. 

Like most students, I didn’t use it at 

all. It’s hard for even me to believe, 

but back then I was in the habit of 

writing letters and postcards.

I vividly recall the tipping point, 

though. In 1re years and my first job 

in PC Week’s lab in 1992 to actually 

start using it. Like a lot of corporate 

workplaces, email was commonly 

used for interoffice communications. 

But the volume wa989 in the middle 

of my sophomore year, I was eating 

lunch with a few freshmen who were 

talking about how great email was 

for chatting up women. I remember 

being shocked at the notion that 

these guys didn’t have the courage to 

pick up the phone. Little did I know. 

I’d be lying if I said that I took to 

email the next day. I didn’t. It took 

three more years and my first job 

in PC Week’s lab in 1992 to actually 

start using it. Like a lot of corporate 

workplaces, email was commonly 

used for interoffice communications. 

But the volume was manageable; I 

remember going two or three hours 

without new email. That sounds 

absolutely crazy now, but this was 

the era before SPAM even existed. 

As more friends started working 

and came online, the postcard- and 

letter-writing days ended forever. 

(That lab job was also awesome 

because after four years of using 

a Mac in college, I was able to get 

back to PC gaming—after hours, of 

course.)

I’ll be honest; I still love checking 

my inbox and discovering email—

from friends, family, writers, 

readers, PR people, whomever—even 

if it has become a bit overwhelming. 

Between re years and my first job 

in PC Week’s lab in 1992 to actually 

start usingaccounts, I’ve never had 

trouble keeping up. Until now. This is 

partially what inspired this month’s 

cover story. Over the last 18 months, 

I’ve begun to notice that my ability to 

quickly parse, read, and respond to 

email just isn’t fast enough anymore. 

I need to develop new systems and 

shortcuts. I need to change my ways. 

I’m curious—are you finding 

yourself in the same boat as I am? 

If so, what have you done to better 

manage your email life? Let me know 

at George@maximumpc.com. 

XXXXXXXXX
Finally, the winners of last month’s 

challenge to identify the fake Google 

app icon. For those scoring at home, 

the correct answer was Google 

Storage. Here are the winners: Keith 

Lucas (who was the first correct 

response), Andy Man, Chris Brush

Gordon Mah Ung is Maximum PC’s 

deputy editor, senior hardware 

expert, and all-around muckraker.

XXXXXXX
XXXXXXXX

↘ submit your questions to: comments@maximumpc.com

Gordon 
Mah Ung
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Tuan 
Nguyen

WE SPEND A LOT OF TIME fussing about 

with hardware. Tinkering, tweaking, and 

otherwise trying to squeeze out every 

last drop of GPU and CPU performance. 

You can find endless amounts of 

resources that tell you what you should 

and shouldn’t do with your hardware. 

But very little attention is given to the 

operating system side of the computer, 

which is unfortunate, because that’s 

ultimately where the results matter the 

most. So we’ve gone and done just that.

Windows 10 is, without doubt, one of 

Microsoft’s best releases of Windows. 

It’s well made, stable, and chock-full of 

features—some of which you may not 

actually want or use. Take, for example, 

Cortana, the smart assistant not unlike 

Apple’s Siri, Amazon’s Echo, or Google 

Assistant. Sure, it can tell jokes, look up 

information on Wikipedia, and search 

your computer, but I personally don’t 

use it. I reckon my keyboard skills can 

get me what I need much faster. So I 

disable it, freeing up system resources 

for other duties.

Things don’t end there, though. There 

are other areas of Windows 10 that you 

can dive into, and with a little know-how, 

gain just not increased performance 

from your PC, but enough performance to 

witness actual usability improvements. 

Startup options, system services, 

clearing out old system update files, and 

more—our crack team of experts show 

you a wide range of pro-level tricks to 

take your rig by the horns.

Some of you might be thinking to 

yourselves, “Well, I’ve done all that, 

but tell me what’s going to give me 

giant leaps in performance on my next 

upgrade.” The answer might surprise 

you: displays.

Earlier this year, at CES, I witnessed 

a flurry of display announcements. 8K 

displays finally debuted, with some 

companies showing working demos. 

HDR is on the rise, primarily in HDTVs, 

but it’ll no doubt show up in computer 

displays this year. Refresh rates are 

going up, too, and a new HDMI spec was 

announced, delivering 4K resolution at an 

astonishing 120Hz. The display industry 

is moving forward at an ever-increasing 

rate, and this will also push the PC.

So, we took it upon ourselves to 

bring all the newest bad-ass displays 

into the lab, and run them through our 

tests. Some are better than others, 

but one result is consistent across the 

board: Current displays have advanced 

significantly in just a few years.

Which brings me to my sage advice: 

Invest in a display. A good display is 

always the most expensive part of my 

build, because I spend all my computing 

time staring at it, and a good display will 

outlast your PC, for the most part. You 

might upgrade this and that inside, but 

the screen will be there for some time. 

What do I use? Two 32-inch 4K 

displays. But with 8K on the way, I’m 

starting to get an itch.ts. 

es, 

nd

ow

to 

to

starting to get an itch.

THE NEVER-ENDING 
PURSUIT OF MORE 
PERFORMANCE

Tuan Nguyen is Maximum PC’s editor-in-
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stick.” He’s been writing, marketing, and 

raising hell in the tech industry for 20 years.
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Commercial 3D memory finally arrives

Intel’s Optane 
Technology Ships

individual transistors. These 

first modules have two layers 

of memory cells, but three-

layer cells are due later in the 

year. The exact physics and 

manufacturing method has yet 

to be revealed. 

Intel’s announcements about 

Optane veer into hyperbole. 

It will “change the face of 

computing with an unparalleled 

combination of speed, 

endurance, and density.” These 

first modules are about three 

times faster than a standard 

SSD in random and sequential 

read. Write speeds are less 

impressive—still capable of 

beating SSDs, but by much 

slimmer margins. The 32GB 

module manages 1,600MB/s on 

reads and 500MB/s on writes. 

Latency is between SSD and 

DRAM. We have nothing on 

price yet, but they won’t be 

cheap. Expect to pay around five 

times the price of flash RAM, or 

twice that of DRAM.

Sure, they are fast, but 

you are right to feel a little 

underwhelmed at this point. 

This doesn’t beat emerging 

NVDIMM or NVMe technology, 

and isn’t what we were 

promised. Early presentations 

about 3D XPoint spoke of speed 

boosts of up to a thousand times 

SSD, and touched on the long-

held dream of unified RAM and 

storage. Alas, these claims have 

proved elusive. The tantalizing 

early proclamations were 

based on the core performance 

of the chips at the cell level. 

Once it goes through all the 

subsystems of the hardware and 

software, the speed is degraded 

considerably. Perhaps it might 

have been wiser not to publicize 

such appetizing claims in the 

first place. 

Larger capacity SSD versions 

are currently being tested in 

servers by IBM and Facebook. 

Before the end of the year, we 

will see more mainstream 

applications, which currently 

sport “Beach” codenames—

Mansion Beach, Stony Beach, 

and Carson Beach—each a 

family of Optane SSDs running 

on PCIe or SATA. Its future as 

a DRAM replacement is less 

obvious. Conventional modules 

are already cheap and fast, but 

its use in servers cannot be 

far away.

Optane is having a slightly 

difficult birth, and the 8000p is 

a bit of a dull start. However, 

a huge research budget and 

much effort has been poured 

into its success. This is just a 

taster. A single unified high-

speed memory is still a long 

way away, but we do have 

commercial 3D memory that is 

already faster than NAND, and 

has an interesting roadmap. 

You will be hearing a lot more 

about Optane. –CL

THE LAUNCH of an M.2 SSD 

memory module is not 

normally of much interest, but 

Intel’s new 8000p is based on 

the company’s new Optane 

technology, which has been 

several years in the making, 

and responsible for quite a few 

promises along the way. The 

modules come in 16GB and 32GB 

sizes, and you’ll need a specific 

set of hardware to run them: a 

Kaby Lake chip, a 200-series 

chipset, a compatible M.2 slot, 

and a compatible BIOS. They 

have been designed to boost 

Intel’s Rapid Cache Technology 

performance, and a small 

number of machines have been 

announced that are Optane-

ready, among them Lenovo’s 

ThinkPad T570 and HP’s Envy 

Curved 34.

Optane is Intel’s brand name 

for the 3D XPoint technology, 

a 3D memory system jointly 

developed by Intel and Micron. 

The tech has been in the labs 

since 2012. Memory cells sit in 

a three-dimensional mesh, and 

use the change in resistance 

of the materials to store data. 

Importantly, there are no 

Memory cells sit in a 3D
mesh, and use the change 
in resistance to store data. 

Not quite what we were expecting, but it’s a start.
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THE CHINESE MINISTRY of Industry and 

Information has announced the start of a 

14-month campaign to target the use of 

VPNs in China to “clean up” the Internet, 

and encourage the “healthy” development 

of the industry. Running a VPN business 

inside China will now require a state license, 

and presumably close co-operation with the 

authorities. President Xi Jinping recently 

delivered a speech to the World Economic 

Forum on the benefits of opening up 

world trade and world borders. The irony 

is palpable.

Details on the new rules are a little 

vague, but the clear targets are businesses 

inside China who provide VPNs for its 

citizens. The firewall that surrounds 

China has also started blocking VPN sites. 

Large corporations are unaffected so 

far. VPNs are popular in China to access 

otherwise blocked sites, such as Google and 

YouTube, and evade censorship on specific 

subjects, principally anything concerning 

dissatisfaction with the state. 

The Internet arrived in China in 1994, 

and the state started to attempt to control 

it in 1998; a firewall for the entire nation 

followed in 2003. China’s efforts to control 

the Internet were initially greeted with much 

skepticism in the West. The Internet was 

seen as too porous and too distributed to 

be stopped. While it is still difficult to stop a 

determined individual, the state has proved 

remarkably effective at suppressing the 

curious. In China, you expect to be tracked, 

and self-censorship is natural.

Meanwhile, in the rest of the world, VPNs 

are free to use and popular, even if the 

authorities aren’t always keen on the uses 

they are put to. China has shown that it is 

possible to effectively control what it was 

once thought almost impossible to police. 

Let’s hope nobody else gets any ideas. –CL 

PRESS WINDOWS AND G in the latest 

Windows Creator Update, and you 

enter the much anticipated Game 

Mode. As expected, it’s mostly about 

resource allocation, specifically CPU and GPU resources to the game, getting all 

processor cores running effectively, and keeping the GPU focused on the game 

graphics. The emphasis is not so much on performance increases—these are 

marginal, at 2–5 percent—but to get Win 10 rigs, Xbox One, and the forthcoming 

Scorpio console to offer a consistent experience. The target standard is 900p 

to 1080p for Xbox One, and 4K at 60fps for Scorpio. The “Games” section in 

“Settings” sports the Xbox logo, and here you can configure each game. Win32 

support has been confirmed, too, which is welcome. You also have game 

streaming via Beam, and a new Game DVR settings page. It’s about blurring the 

lines between platforms, and focusing on a consistent game experience. –CL

GAME MODE 
GOES BETA
It’s all about 
consistency

Free trade for China, 
but no free Internet

THE LAST TWO BIG PLAYERS making 3D TVs—

LG and Sony—are to drop their support with 

this year’s models. The format is dead, for the 

mass market at least. Lack of content was obvious; there was very little broadcast 3D, and 

even that has now stopped. Enthusiasm from consumers dropped off sharply, and the TV 

people’s attention has shifted to HDR and 4K. 3D content will live on, but only through VR. 

3D TVs came on the back of 3D movies, which appeared in sporadic waves since the 

1950s, each powered by new technology. The first wave lasted just three years, and the 

revivals fared little better. The current dalliance with 3D movies has at least attracted some 

big budget titles, but there are signs that this is fading, too. The odds are that 3D will return 

at some point, probably using yet another technology, but for now you had better start 

hoarding those 3D Blu-rays if you want any use out of your 3D TV. –CL

CHINESE BAN 
ON VPNS

A monthly snapshot of what’s up and down in tech  
Tech Tragedies and Triumphs

TRIUMPHS TRAGEDIES
DRONEGUN

We now have ray guns that can shoot 

down drones with concentrated 

electromagnetic radiation—not 

available to the public yet, though. 

INTEL BACKS 7nm

Intel is building a pilot plant  

to develop the 7nm process.  

Moore’s Law still has legs. 

GOOGLE PARKING

Google Maps will now include  

a color-coded guide to how  

difficult it is to park at your 

destination. Handy.

BURNING LAPTOPS

HP has recalled over 100,000 

laptop batteries over issues with 

overheating and possible fires. 

WIN 7 NOT SECURE

It still has three years of official 

support left, but Microsoft has 

warned that Windows 7 is now 

intrinsically insecure.  

APPLE SLUMP

Apple’s share of the market has 

dropped to 6.1 percent of PCs 

online, down from 9.6 percent 

barely a year ago.

3D TV IS DEAD
NO NEW HARDWARE 
IS BEING BUILT
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Jarred Walton

TECH TALK
The Current State of 
Integrated Graphics

The good news is that Intel started putting more 

effort into improving graphics when it created HD 

Graphics, in 2010. The latest iteration is its 600 

series, in the new Kaby Lake CPUs, which is largely 

the same as the 500 series. A huge chunk of the 

processor is devoted to graphics—roughly one third 

of the die. But even so, performance isn’t stellar.

I ran tests on 15 modern games, and even at low 

quality settings and 1280x720, less than half were 

playable. But there is some good news in that all 15 

games rendered without any noticeable errors. Less 

demanding games such as Overwatch, League of 

Legends, Counter-Strike: Global Offensive, Dota 2, 

and many indie titles are also definitely playable.

Perhaps more interesting is what Intel has 

been doing over the past seven generations of 

Core processors. Intel more than quadrupled its 

mainstream integrated graphics performance 

going from first-gen to third-gen Core, but since 

then, most of the desktop parts (Broadwell being 

the exception) haven’t seen much improvement. In 

raw computational power, the fastest GT2 variants 

of Intel’s HD Graphics have sat in the 400-450Gflops 

range since Haswell’s HD 4600 in late 2012.

AMD is only slightly better, with its top APUs, like 

the A10-7890K, sitting at 887Gflops, while lower-tier 

parts like the A8-7670K (581Gflops) and A6-7470K 

(410Gflops) are well off the pace. More critically, 

all of these parts, including desktop Skylake and 

THE WORLD OF INTEGRATED GRAPHICS has a long and storied history, 

most of which can be summed up as: they’re too slow and lacking in 

functionality. For years, the most “popular” graphics chips have been 

Intel’s, not because they were fast but because they were ubiquitous.

Kaby Lake at 440Gflops, are less 

than half the performance of the 

GTX 1050 (1,733Gflops) and RX 460 

(2,150Gflops) that represent entry-

level dedicated GPUs. That’s a big 

part of why most gamers end up 

running a dedicated graphics card.

Other factors include sharing 

system memory bandwidth. Even 

with two or three times as many 

GPU cores, without increasing the 

memory bandwidth, a lot of potential 

performance is lost. An HBM2 cache 

is a potential solution, and Intel has 

used eDRAM caches with its Iris 

products, but few desktop users are 

interested in improving integrated 

graphics when a quick upgrade to 

a dedicated graphics card can more 

than double performance.

Consoles are a different matter, 

where economies of scale come 

Jarred Walton has been a 
PC and gaming enthusiast 
for over 30 years.

into play, and by targeting a closed 

platform, manufacturers can do 

more with less. The PS4’s custom 

AMD processor uses about two-

thirds of the die space on graphics, 

with the relatively slow Jaguar CPU 

cores relegated to one eighth of 

the die. The PS4 also uses GDDR5, 

with a 256-bit interface clocked at 

5,500MT/s, with over four times the 

bandwidth of a dual-channel DDR4-

2667 configuration, and the PS4 Pro 

should double GPU performance.

I’m eager to see what AMD does 

with the upcoming Zen APUs. Will 

it include a high-speed memory 

cache, along with substantially 

more GPU cores? It could, and 

I’ve seen rumors of an APU with 

potentially 1,024 Vega GPU cores—

twice the number found in AMD’s 

current top APUs. Combined with 

stacked memory (a single 2–4GB 

HBM2 stack, perhaps), AMD could 

end up surpassing the performance 

of its RX 460. Certainly, AMD has 

the expertise to pull this off, but 

I’m not convinced it will be enough 

to capture the interest of gamers, 

with price being a major factor. AMD 

might end up cannibalizing sales of 

its $100-200 graphics cards in order 

to sell more $100-200 APUs.

A quick upgrade to a dedicated 
graphics card can more than 
double performance.

AMD’s Kaveri APU uses half the die 
space on graphics functionality.
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LG NANO CELL
TECHNOLOGY
LG is innovating on top 

of quantum dot by 

shrinking the 

pixel size down 

to a single 

nanometer to 

improve viewing 

angles, even 

beyond the limits 

of IPS and VA.

AMD FREESYNC 2
The revolution of AMD’s variable refresh 

rate. Similar to G-Sync, AMD is now 

enforcing standards 

including 

low latency 

and HDR.

RAZER PROJECT VALERIE
Although not to everyone’s liking, this 

triple-screen gaming notebook touts a 

total resolution of 11520x2160.

MSI AM4+ MOTHERBOARDS
With Ryzen launching in the first quarter of 

2017, AM4+ mobos are coming thick and fast. 

1 iBUYPOWER 
PROJECT SNOWBLIND
The transparent LCD screen was first seen at 

Computex last year. Acting as a second display 

via HDMI, you can run anything you want on it.

2 ASUS ROG SWIFT PG27UQ
Meet the future of monitors—once graphics 

cards catch up. The PG27UQ combines 4K, 

144Hz, G-Sync, and HDR in one sexy package.

3 AMD VEGA GPU
The future’s bright for AMD’s next-gen GPUs. 

With HBM 2.0 and impressive compression 

tech, that 4K screen might have a use after all.
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The first big thing that offers promise is the Vulkan 

graphics API, the spiritual successor to OpenGL. As 

an open API, Vulkan has promised a cross-platform 

API for developers who want to develop for Linux, 

Windows, Mac, and even mobile devices. (The API 

also shipped with support for the modern Wayland 

graphics server.) The API spec was published in 

early 2016, and hardware released during the year 

offered support for Vulkan. However, very few 

games offered support, with most released in 2016 

opting for DirectX 11 or 12. Id Software’s id Tech 

6-powered Doom was a notable exception, showing 

the blistering-fast performance that Vulkan offered. 

Epic’s Unreal Engine 4 also supports the API.

With a high-performance, modern graphics API 

available for Linux, one would thing there would 

be a tidal wave of AAA games for Linux. That wave 

hasn’t come. A quick scan of a list of games with 

Vulkan support on Wikipedia shows eight games 

written for Vulkan. Only two of those (Dota 2 and The 

Talos Principle) are available on Linux. (Id’s Doom is 

curiously Windows-only, breaking from id’s history 

of releasing shooters for Linux as well as Windows.)

There simply aren’t many games written for 

Vulkan yet, but given time, that will change. The 

percentage of those games that are released for 

Linux might not, however. The big reason developers 

shy away from Linux development 

is understandable. The market is 

minuscule compared to the number 

of gamers on Windows, and Linux 

presents a moving target in terms 

of libraries and drivers. Anyone 

who’s broken something like Wi-Fi 

or Bluetooth support because of an 

update knows what I mean. That 

means a huge headache for very 

little return for a game dev shop. 

But there are a few new packaging 

technologies that aim to fix that.

Universal Linux “container” 

formats are one of the most 

important new ideas for desktop 

users. They differ slightly from 

container technologies such as 

Docker, and aim to unify the Linux 

application distribution space.

These technologies promise to 

allow developers to package their 

apps with the libraries that they 

Alex Campbell is a Linux geek 
who enjoys learning about 
computer security.

Linux is a moving target in 
terms of libraries and drivers; 
a huge headache for very little 
return for a game dev shop. 

Alex Campbell

OPEN SOURCE

Vulkan Can’t Bring 
Games to Linux by Itself
FOR YEARS AND YEARS, being a Linux user meant giving up on the idea 
of playing top-tier games when they’re released. For the most part, 
that’s still true, but technologies are emerging that will make it easier 
for developers to distribute games for Linux. Unfortunately, these new-
fangled technologies don’t solve all of the underlying issues.

need. The formats allow them to 

stop chasing library updates, and 

distribute software images that are 

known to run on the vast majority of 

Linux systems without issue.

These formats also aim to 

unify distribution in the face of the 

fracturing caused by each distro’s 

package management solution. 

Debian, Ubuntu, and Mint have 

deb; Fedora and openSUSE have 

RPM; Arch and Manjaro use tar.xz; 

Gentoo builds everything from 

source because why the hell not? 

This landscape is hell for software 

distribution (and creates a lot of 

work that volunteers have to do).

Unfortunately, the three new 

competing formats—flatpak, snap, 

and AppImage—suffer from the 

same problem, in that there’s three 

of them. Hopefully, 2017 will see a 

clear winner pull ahead of the pack. 

But even if one does, and developers 

have a clearer and more stable 

platform to target, the chicken 

(penguin?) or the egg problem will 

likely persist: There aren’t many 

gamers on Linux because there 

aren’t many games for Linux, and 

there aren’t many games for Linux 

because there aren’t many gamers.

Doomed? Actually, things are 
looking up for Linux gamers, but 
there’s still much work to be done.







BY MATT HANSON

No matter how careful you are online, you can still be at risk of picking up a nasty virus 
or other malware. If you don’t want to shell out for an expensive (and resource-hogging) 
antivirus app, there are plenty of free tools to keep you protected. Far from being cut-down 
and basic, even these free programs come with plenty of features to protect your PC. But are 
they too good to be true, and how do they compare to the built-in protection that Windows 
offers? We pit three of the most popular free antivirus tools against each other to find out.

AVG AntiVirus vs. Bitdefender 
Antivirus vs. Microsoft Defender

ROUND 1 ROUND 2

Ease of Use

We want our antivirus app to 

be unobtrusive, and keep us 

protected with the minimum of 

fuss. In that regard, Windows 

Defender has a huge advantage, 

as if you’re running a recent 

version of Windows, it is already 

installed and configured. 

Downloading and installing 

Bitdefender is straightforward, 

scanning your PC during 

the process. The interface 

is streamlined and easy to 

understand, and the Autopilot 

mode means you can leave it 

alone to get on with protecting 

you. To scan specific files, just 

drag and drop them. 

AVG’s interface has simple 

indications letting you know if 

your PC is protected, and a big 

button to scan your system. It’s 

not as hands-off as the others, 

but installation is simple. You’re 

encouraged to install a browser 

plugin to protect you while 

online, but it tries to change your 

homepage and default search 

engine, which we don’t like.

Tie:

Windows Defender  

and Bitdefender

Features

Defender has virus, malware, 

and spyware detection and 

removal. Real-time protection 

monitors downloaded files. 

There’s no firewall. Cloud-

based protection defends 

against threats identified on 

other users’ PCs. It comes 

preinstalled, with no ads or pop-

ups nagging you to upgrade.

The free version of AVG 

features virus, malware, and 

spyware protection, and real-

time security updates. Unlike 

Defender, it comes with a plugin 

to protect you from unsafe 

links, downloads, and email 

attachments. A gaming mode 

(that cuts down on resources 

used) is welcome, but if you 

want firewall or phishing 

protection, you must pay.

Bitdefender offers similar 

features as AVG, plus comes 

with Autopilot mode, which 

configures security settings 

on the fly, enables automatic 

updates, and more, with no 

annoying pop-ups, but AVG’s 

gaming mode gives it the edge.

Winner:

AVG

AVG AntiVirus 
also comes 
with a browser 
plugin for 
protection 
when surfing 
the Internet.

Bitdefender 
Antivirus is 
both speedy 
and highly 
effective 
at spotting 
nasties.

Windows 
Defender is 
preinstalled 
with Windows, 
and never 
nags you to 
shell out for 
an upgrade.
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ROUND 3 ROUND 4 ROUND 5 And the
Winner 
Is…
Every one of these AV tools 

has something going for it, 

be it Windows Defender’s 

convenience, Bitdefender’s 

excellent detection rate, or 

AVG’s speed and lightness. If 

you go with Bitdefender, you 

can be sure your PC is as well 

protected as possible for a 

free program, and if you just 

stick with Windows Defender, 

you’ll at least be protected 

against the majority of threats.

However, the overall winner 

of these tests is AVG. It comes 

with plenty of features, has an 

excellent detection rate, and 

decent scanning speeds. What 

we really love, though, is how 

few resources it takes up when 

running in the background, 

or even when scanning your 

computer. It does a great job 

of protecting your PC, while 

having almost no impact on 

performance—like all good AV 

products, you’ll hardly know 

it’s there. 

Resource Use

Antivirus software can be 

very resource hungry. With 

Microsoft’s knowledge of 

Windows, you’d think Defender 

would have an advantage here. 

While performing a full scan, it 

took up a peak of 275MB of RAM, 

with CPU use (a powerful quad-

core Intel Core i7) hovering 

around 54.6 percent. When not 

in use, it used 152MB of RAM.

Bitdefender was much more 

resource-intensive. When idle, 

it used around 180MB of RAM, 

but when scanning, it had peaks 

of 780MB RAM use (though 

around 400MB for most of the 

scan time), and CPU usage 

spiking at 98 percent, averaging 

about 70 percent. The price to 

pay for such fast scanning.

Meanwhile, we were very 

impressed with the impact of 

AVG. At idle, the software takes 

up 130MB of RAM, while in use 

it only takes up around 160MB. 

Better still, CPU use never went 

higher than 14 percent—a far 

cry from the stress Bitdefender 

puts the PC under.

Winner:

AVG

Scan Speeds 

On our test machine, Windows 

Defender completed a Quick 

Scan in one minute, scanning 

11,288 files. We then performed 

a deeper scan on a full 100GB 

hard drive, which completed in 

26 minutes, 42 seconds. Next 

up was Bitdefender, and the 

initial Quick Scan took just 49 

seconds. With the free version 

of Bitdefender, scan choices are 

a bit limited, so we dragged and 

dropped the entire 100GB folder 

on to the program to scan. That 

took just seven minutes, 10 

seconds, which is a lot quicker 

than Windows Defender.

AVG doesn’t have a Quick 

Scan option, though it offers lots 

of ways to configure scans, so 

they only check the bits of your 

PC you want. The default is a 

full, deep scan. This is advisable 

with all AV products, to make 

sure your PC is completely safe. 

However, with our custom scan 

of the 100GB hard drive, it took 

9 minutes, 48 seconds. Much 

faster than Windows Defender, 

but not as quick as Bitdefender. 

Winner:

Bitdefender

Virus Scanning 

In the latest AV Comparatives 

benchmarks (which are 

carried out by an independent 

company), Bitdefender blocked 

1,618 out of 1,619 test cases 

successfully, with a protection 

rate of 99.9 percent. AVG didn’t 

catch quite as many, with 1,612, 

and 99.6 percent. Windows 

Defender caught 1,570 test 

cases, for a protection rate of 

97 percent. That’s still high, but 

not quite as good as the other 

two AV products on test.

AV Comparatives also 

tested the programs for false 

flags—these are safe files or 

websites that are incorrectly 

identified as harmful, and 

blocked by AV programs. Both 

AVG and Bitdefender passed 

the tests with no wrongly 

blocked files or websites, but 

Windows Defender incorrectly 

blocked 23 cases. While it’s 

a close call between AVG and 

Bitdefender (with Bitdefender 

just edging a win), Windows 

Defender’s performance was 

rather disappointing.

Winner:

Bitdefender
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THIS MONTH THE DOCTOR TACKLES...

↘ submit your questions to: doctor@maximumpc.com

Workstation Power
Hi Doctor. My son is a 3D digital 

design student at Rochester 

Institute of Technology (RIT). 

We purchased a Lenovo P700 

system for his design work and, 

of course, gaming. He uses 

applications such as Maya, 

RealFlow, and Adobe’s CC suite.

He’s having an issue setting 

up his hardware to reduce the 

time it takes to render projects 

in Maya—they take as long as 30 

hours to complete. I don’t think 

adding more memory will help, 

and he’s already running dual 

Xeon processors, with a pretty 

good graphics card.

We looked for ways to 

better utilize both processors, 

but can’t figure that out. He 

also thinks a second graphics 

card might help, but can’t find 

documentation supporting his 

hypothesis. Any ideas you have 

would be greatly appreciated.

–Dave Fantauzzo

THE DOCTOR RESPONDS: The 

Doc is well versed in matters 

of hardware, but less familiar 

with Maya, and the resources 

its renderer exploits. To get you 

the best answer, the Doc went 

to his friends at Puget Systems 

in Auburn, Washington, who 

test and write about optimizing 

configurations for workstation 

applications. Matt Bach, in 

Puget’s lab, sent over the 

following guidance: “If faster 

render times from Maya are 

your primary concern, the 

solution isn’t quick or easy. 

You are correct that more 

RAM likely won’t help (32GB is 

typically plenty), and as Maya 

uses a CPU-based rendering 

engine, upgrading the GPU 

won’t improve render times 

either. The weakest link in your 

son’s dual-Xeon workstation 

is the CPUs themselves. Two 

Xeons can work very well for 

rendering, as they scale nicely 

with higher core counts, but 

the E5-2609 v3 is only one step 

up from the lowest-end CPU of 

that generation. Upgrading a 

dual-Xeon setup isn’t as cheap 

as adding RAM, but it’s the only 

thing that will help significantly.

“For rendering, the Xeon 

E5-2630 v3/v4 is usually the 

lowest-end dual-CPU config 

we recommend to one of our 

customers. Compared to the 

E5-2609 v3s your son has today, 

a pair of E5-2630 v3s could be 

expected to drop that 30-hour 

render to 17 hours or so. You 

could use a cheaper CPU, but 

anything lower than the -2630 

will typically be outperformed 

by a 6- to 10-core 3GHz-plus 

single-CPU system, which is 

also more affordable. If you 

have the budget to go higher 

than the E5-2630, a quick rule 

of thumb for rendering is to 

use Xeon CPUs that end in a 0 

(-2630, -2640, -2660, and so on).

“Keep in mind that many of 

the other tasks you mentioned 

(gaming, Maya modeling, and 

all Adobe software) do not work 

well with dual-Xeon systems. 

There is extra processing 

overhead when you have two 

physical CPUs, and unless the 

software is good at utilizing 

multiple cores at the same 

time—as rendering is—you 

often get better performance 

with one CPU than with two. In 

fact, for gaming and modeling/

animation, four cores running 

at high clock rates yield much 

better performance.”

Mixing Memory
Dear Doctor, When it comes to 

memory, if I’m using the same 

brand and speed, does it matter 

if I install two 16GB modules 

with a CAS rating of 14 and two 

4GB sticks at CAS 16? Both 

would be DDR4-3200. Or would 

a slower data rate at CAS 12 be 

better? I’m doing some gaming, 

Lenovo’s ThinkStation P700 may require higher-end CPUs for 

optimal rendering performance.

quickstart
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surfing the net, and watching 

old Tarzan movies. If I overclock, 

it’ll be conservative.

I also have a Samsung M.2-

based boot drive and a Samsung 

SSD for user data. If I use an 

external SSD for downloading 

Internet content, and that 

content is infected with a virus, 

would only the portable drive be 

affected, or could the contagion 

spread to other devices? A $60 

external drive lost to cooties 

would be far better than the 

permanent drives.

If this helps, I plan on buying 

a Core i7-6700K, an MSI Gaming 

M7 or Asus Maximus VIII Hero 

motherboard, a Corsair H110i 

GT cooler, a Samsung 850 EVO 

500GB M.2, a Samsung 850 

EVO 1TB, an MSI GeForce GTX 

1080, and a Be Quiet! Dark Base 

900 chassis. –Ray Nimeth

THE DOCTOR RESPONDS: Let’s 

start with your memory 

question. The answer isn’t 

straightforward because 

it depends on a number 

of variables. First, there’s 

your motherboard’s BIOS. 

Depending on how the firmware 

was written, it might choose 

the slowest common memory 

settings, the memory settings 

from a preset priority list of 

slots on the board, the serial 

presence detect (SPD) settings 

from a random module, or 

it could refuse to boot when 

presented with conflicting SPD 

information. The memory chips 

on those modules could also be 

incompatible due to different 

densities or capacities.

So, there’s a lot that could go 

wrong—if you have the option to 

avoid mixing kits, take it.

If you already have them 

both, try installing the modules 

in alternate slots, so that the 

kits each populate one channel. 

Check your manual for guidance 

on where to put the higher-

capacity modules. Should your 

system boot successfully at 

low baseline settings, dial in 

manual settings for the data 

rate, CL timings, command 

rate, and voltage (that is, don’t 

use XMP). Specify the lower of 

the settings between both kits.

Should you run into trouble 

booting up, try resetting the 

BIOS settings to default. If the 

issue persists, you’re likely 

out of luck. Don’t be surprised 

if this is the case; it could be 

that the capacity differences 

between 16GB and 4GB 

modules are simply too great.

In regard to your external 

drive question—yes, any virus 

on one drive can potentially 

affect other drives as well.

The Right Connection
Hello, I’m a long-time 

subscriber, going back to the 

days of Boot. In the January 

2017 issue, editor-in-chief Tuan 

Nguyen’s Lab Notes article 

“Short Circuits” intrigued me, 

as I recently built a new system. 

I double-checked and verified 

that I was using both the CPU_

FAN and CPU_OPT headers, 

which Tuan warns against doing.

I’ve had the system for a 

month and have had no problem 

whatsoever. It consists of a Core 

i5-6600K attached to a Gigabyte 

Z170X-Gaming 7 motherboard, 

with a Corsair H60 CPU cooler. 

The radiator fan is connected to 

the CPU_FAN header, while the 

pump is connected to CPU_OPT. 

I left it as-is for the moment 

because, like I said, zero 

issues. Thoughts? –Mike H.

THE DOCTOR RESPONDS: Tuan 

was having issues with an Asus 

board; that company’s support 

folks advised against using both 

headers concurrently to avoid 

the problem he encountered.

The Doc consulted Gigabyte 

about your motherboard, and 

was told that the CPU_FAN 

and CPU_OPT headers can be 

used together without an issue. 

CPU_FAN is either for a heat 

sink or radiator fan that can 

ramp up and down based on 

CPU temperature; CPU_OPT is 

an additional header that can 

provide 100 percent power all 

the time to the pump. Each has 

its own IC to control amperage 

limits. You’re in the clear.

Reinstalling Win 10
I have a Lenovo laptop that 

came with an OEM copy of 

Windows 8 and a UEFI firmware. 

I upgraded to Windows 10 on 

my own, and it was working 

well. Unfortunately, the OEM 

diagnostic software still thinks 

I’m using Windows 8.

I’d like to remove everything 

and reinstall from a Windows 

10 Home disc. However, it is my 

understanding that because 

the laptop has UEFI, it requires 

the original OEM partitions to 

boot. In other words, I can’t 

delete the OEM partitions and 

software before performing a 

full reinstallation.

Is there any way around this 

requirement, and how does one 

get a laptop with no operating 

system to perform its own 

installation? –Gerald Gibson

THE DOCTOR RESPONDS: 

Updating an older system 

to Windows 10 sometimes 

requires a BIOS/UEFI update. 

For anyone else considering 

this, depending on how old the 

laptop is, it may or may not 

support Win 10, or you may run 

into driver limitations.

That said, if you have an 

optical disc drive, Windows 

10 Home media, and the 

key, there should be nothing 

preventing you from starting 

afresh. Update the UEFI by 

downloading the latest version 

from Lenovo’s website. Pop the 

disc in your drive, and ensure 

your firmware is configured 

to look there first upon boot. 

Or, visit http://go.microsoft.

com/fwlink/?LinkId=691209 

to download Microsoft’s media 

creation tool.

Jumping to X99
Hey, Doc! I got my hands on a 

Core i7-6850K for a great price, 

and I’m wondering whether 

I should make the jump to 

X99? I still need to buy a new 

motherboard and RAM.

I have a Core i7-4790K on the 

Z97 chipset, and that’s working 

fine for me, but I’d like to take 

advantage of the additional 

cores, PCIe lanes, and support 

for full-speed M.2 drives. I want 

to get the most from my ROG 

Swift PG279Q, a task I suspect 

may require two GPUs.

However, I’ve heard that the 

LGA-2011 v3 interface won’t be 

used for Skylake-X and Kaby 

Lake-X. And some of the new 

Z270 boards that are coming 

out look quite tempting as well, 

especially with their support for 

Intel’s upcoming Optane tech.

I mostly do digital drawing 

and gaming, though I do use 

virtual machines from time to 

time. Do you think I’d be better 

served making the jump to 

the enthusiast X99, or finding 

some other use for my new CPU 

and sticking with consumer 

platforms like Z270 or (gasp) 

AMD’s Ryzen? –Jordan S.

THE DOCTOR RESPONDS: The Doc 

wouldn’t jump to X99 for gaming 

alone; your fast quad-core CPU 

is fine for that. Plus, a single 

GeForce GTX 1080 or 1070 will 

drive your QHD display well 

enough in the latest games. 

Even if you do crave more 

graphics performance, two x8 

slots are plenty for CrossFire 

or SLI. But virtualization does 

benefit from lots of cores and 

cache. That could be reason 

alone for you to make the 

switch, if the workload is 

important enough. 

Gigabyte’s Z170X-Gaming 7 supports simultaneous use of its  

CPU_FAN and CPU_OPT headers.
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Never before has the high-end PC monitor 
market been so vibrant and innovative. 
Allow Jeremy Laird  to help you solve this 
particular paradox of choice 

BIG-SCREEN 
DEBUT
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A WINDOW INTO YOUR COMPUTING WORLD. That’s 

what a PC monitor is. The question is, do you want 

your view to be a miserable, letter-box glimpse, or 

a broad, expansive, and liberating vista?

OK, that’s a loaded way of posing the problem of 

screen choice. It ain’t all about size. In fact, at the 

high end, generous proportions are a given. So it’s 

all the rest that you need to worry about: panel type, 

native resolution, and pixel pitch, for instance.

But that’s just the basics. The PC monitor market 

is more complex than ever. That begins with a much 

broader choice of shapes and sizes. You can go 

seriously big these days. You can also go seriously 

wide, thanks to 21:9 aspect ratio panels. And you 

can go curved for a wrap-around experience.

Meanwhile, several spectacular new image-

enhancement technologies have emerged over the 

last two years. It wasn’t that long ago that refresh 

rates for LCD monitors were stuck at 60Hz. Now you 

can go up to 160Hz. Gamers can also opt for dynamic 

refresh rates synched with the output of their video 

card. Then there’s the widespread adoption of far 

higher resolutions, such as 4K or UHD.

Even more recently, there’s been a revolution in 

colors and contrast. HDR, or high dynamic range, is 

the latest technology to hit the display market. It’s 

already pretty much taken over the high-end HDTV 

segment. Now it’s beginning to assimilate monitors. 

However, the process will be more complicated 

on the PC, as if the practicalities of implementing 

HDR weren’t already complex enough. Point being, 

you’ll be able to pick and choose between various 

aspects of what has become known as HDR.

An example is quantum dot technology. It’s 

a color enhancement feature that isn’t strictly 

associated with increasing dynamic range, but 

it’s part of the broader HDR toolkit that’s 

finding its way into PC monitors. So, 

let’s dissect the high-end PC 

display market.
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LET’S TAKE A TOUR around the recent history of 

the high-end PC monitor. Remember when a 24-

inch widescreen monitor with a 1920x1200 native 

resolution constituted high end? We’re thinking 

2004, and the Dell 2405FPW. You can get something 

close to that for about 100 bucks today. Incredible.

About three years later, Dell shook things up 

again with the 3007WFP, a 30-inch 2560x1600 beast 

that was so spectacular at the time, it was hard to 

imagine anything bigger. But a further five years 

down the road in 2017, and the 3007 is toast.

Screen tech is advancing at breakneck speed. One 

moment you’re marveling at the latest superwide 

curved monitor, the next you’re having your entire 

field of view saturated by staggering HDR visuals 

courtesy of a 55-inch UHDTV, and every monitor 

you’ve ever used before suddenly seems tiny.

But let’s not get ahead of ourselves. Choices must 

be made. You can’t have everything in one monitor. 

For instance, let’s say you wanted a 4K screen with 

160Hz refresh, and 40-inch-plus diagonal. It can’t be 

had. So, you need to be clear on your priorities.

Let’s look at gamer-centric tech, including ultra-

high refresh rates. High refresh on the desktop is 

nice. It’s hard to go back to a 60Hz panel once you’ve 

experienced 120Hz-plus. But, arguably, anything 

above 120Hz for the desktop is redundant. Adaptive 

refresh technology, including Nvidia’s G-Sync and 

AMD’s FreeSync, is even more gamer-centric. If you 

don’t game much, you can probably ignore it.

Now let’s move on to size and shape. Your options 

are extensive and the choice subjective. It is also 

intimately related to native resolution. For starters, 

bigger isn’t always better. The UHD or 4K pixel grid of 

3840x2160 sounds impressive. On a 32-inch monitor, 

it gives a nice, tight pixel pitch, crisp fonts, and loads 

of detail. On a 50-inch panel, it’s a whole different 

ball game. At least, it is at normal PC monitor 

viewing distances. You can move further away with 

a larger panel, but if the apparent size is then the 

same, what’s the point? Likewise, is a screen hooked 

up to a PC while you sit on a couch 15 feet away a 

monitor or a TV? Similarly, it’s possible to go too 

big in terms of panel viewability. Beyond 40 inches, 

a screen situated at conventional monitor viewing 

distances requires a whole lot of head craning.

That said, many people who thought 30-inch 

panels were too big 10 years ago are probably happily 

running 32-inch or 34-inch monitors today. What 

feels unwieldy at first, can soon make reverting to a 

smaller screen seem restrictive. On a similar note, 

where do projectors fit in? A projector can never be a 

direct replacement for a PC monitor, yet nothing can 

compete with their sheer cinematic scale.

POINTS OF VIEW
Aspect ratio is another consideration. Superwide 

21:9-aspect monitors are gaining traction. They’re 

fantastic for movies. They work great with games. 

They can be thoroughly ergonomic for viewing 

multiple documents or web pages at the same time, 

too. But they’re also restrictive in terms of vertical 

resolution and desktop space. So, while you may 

be able to view documents side by side more easily, 

your view of each is more limited, which means 

more scrolling. The 21:9 aspect is also distinctly 

sub-optimal for standard 16:9 HDTV video content.

Curved versus flat is yet another geometric 

conundrum. In our experience, this is a question 

of personal preference. Some people love curved 

screens, others think they look ridiculous. We argue 

that the bigger a screen is, the more sense a little 

curve can make. But just remember, 

not all screens sport the same 

curve. Some are curvier than 

others. So, head down to your 

local store, and get a feel for the 

various radii of curve on offer.

All of which brings us to plain, 

old image quality. Partly, that’s a 

Above from left to right: 

The Asus PA329Q has 

advanced quantum dot 

technology, but it’s the 

purist’s choice.

The Dell UP3017Q is 

one of the first OLED PC 

monitors to arrive—but 

it costs a fortune. 

LG’s 38UC99 is the 

latest superwide 

curved-screen wonder.

This HDTV is big and 

beautiful, but do you 

really want a 50-inch 

screen as a PC monitor?

Below:

4K tech has now come to 

projectors, too.
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question of panel choice. At this end of the spectrum, 

it’s unlikely you’ll be considering a TN panel, though 

some gamers prefer TN at any price, thanks to its 

superior pixel response. For everyone else, it’s a 

choice between IPS and VA panels, plus closely 

related variants thereof, such as Samsung’s PLS 

tech, which is essentially IPS by another name.

Ultimately, the traditional divisions here remain. 

IPS is the best choice for color accuracy and viewing 

angles, while VA delivers the best contrast and color 

saturation. So, you’ll want IPS for a super-precise 

pro-style monitor, or VA for the ultimate in visual pop 

and punch. That said, those traditional categories 

are blurring. An IPS display with quantum dot 

backlight technology can have colors with even 

more pop than VA with a conventional LED backlight.

What’s more, the emergence of HDR, or high 

dynamic range, technology is complicating matters, 

It feels like OLED has been the 

next big thing in monitor tech for 

about a decade. It’s been one of 

those technologies that seems to 

always be just around the corner, 

but somehow never arrives.

OLED, or Organic Light 

Emitting Diode, tech has actually 

been successful on the small 

scale of smartphone displays 

for several years. Scaling 

the technology reliably and 

affordably for big displays has 

proven more difficult. However, 

the major brands in the HDTV 

market went big on OLED at CES 

earlier this year. What’s more, 

the first laptops with full OLED 

displays have now gone on sale, 

including the Lenovo ThinkPad X1 

Yoga and the latest Alienware 13.

Strictly speaking, the first 

OLED PC monitors have also 

arrived. The Dell UP3017Q 

delivers an OLED panel in a 

30-inch 4K form factor. Problem 

is, it’s a $5,000 screen. OLED, 

then, isn’t exactly mainstream. 

But it will be worth the wait 

when it does become more 

affordable. That’s because, when 

you get right down to it, LCD is a 

fundamentally borked technology 

on which to base a large, full-

color display. When you sit in 

front of the latest 4K HDR LCD TV, 

that’s easy to forget. The world’s 

display engineers have done an 

amazing job of compensating 

for the obvious flaws in LCD 

technology. But the advantage 

OLED has, by virtue of each pixel 

being its own light source in 

terms of contrast, viewing, and 

response, is simply too much. 

Already, OLED beats LCD hands 

down in many areas, and it’s still 

a nascent technology. A decade 

from now, OLED displays will 

be making anything with an LCD 

panel look utterly ancient.

WHEREFORE ART THOU, OLED?

a subject we covered in depth in our January issue. 

Long story short, HDR uses technologies, including 

local backlight dimming, to dramatically increase 

the range of brightness a screen can display. 

The new HDR standards also bring with them an 

expansion in color spaces, and support for up to 12 

bits of color per channel—in the past, even high-end 

monitors have been limited to eight bits per channel.

A true HDR monitor is capable of much greater 

highs and much lower lows than a conventional 

screen. The results can be spectacular, but HDR 

may not be for everyone. A 32-inch 4K IPS monitor 

with quantum dot technology is a very different 

proposition from something like a large 4K TV with 

HDR capability, to the point where it’s more a case 

of what fits your needs than necessarily determining 

which is better. You pays your money. You takes your 

choice. And the end result is a stunning screen. 

Lenovo’s Yoga 

X1 is one of the 

first vaguely 

affordable PCs 

with an OLED 

display.
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SPECIFICATIONS

Panel Size 34-inch

Native Resolution 3440x1440

Pixels Per Inch 110

Panel Type IPS

Max Refresh 60Hz

Response 5ms

Display Inputs

1x DisplayPort,  

1x HDMI,  

1x DVI,  

1x VGA

Connectivity N/A

VESA Mount 100 x 100mm

Warranty Three years

not going to get 10- or 12-bit color support, 

for instance. In strict terms, that limits your 

content mastering options. Nor can you 

expect the U3477PQU to be loaded up with 

the latest gaming-centric goodness. It tops 

out at a 60Hz refresh, it doesn’t support 

adaptive synching, and it’s completely flat.

That said, the U3477PQU is far from 

without gaming merit. AOC gives you four 

levels of pixel overdrive, so you can decide 

if you want to minimize blurring by ramping 

the overdrive to the max, in return for some 

inverse ghosting. That 34-inch 21:9 panel, 

with its 3440x1440 grid, is a very nice 

compromise for real-world gaming, too. 

It’s big enough to feel cinematic, and the 

pixel count provides lots of detail without 

presenting your GPU with a huge overload.

You could make a similar argument for 

the U3477PQU as a day-to-day productivity 

monitor. We’d prefer 32-inch 4K for the 

superior pixel pitch and additional desktop 

real estate. The 21:9 aspect ratio can also 

create its own problems: 16:9 TV content 

looks silly (and small) framed by thick 

black bars either side, for instance. Those 

1,440 pixels of vertical resolution will feel 

constraining for some. But at this price, 

it’s a decent compromise if you want a 

screen that can turn its hand to a little bit 

of everything, and look slick in the process.

WHAT TO MAKE OF AOC’S slick, superwide 

U3477PQU? It comes down to your point of 

view. If you’re a serious player in the true 

high end of the monitor market, it’s not 

going to be on your radar. But if you want to 

get a slice of the high-end action at a more 

attainable price, slap it on your shortlist.

It all starts with the 34-inch LCD panel. 

It’s a proper IPS item. It’s also 34 inches 

across the diagonal, and packs a 3440x1440 

pixel punch. For most mere mortals, that’s 

plenty. The 21:9 aspect ratio also adds an 

element of the exotic. AOC has done a nice 

job of giving the chassis and stand a quality 

consumer electronics vibe, too. 

Image quality doesn’t disappoint, either. 

It’s more vibrant than the more expensive LG 

38UC99, even if it can’t match the quantum-

dot brigade with their eye-popping colors. 

It doesn’t suffer from any major accuracy 

flaws either. There’s a little banding when 

viewing gradients, but it’s subtle. The black 

and white scales show virtually no evidence 

of compression, so the factory calibration 

is solid. It’s IPS, so the viewing angles are 

great, and both black levels and contrast 

are good. It can’t compete with a VA panel or 

an HDR screen with local dimming for really 

inky blackness, but that’s inevitable.

Similarly, you have to be realistic about 

the overall feature set at this price. You’re 

Six hundred bucks, but still a bargain

AOC 
U3477PQU

7
VERDICT AOC U3477PQU

A NEW HOPE Nice all-round 

package for the money; quality 

IPS image quality; slick chassis.

PHANTOM MENACE Lacks high refresh and 

frame synching; color capabilities limit 

content production support.

$616, www.aoc.com
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SPECIFICATIONS

Panel Size 32-inch

Native Resolution 3840x2160

Pixels Per Inch 127

Panel Type IPS

Max Refresh 60Hz

Response 5ms

Display Inputs
4x HDMI,  

1x DisplayPort,  

1x Mini DisplayPort

Connectivity
USB, card reader, 

3.5mm audio

VESA Mount 100 x 100mm

Warranty Three years

rotation to portrait mode. While the overall 

feel is robust, it’s far from chunky or old-

fashioned, thanks to a very slim bezel. What 

you don’t get is a curved panel, zany refresh 

rates, frame synching, or crazy levels of 

pixel overdrive. It’s all about precision.

Fire her up, and initial impressions are 

glorious. The PA329Q is supervibrant, but 

without that uber-saturated look that many 

TVs go for in order to achieve superficial 

punch. Think of it as both power and control 

when it comes to colors. The viewing angles 

are pretty much immaculate, too, and the 

anti-glare coating is superclean and free 

from grain or sparkle. Plus, there’s the 

razor sharpness due to that tight pixel pitch. 

The basic calibration is bang on, with 

flawless detail in white and black scales, 

and visually perfect gradients. The default 

6,500K color temperature is a little warm 

subjectively, and the IPS panel can’t compete 

with the latest VA screens for contrast and 

black levels. Likewise, support for a higher 

refresh rate would be nice, but that’s limited 

by display interface bandwidth.

In all other regards, this is a screen with 

which you could have a long and meaningful 

relationship. The advent of OLED tech 

notwithstanding, it’s easy to imagine the 

PA329Q still looking stunning in five years. 

It ain’t cheap, but it is a good investment.

SUPERWIDE 21:9 aspect screens with crazy 

curves? Wall-sized UHDTVs masquerading 

as PC monitors? Gaming gimmicks such as 

adaptive sync and 160Hz refresh? They’re 

all very well, but it’s time to put away the 

big boys’ toys and get serious. Enter the 

new ProArt PA329Q, Asus’s shot at a lasting 

monument to visual precision.

It isn’t big by high-end standards. It’s 

just 32 inches. But it is 4K, which has 

implications for pixel pitch and sharpness. 

As its name suggests, it’s aimed at serious 

productivity, therefore the core technology 

is IPS, with added color-fidelity chops.

In terms of color reproduction, that 

includes 10-bit per channel support, along 

with a 14-bit look-up table for precision 

calibration. But what marks the PA329Q out 

as cutting edge is the addition of quantum-

dot backlight enhancement for even greater 

color dynamism. The result is 100 percent 

coverage of the Adobe RGB color space. 

Asus also claims that factory calibration 

guarantees a sub-two Delta E color space.

The bottom line is that this display will 

enable you to properly master content for 

HDR compliance, including the Rec. 2020 

video gamut. The PA329Q’s physical 

bearing reflects its pro remit, too. There’s 

a pleasing quality to the chassis and stand, 

the latter being fully adjustable, including 

Asus ProArt PA329Q

PRECISION TOOL Extremely 

high fidelity IPS panel; 

impressive color capabilities; 

superfine pixel pitch.

NOT SO COOL Not exactly cinematic in 

scale; requires a fairly serious investment; 

not ideal for gaming.

$1,249, www.asus.com

Time to put away the big boys’ toys

ASUS
PROART PA329Q

9
VERDICT
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SPECIFICATIONS

Panel Size 32-inch

Native Resolution 3840x2160

Pixels Per Inch 127

Panel Type IPS

Max Refresh 60Hz

Response 4ms

Display Inputs
1x HDMI,  

1x DisplayPort,  

1x Mini DisplayPort

Connectivity USB, 3.5mm audio

VESA Mount 100 x 100mm

Warranty Three years

and pleasing colors. The out-of-the-

box calibration is mostly very good, too. 

Black and white scales show no signs of 

compression, and if anything we prefer the 

BenQ’s default color temperature. It’s bang 

on. That said, a whiff of banding in gradients 

is visible. Similarly, the anti-glare coating 

suffers from just a touch of graininess.

Move the frame of reference beyond its 

Asus nemesis, and it’s down to personal 

preference. On the one hand, it blows away 

all the larger screens in terms of crispness, 

detail, and accuracy. There’s no substitute 

for more pixels per inch. On the other, 

it’s not gaming-centric. There’s no high 

refresh rate, no frame synching, no HDR 

or mega-bright backlight, or incredible 

contrast ratios. Its pixel response is merely 

adequate, too. And at 32 inches, it’s not 

going to fill in as a home cinema screen. 

However, most of those complaints are 

largely beside the point. This isn’t a gaming 

monitor or a home cinema screen, even if 

it can turn its hand to those tasks. Instead, 

it’s a conventional PC monitor that majors 

on productivity, and delivers an upscale 

experience for a reasonable price. The Asus 

PA329Q may be the superior monitor, but 

it’s also more expensive. If you can’t quite 

stretch to the Asus, you’ll be grateful BenQ 

is offering this more affordable option.

SPARE A THOUGHT for the BenQ PD3200U. 

While the Asus ProArt PA329Q struts about, 

flaunting its quantum dot-enhanced colors, 

the PD3200U must make do with an LED 

backlight. However, this otherwise similar 

BenQ monitor has its own appeal.

Mostly, that comes down to price. The 

BenQ rocks in at just under $900, while the 

Asus sports a much heftier $1,250 sticker. 

Both share very similar core specifications 

and form factor: 32 inches of precision IPS 

panel, and the 3840x2160 pixel grid that 

denotes full-on 4K action. Like the Asus, the 

BenQ offers 10-bit per channel color, too. 

The PD3200U also cuts a similar dash 

on the desktop. It aims for a sober suit 

that majors on quality and functionality, 

including a fully adjustable stand that 

supports rotation to portrait. That said, it 

doesn’t have quite as pleasingly slim a bezel 

as the Asus. From there, you begin to see 

where BenQ achieves some cost savings.

The PD3200U delivers 100 percent of the 

smaller sRGB color space, rather than the 

more fulsome Adobe RGB gamut the Asus 

notches up. Similarly, where the Asus is 

fully Rec. 2020 compliant, the BenQ only 

musters the FullHD Rec. 720 color space. 

In practice, however, the BenQ doesn’t 

feel like you make much of a trade-off. It 

really is beautiful, with subtle yet vibrant 

An LCD panel for old-school purists

BENQ 
PD3200U

8
VERDICT BenQ PD3200U

IVY LEAGUE GRAD Lovely IPS 

panel; supercrisp 4K pixel 

pitch; competitive pricing.

HIGH SCHOOL DROP-OUT Modest overall 

proportions; can’t compete with the best 

on color space.

$899, www.benq.com

32 MAXIMUMPC

big screen group test

SPRING 2017 maximumpc.com



SPECIFICATIONS

Projector Type Triple-LCD

Resolution
1920x1080  

with 4K pixel shift

Brightness 2,500 lumens

Contrast 1,000,000:1 (dynamic)

Refresh
120Hz (1080p),  

60Hz (4K)

Throw Ratio Range 1.35–2.84

Color Processing 10-bit

Other
3D support, lens shift 

with remote control 

and memory function

Warranty
Two years  

(lamp 90 days)

up and to the right by half a pixel, and fire 

again. Rinse and repeat, except so fast the 

eye can’t see the oscillations, and add clever 

image processing to smooth everything out.

The result isn’t true 4K. The math works 

out to around four million pixels, where 

1080p is two million, and 4K is eight million. 

But from your video card’s perspective, the 

projector accepts a 4K input. But what about 

your eyes? Without question, it’s a huge leap 

over standard HD. The crispness and detail 

is on a whole new level. If you’d never seen 

a true 4K projector, you’d probably believe 

this was the real 4K deal. Even if you had, 

you’d probably be fooled. The step up to true 

4K isn’t as dramatic as the step from FullHD 

to this pixel-shift option.  

It’s a very nice projector in general terms, 

too. LCD technology has come a long way, 

and the contrast and colors are superb. The 

full-feature optics are remote-controlled, 

which makes the 5040UB a cinch to set up, 

even when installed on a ceiling mount or 

similar. It’s virtually silent in operation, 

too. On the other hand, it’s physically a big 

ol’ box, and the usual projector limitations 

apply. You can’t just stick it in any old room 

and use it any old time. Ambient lighting 

conditions need to be managed. But for 

gaming and video on a truly cinematic scale, 

nothing else here comes close.

WANT A REGULAR 4K monitor? Not a 

problem. You can have one for 300 bucks. 

Hell, you can get a 40-inch 4K TV for 

even less than that. Prices really have 

plummeted. But projectors? Not so much.

Projectors always have been a niche 

market. Volumes are lower, prices higher, 

innovation not as brisk. It also doesn’t help 

that one of the major projector technologies, 

Texas Instruments’ DLP, remains locked 

down under patent protection. The likes 

of Intel flirted with shaking things up with 

LCOS (Liquid Crystal on Silicon), then 

decided it wasn’t worth the hassle.

Anyway, just as 1080p FullHD was slow 

to make the move into the projector market, 

so it is with 4K or UHD. But it is happening. 

There’s been a number of mega-money 4K 

projectors available for a while, but now 

the first consumer models are appearing. 

They’re not cheap—the Epson PowerLite 

5040UB rocks the scales at $2,999, but 

it’s not some $20,000 monster aimed at 

professional installations.

There is a catch: It’s not true 4K. In fact, 

it’s a triple-LCD projector, with a native 

resolution of 1920x1080, and what Epson 

calls “4K enhancement.” The details involve 

what’s known as “pixel shift.” The idea is 

simple: First, project the native 1920x1080 

grid, then use the optics to shift the grid 

Kinda 4K. Definitely a projector

EPSON
POWERLITE 5040UB

8
VERDICT Epson PowerLite 5040UB

CINEMATIC Far more crisp and 

detailed than a 1080p beamer; 

super all-round image quality.

IDIOSYNCRATIC Not actually true 4K; still 

pretty pricey; physically it’s a big beast.

$2,999, www.epson.com
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SPECIFICATIONS

Panel Size 37.5-inch

Native Resolution 3840x1600

Pixels Per Inch 111

Panel Type IPS

Max Refresh 75Hz

Response 5ms

Display Inputs
1x HDMI,  

1x DisplayPort

Connectivity USB 

VESA Mount 100 x 100mm

Warranty One year

available, it’s questionable how relevant 

that all is. Instead, the 38UC99 seems to 

major on what you might call traditional 

monitor qualities. Plenty of pixels. A high-

quality panel. High-fidelity color support. A 

nice, enveloping panel curve. That kind of 

thing. On paper, it’s our kind of screen.

As soon as you fire it up, however, it’s 

obvious something is missing—a sense 

of pizzazz. For sure, the pixel pitch is nice 

and crisp, albeit not as sharp as a 32-inch 

4K panel. For the most part, it’s nicely 

calibrated out of the box, too. The black 

and white scales show loads of detail, and 

gradients are flawless. Additional points 

should also be awarded for a proper 

execution of FreeSync that isn’t spoiled by 

nasty ghosting when enabled.

But there’s no getting away from it. 

Compared to the likes of, say, the Asus 

PA329Q, and its quantum dot-enhanced 

colors, the 38UC99 looks dull. It even looks 

tepid next to some of the cheaper panels 

here. The outright contrast and black levels 

are underwhelming, and the anti-glare 

coating suffers from a little sparkle. All of 

which means it looks great on paper, and 

comes very nicely calibrated, but lacks 

the kind of visual fizz you’ve every right to 

expect at this price. It’s a certainly good 

monitor, but it’s definitely not a great one.

AS YOU PLAN A GROUP TEST, and the slots fill 

up, there’s usually one entrant that stands 

out. One that feels like a winner in the 

making. This time, it’s LG’s new 38UC99.

As a 21:9 aspect ratio panel, that’s 

surprising. After all, superwide screens 

are an acquired taste. But with the 38UC99, 

LG has hammered the main shortcoming of 

such screens—limited vertical resolution 

and desktop space—into the stands.

The first 29-inch 21:9 LCD monitors 

managed just 1,080 vertical pixels. Then a 

new 34-inch generation arrived, and upped 

the ante to 1,440 vertical pixels. Good 

enough for most, but not quite enough for 

everyone. Now LG has ramped the 21:9 

category up to 38 inches and 1,600 vertical 

pixels. That’s gotta be enough, surely?

The rest of the specs look promising, 

too. The overall pixel grid is 3840x1600, so 

there’s oodles of elbow room. The panel 

tech is IPS, and there’s 10-bit color support 

enabling 99 percent of the sRGB color space. 

LG has also added a few extras in the form 

of 75Hz refresh when used in concert with 

FreeSync adaptive frame rate technology.

That still means there’s a number of 

cutting-edge features missing. You don’t 

get really high refresh rates, HDR support, 

a backlight with quantum dots, or any of that 

jazz. Of course, with very little HDR content 

Superwide? Make ours extra large...

LG
38UC99

7
VERDICT LG 38UC99

OSCAR WINNER Generous 

proportions; plenty of pixels; 

nicely calibrated; decent pixel pitch.

RAZZIE NOMINEE Dull image quality; 

very expensive; short on frills and cutting-

edge features.

$1,499, www.lg.com
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SPECIFICATIONS

Panel Size 34-inch

Native Resolution 3440x1440

Pixels Per Inch 110

Panel Type IPS

Max Refresh 60Hz

Response 5ms

Display Inputs
3x HDMI,  

1x DisplayPort

Connectivity USB, 3.5mm audio

VESA Mount No

Warranty Three years

HDR, no quantum dots, no high refresh, no 

exotic color space support.

All that would be fine were it not for one 

other detail: It costs around $1,100. That’s 

mega money given the overall spec, and 

means the Philips is not only nearly double 

the money of the similar AOC monitor, but 

more expensive than the 100Hz, ultra-

curved, quantum dot Samsung CF791. 

Question is, can the Philips somehow make 

up for its implausibly high price?

In a word, no. Don’t get us wrong, this 

is a very nice screen. It has the measure 

of LG’s 38UC99 for colors, pop, and punch, 

for instance. There are no nasties from the 

factory calibration, either. The white and 

black scales look good, and the gradients 

are nice and smooth. Ditto the anti-glare 

coating. The pixel response is decent for an 

IPS display, and Philips includes an option in 

the OSD to tweak the overdrive levels, and 

thus choose between speed and accuracy.

The chassis has an intriguingly spacey 

design, and feels well put together, even if 

the tilt-only stand is pathetic at this price. 

All told, it’s a nice display. Shave $400 or 

$500 off the price, and it would be easy to 

recommend. We wouldn’t be surprised to 

see it experience a major price drop. Until 

that happens, it’s impossible to recommend 

when there are better screens for less cash.

FORGIVE US A PHILOSOPHICAL interlude. If 

you need to double-check both the product 

itself and its spec sheet to confirm the 

presence of a given technology or feature, 

does that feature have any value?

Adaptive frame sync had us pondering 

along those lines. It’s one of those 

technologies where it isn’t obvious whether 

it’s working correctly. But we’ve never felt 

like that about curved LCD screens. They 

split opinion, sure, but not being able to see 

the difference hasn’t been an issue.

Until the Philips Brilliance BDM349OUC, 

that is. That’s surprising, because it has 

the same 3800R curvature as several other 

34-inch displays. The explanation very 

likely comes down to context. Both of the 

Samsung displays in this group test are so 

curvy by comparison, the Philips looks flat. 

The mild curve makes for moderate impact 

at most. That either makes it a good choice 

if you’re unsure of the merits of curved 

panels, or a monitor that doesn’t fully 

deliver on the curved-screen proposition. 

Curvature aside, however, how does the 

BDM349OUC shape up? On paper, it all looks 

pretty familiar. The 3440x1440 pixel grid is 

standard for a 21:9 and 34-inch screen, as 

is the IPS panel technology. Elsewhere, the 

feature set is pretty thin when it comes to 

image quality enhancements. There’s no 

Ahead of the curve or overpriced?

PHILIPS 
BRILLIANCE BDM3490UC

7
VERDICT Philips Brilliance BDM3490UC

POLE POSITION Nice IPS panel; 

high-quality chassis; solid all-

round image quality.

ENGINE FAILURE Staggeringly expensive; 

limited feature set; panel curve is arguably 

too subtle.

$1,100, www.philips.com
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SPECIFICATIONS

Panel Size 34-inch

Native Resolution 3440x1440

Pixels Per Inch 110

Panel Type VA

Max Refresh 100Hz

Response 4ms

Display Inputs
2x HDMI,  

1x DisplayPort

Connectivity USB, 3.5mm audio

VESA Mount No

Warranty Three years

Brilliance. Whether that’s a good thing or 

not is subjective. Let’s just say if you’re not 

sure about curves, steer clear of the CF791.

Curvature aside, this is a great-looking 

panel. It doesn’t immediately blow your 

socks off like an HDR UHDTV playing high 

dynamic range content. But it’s more 

vibrant than a non-quantum dot monitor. 

The default calibration is a bit warm 

for our liking, pushing flesh tones toward 

pink. There’s a big gap between the color 

temperature presets, too, so you need to do 

a full calibration to dial that out. But that’s 

typical given the panel tech is VA, rather 

than IPS. Elsewhere, it’s well set up out of 

the box, with a good balance between detail 

in whites and black, and smooth gradients.

Objective concerns aside, the subjective 

experience rendering 4K video is stunning, 

even if the 3440x1440 native resolution is 

sub-4K fidelity. With that 100Hz refresh 

and adaptive sync support, plus better pixel 

response than just about any VA panel we’ve 

seen, this is one heck of a gaming panel, too. 

And it’s a good-looking hunk of consumer 

electronics, thanks to Samsung’s typically 

snazzy styling. With that hefty curvature 

and the extreme 21:9 aspect, it’s an acquired 

taste rather than a sure-fire hit, but if you’re 

looking for a 34-inch curved screen, the 

CF791 should be near the top of your list.

IT’S REMARKABLE how quickly the 34-inch, 

21:9 aspect segment has become almost 

a staple in the higher echelons of the PC 

monitor market. Even with the addition of a 

curved panel, you’re still not talking about 

anything exotic. Just a few years ago, a 34-

inch panel with such superwide proportions 

would have seemed almost preposterous.

Still, even by the standards of such 

screens, the Samsung CF791 is special. 

For starters, it boasts an LED backlight 

enhanced with quantum dot technology. 

The basics of quantum dot involve materials 

that absorb certain frequencies of light, 

convert them, and re-emit. The “quantum” 

bit is because the semiconductor crystal 

on which it’s based leverages a nanoscale 

effect known as quantum confinement, 

which involves electron holes, two-

dimensional potential wells, and the exciton 

Bohr radius. But you knew that, obviously.

Basically, it takes suboptimal light output 

from an LED backlight, and buffs it up to 

enable increased color vibrancy and fidelity. 

The CF791 also sports a couple of gaming-

friendly features: 100Hz refresh and AMD 

FreeSync adaptive refresh support.

Finally, it’s curved. Not just any old 

curved, but 1500R curved. That means 

the curve’s radius is a yard and a half or 

so—over twice as curved as the Philips 

Samsung gets a serious curve on

SAMSUNG
CF791

8
VERDICT Samsung CF791

BEAUTIFUL Gorgeous colors; 

epic, cinematic LCD panel; nice 

gaming extras.

BENT Extreme curve not to all tastes; 

ditto 21:9 aspect; pretty pricey for a 

34-inch panel.

$999, www.samsung.com
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SPECIFICATIONS

Panel Size 55-inch

Native Resolution 3840x2160

Pixels Per Inch 80

Panel Type VA

Max Refresh 60Hz

Response Not quoted

Display Inputs 4x HDMI

Connectivity
3x USB,  

optical audio-out

VESA Mount 400 x 400mm

Warranty One year

words, it leaps all the hurdles that TVs used 

to stumble over when used as a PC monitor.

That’s thanks in part to the fact that 

this 9 Series Samsung is a member of the 

brave new army of HDR TVs. With support 

for the HDR 1000 standard come several 

features that help it perform in the exacting 

environment of a PC, including expanded 

color space, with 10-bit per channel 

capability, and an LED backlight augmented 

by local dimming and quantum dot tech.

The result is stunning, but has its 

limitations. As a gaming monitor, it is 

staggering. The huge panel with plenty of 

curve makes for an incredibly immersive 

experience. It is the most impressive 

gaming display we’ve experienced, though 

the lack of both 120Hz-plus refresh support 

and adaptive frame synching means it can’t 

check every gaming box.

It’s stellar for 4K video content, too. But as 

a conventional PC monitor for web browsing 

or productivity work, it’s less convincing. 

While the pixel pitch is tolerable, fonts aren’t 

nearly as crisp as a 32-inch 4K monitor. And 

you don’t actually get any additional screen 

real estate. The practicality of such a huge 

screen is questionable to say the least, too. 

And while the quantum dot-powered panel 

packs an incredible punch, it’s hardly the 

last word in accuracy.

WORD TO THE WISE: Unless you are 

seriously considering a large UHDTV like 

the Samsung 9 Series as some kind of PC 

monitor, don’t try one just for fun. It will ruin 

you for conventional PC monitors. It makes 

almost every other monitor seem tiny.

Take the LG 38UC99. It’s a 38-inch beast, 

with a 21:9 aspect ratio, and by any sane 

metric, it’s a big PC monitor. But we set it up 

after assessing this Samsung monster, and 

it looked pitiful. At 55 inches, this Samsung 

9 Series model is nothing special by UHDTV 

standards (they go up to 78 inches), but set 

up as a PC monitor at PC monitor viewing 

distances, it dominates your field of view, 

and recalibrates your definition of big.

However, don’t go thinking this screen is 

a one-trick pony. This isn’t like the bad old 

days of large HDTVs, where size was all you 

got, and everything else—color accuracy, 

response, pixel pitch—sucked. Thanks to 

that 4K 3840x2160 grid, the pixel pitch is 

reasonable, if not awe-inspiring. Just as 

impressive is the out-of-the box calibration 

and ease of use. Hooked up to a modern 

graphics card with HDMI 2.0 support, in 

this case an Nvidia GeForce GTX 1080, this 

thing just works. What’s more, both black 

and white scales show plenty of detail, and 

gradient rendering is smooth. There’s little, 

if any, noticeable input lag, either. In other 

If bigger is better, we’ve found a winner

SAMSUNG
UN55KS9500

8
VERDICT Samsung SUHD 9 Series

LIFE-ENHANCING Spectacular 

proportions; works 

surprisingly well as a monitor; latest 

HDR capabilities.

MID-LIFE CRISIS Not exactly the last word 

in accuracy or practicality; fat pixel pitch 

even with 4K res.

$1,698, www.samsung.com
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have a huge amount to offer, though. The 

AOC U3477PQU is the easy pick as the 

value proposition. For around $600, you 

get a great 34-inch superwide IPS panel, 

wrapped in a slick chassis. Sure, it isn’t 

exactly loaded with extras, but it’s a large 

heap of screen for the money.

As for the Samsung 9 Series SUHDTV, in 

many ways, it’s the most stunning display 

that we have ever hooked up to a PC. 

Thanks to its HDR-capable feature set, 4K 

resolution, and epic panel size, it makes for 

a simply stellar gaming experience, even 

without frame synching or high refresh 

support. It’s not badly calibrated for use as a 

PC monitor, either. However, its size is also 

its downfall, both in terms of practicality, 

and the impact on pixel pitch. Epson’s 

PowerLite 5040UB, meanwhile, falls into 

a category all of its own. As a vaguely 

affordable way to go beyond 1080p with a 

projector, we highly recommend it. But just 

FIRST, A FEW WORDS ON HDR. It’s undoubtedly 

the screen technology du jour. But it’s also 

of marginal benefit on the PC—currently. 

The hardware is ready. You can buy an 

HDR screen, and the latest graphics cards 

from Nvidia and AMD are ready to roll. 

The problem is the content. There almost 

isn’t any.

It’s a particular problem on the PC 

at the moment. Service providers who 

are currently streaming in HDR, such as 

Amazon Prime, are yet to support the PC. 

Meanwhile, true HDR PC games—rather 

than games that render in HDR internally, 

but then knock the output back to SDR—

have yet to arrive. With that in mind, we 

would recommend viewing HDR more as an 

investment in the future, rather than a killer 

feature today. The fact that few PC monitors 

are currently HDR-compliant is therefore 

no huge loss. 

HDR or no, there are some fabulous 

screens on test this month. However, two 

stand out as relative stinkers, namely the 

Philips Brilliance BDM3490UC and the LG 

38UC99. The Philips is undone purely by 

pricing. It’s not a flawed product, it’s just 

far too expensive. As for the LG, we had 

very high hopes. But its subdued, even dull, 

image quality pulls the rug out from under 

our enthusiasm. The remaining six screens 

like any projector, it has niche, albeit highly 

cinematic, appeal.

That just leaves us with our podium-

position competitors, all three of which are 

superb displays. The Samsung CF791 is a 

fabulous multimedia display. Whether it’s 

games, video, or productivity, it’s a delight 

to use and genuinely innovative, with its 

quantum dot tech and extreme curve. 

The BenQ PD3200U, on the other hand, is 

the perfect foil for the CF791. It delivers 

precision and accuracy in a straightforward 

package, and at a competitive price.

But the overall honors have to go to the 

Asus ProArt PA329Q. It’s a serious piece 

of precision display engineering. It has a 

strong feature set for professional content 

creation, gorgeous high-DPI 4K image 

quality, and plenty of future-proofing with 

the likes of quantum dot color enhancement. 

If you are serious about computing, it’s one 

of the very best monitors money can buy. 

The Asus ProArt PA329Q is a serious piece of 
precision display engineering, future-proofed
with quantum dot color enhancement.

ASUS PROART PA329Q
And the winner is...
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Follow our tips for a 

cleaner, healthier, 

faster PC.
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Give Windows a shot in the arm by 
cleaning up and optimizing your PC  
By Nick Peers

Spring is in the air, so it’s the perfect 

time to take a virtual vacuum to your 

computer. Every year, it’s the same 

old story: Despite your best intentions, 

you rapidly lose control of what goes on 

to your PC, as programs are installed 

and forgotten, while gigabytes of files—

from documents to photos and videos—

are copied multiple times to a myriad 

locations, clogging up your hard drives. 

The result? A computer that’s slow to start, 

performs sluggishly, and is approaching 

the limits of your storage capacity.

The changing of the seasons brings the 

whiff of new life, and again, you resolve to 

clean out your PC, and see whether you 

can bring it back to those heady days of its 

youth, when it performed with a noticeable 

zip. And this is where we come in. We’re 

going to reveal all the tips and tools you 

need to get your PC properly cleaned up 

and raring to go. We’ll avoid snake-oil 

remedies, such as Registry cleaning, to 

focus on techniques that actually make a 

difference to your PC’s performance.

We’ve split the feature into four sections, 

enabling you to take your cleaning as far 

as you wish. Don’t want to dig too deep? 

Our light clean focuses on quick and easy 

ways to clean out space using only those 

tools provided by Windows itself. Feeling 

a bit braver? We introduce a couple of 

tools that go further than Windows does. 

Then we move on to tackle the problem of 

duplicate files, helping you preserve just 

the essentials, and freeing up tens (or 

hundreds) of gigabytes in the process.

If you’re still not satisfied, we push the 

boat out even further with our deep clean, 

revealing how to balance the competing 

demands of your PC’s resources, strip 

back unnecessary services, and optimize 

older hard drives so they perform that bit 

quicker. The end result is a revitalized PC, 

one that more closely resembles the lean, 

mean speed machine you bought, ready 

and better able to face the challenges 

you’ll throw at it over the next 12 months.
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A light spring clean can free up 

drive space and improve your PC’s 

performance without involving 

any hard work or even third-party tools. 

Everything we feature on these two pages is 

done using Windows’ own built-in tools, so 

without further ado, let’s get started.

First, check your hard drive is in good 

working order. The quickest way to force 

Windows 10 to perform a complete check 

on your hard drive is to right-click the 

“Start” button, and choose “Command 

Prompt (Admin).” Type the following into the 

command prompt window, then hit Enter:

 $ chkdisk /f /r c:

You’re told the drive can’t be locked 

(because it’s in use), so press Y, then 

when you next restart, Windows performs 

a complete check of your hard drive, 

attempting to correct any errors it comes 

across. If it finds and fixes any, you may 

immediately get a speed boost. Now repeat 

for any other drives you have attached—if 

you get a warning about forcing a dismount, 

we suggest hitting N, then Y to run the check 

when you next reboot. Once your drives have 

been checked, it’s time to begin cleaning.

Remove Unwanted Apps
How many programs have you installed 

on your PC? How many do you still use? 

Now is the perfect time to go through all 

the desktop programs and Microsoft Store 

apps you have installed, cleaning out those 

you no longer need or use. To do this, 

click “Start > Settings.” Select “System,” 

followed by “Apps & features.”

All installed apps and programs are 

listed alphabetically—you can, however, 

sort by size (useful if you need to free up 

drive space) or installation date. Go through 

the list, clicking any programs you no 

longer need, and choosing “Uninstall” to 

remove them using the standard program 

installer. Some uninstallers leave Registry 

entries and program files behind—for a 

more thorough way to remove programs, 

turn the page.

Perform a Disk Clean
Open File Explorer, and select “This PC” 

on the left to reveal a list of all your hard 

drives. Right-click your C drive (or the 

drive Windows is installed on), and choose 

“Properties,” then click the ‘“Disk Clean-

up” button. The step-by-step guide reveals 

how the tool works—basically, it enables 

you to quickly clear up all kinds of detritus, 

from the contents of various temporary 

folders to redundant system error logs, and 

even older System Restore points. You can 

run Disk Cleanup across other drives, too, 

but it’s usually most effective on the drive 

Windows is installed on.

It’s worth taking a pause before simply 

deleting everything that Windows suggests. 

For example, if you’ve just upgraded to a 

new version of Windows, you should find a 

“Previous Windows installation(s)” entry, 

offering tens of gigabytes of data ready 

to free up—don’t select this until you’re  

happy you won’t be rolling back to that 

previous version (note that Windows  

usually deletes these files after a set time 

anyway; typically 30 days). 

Recently installed a new driver and not 

sure whether it’s causing problems? Don’t 

Hopefully, you’re making good use of File 

History or Windows Backup to ensure your 

critical files are kept safe and sound. Both 

methods store multiple versions of your 

backups, giving you the option of rolling back 

the changes with individual files should you 

wish to restore an earlier version.

This protection comes with a price, 

however—increased consumption of drive 

space. If you’re feeling the squeeze, reclaim 

some breathing room by removing the oldest 

backups. Right-click the “Start” button and 

choose “Control Panel.” File History users 

should click “Save backup copies of your 

files with File History,” then click “Advanced 

settings.” You can change the frequency of 

backups (to reduce drive consumption going 

forward), plus set a time limit for how long 

backups are kept (“Until space is needed” 

is safest, but you can specify your own 

time). Click “Clean up versions” to clear out 

space by choosing what backups to delete 

(anything from all but the most recent to 

those backups older than two years).

If you use the Windows Backup tool, select 

“Back up and Restore (Windows 7),” and 

click “Manage space,” then “View backups” 

to manually select which backups to 

remove. Remember that older backups may 

contain files you have subsequently deleted, 

so be sure you haven’t mislaid any critical 

old files before cleaning up.

Manage Backups

Discover how much space and resources you can 
reclaim armed with only Windows 10’s tools

A LIGHT SPRING CLEAN

Before embarking on your cleanup, make 

sure your drives are error-free.

42 MAXIMUMPC

speed up your PC

SPRING 2017 maximumpc.com



touch “Device driver packages,” otherwise 

you lose the “Roll back” option in Device 

Manager. Finally, if you’re in the middle of 

troubleshooting a problem using a tool  

such as WhoCrashed (www.resplendence.

com), deleting the “System error memory 

dump files” is not recommended until you’ve 

finished fixing your problem. Long story 

short: Make sure you read the description 

of each setting before choosing whether  

or not to delete it, and if in doubt, leave it 

where it is for now.

Trim Startup Items
One of the biggest bottlenecks of PC 

performance is the number of processes 

and programs running in the background. 

We look at more extreme ways of bringing 

these under control later on in the feature, 

but for now, the most effective way to give 

your PC a shot in the arm is to review—and 

clean out, if necessary—the programs that 

are set to start with your PC.

The simplest way to do this is with the 

help of Task Manager, so right-click the 

taskbar, and choose “Task Manager.” 

Click “More details,” if necessary, then 

switch to the “Startup” tab. You’ll see a 

list of programs set to load with Windows, 

complete with publisher, status (enabled 

at this point), and—crucially—startup 

impact. This latter column helps you  

quickly determine which are the biggest 

resource-hogging programs.

Some programs are—by necessity—vital 

to the well-being of your PC, while others 

may be required on a regular basis, such 

as OneDrive or your cloud sync provider. 

Others, however, can be safely disabled, 

so they only run when you want them to. 

To do this, right-click the offending entry, 

and choose “Disable.” It’ll shave seconds 

off your startup, free up memory and other 

1. CHOOSE FULL SCAN
The first time you run Disk Cleanup, you’re 

prompted to wait while it analyzes selected 

parts of your system. When the scan 

completes, you’re shown an amount of disk 

space you can gain. For a more thorough 

scan, click the “Clean up system files” 

button, and wait while the scan repeats.

2. REVIEW SCAN ITEMS
You should find Windows has found lots 

more free space it can clear. Review each 

item by highlighting it for a description. 

You can select or unselect boxes to add or 

remove items to be cleaned—you should 

see the space gained figure adjust. Ready 

to clean? Click “OK > Delete Files.”

3. MORE ITEMS TO CLEAN
If you have System Restore enabled, you 

can launch Disk Cleanup again and click 

“Clean up system files” for a second time. 

Switch to the “More Options” tab, and 

quickly wipe all but the most recent Restore 

points by clicking the relevant “Clean up” 

button after reading the warnings.

FREE UP DRIVE SPACE WITH DISK CLEANUP

resources, and if you find enough items to 

disable, could make a noticeable difference 

to the performance of your PC.

Don’t recognize an entry? Right-click it, 

and choose “Search online” to search the 

web for the underlying file name. Disabled 

entries can be restored later—right-click, 

choose “Enable”—but if you’d like to remove 

them completely, explore the program’s 

own settings or preferences for an option 

to do so, and they should vanish from sight.

More Cleanup Tweaks
One way to improve performance is to 

take control of the Windows search index. 

This database helps speed up searches on 

frequently accessed folders, by scanning 

them for content, and storing them in a 

database. Sometimes, you’ll want to add 

folders to this index—data folders stored 

outside your user folder, for instance—

while removing others.

To manage these settings, type 

“indexing” into the “Search” box, and 

click “Change how Windows searches.” 

Click “Modify” to choose which folders get 

indexed, by selecting or unselecting them, 

or click “Advanced,” where you can change 

the index location (handy if you’d like to 

store it on another partition for retrieving 

after a Windows reinstall), or switch to the 

“File Types” tab to choose exactly which 

sort of files you want to include in your 

index. This latter tip enables you to tune the 

search index to only find specific document 

or image types, if those are the kinds of files 

you typically search for.

If you’re left feeling dissatisfied by your 

light spring clean, turn the page to dig 

deeper and really start to clear the clutter.

Windows 10’s uninstall tool covers both desktop programs and Microsoft Store apps.
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Dissatisfied with the results of spring 

cleaning with Windows’ own tools? 

Time to go further. In this section, 

we’ll perform a deeper clean on areas 

already covered, with the help of free third-

party tools, which can also reach areas not 

touched by Windows. As always, caution 

should be your keyword. While cleaning out 

gigabytes of data is satisfying, it can lose 

its allure if you’ve been hasty and discover 

useful shortcuts, such as the Jump lists of 

programs, have been removed.

Remove Apps Thoroughly
Standard program uninstallers tend to 

be conservative, leaving lots of detritus 

behind. This can soon mount up, and while 

you could employ the services of a Registry 

cleaner, the best time to clean up after a 

program is when you remove it. 

Our tool of choice for cleaning out old 

programs is IObit Uninstaller (www.iobit.

com/en/advanceduninstaller.php), which 

offers a “powerful scan” feature after a 

program’s standard uninstaller finishes. 

This roots out leftover files and Registry 

entries, which you review manually, then 

decide whether or not to keep.

During installation, look out for prompts 

to install Advanced SystemCare Free—it’s 

from IObit, so safe, but not needed for this 

feature. Once done, Uninstaller launches 

and you’ll see a list of desktop programs. A 

number of options appear on the left, from 

“All Programs” to “Large Programs” and 

“Infrequently Used.” The latter is good for 

weeding out programs you’re not using.

You’ll see a bin button appear on the right 

of each entry—click it, and the program in 

question is uninstalled. IObit Uninstaller 

offers to take a System Restore point 

before uninstalling, which we recommend 

for safety purposes. It then invokes the 

program’s own uninstaller—ignore 

prompts to reboot now—and performs its 

own powerful scan. This roots out potential 

leftovers in the form of files and Registry 

entries—you review the list, decide what to 

remove, then reboot if necessary.

To remove programs in batches, select 

each program you want to get rid of, then 

click “Uninstall.” The “Programs” list 

focuses on desktop programs only, so 

select “Windows Apps” to get a list of apps 

you’ve installed through the Microsoft 

Store, enabling you to remove those, too. 

Select “Toolbars & Plug-ins” to quickly 

review all the browser add-ons you have 

installed (all popular variants—IE, Chrome, 

Firefox, Opera, and Edge—are supported), 

plus remove those you don’t want, need, or 

recognize. It’s a quick and effective way to 

trim down your browser’s resource usage.

Clean More Settings
One of the best free cleanup tools is 

CCleaner (www.piriform.com). The app 

boasts a number of tools to help you clean 

out the detritus and recover gigabytes of 

files. Its main cleaning component searches 

more than just basic Windows settings, 

including browser settings (a source of 

hundreds of megabytes of potential waste), 

plus popular programs, and apps. It’s 

tempting to click “Analyze,” then clean out 

everything it recommends, but you’ll end up 

losing potentially useful settings. The step-

by-step guide reveals how to use it to free 

up space without deleting those files you 

didn’t know you needed.

Outside of its primary cleaning element, 

CCleaner offers a number of other tools. 

Its Registry cleaner is potentially the most 

dangerous, so skip that. Instead, select 

“Tools,” where you’ll find seven cleanup 

tools. The Uninstall section works in the 

same way as Windows’ Apps & Features 

tool, but is outclassed by IObit Uninstaller.

Startup provides you with a more 

comprehensive list of programs and items 

that launch with Windows. This is split into 

three tabs. “Windows” contains a list of 

programs, organized by location (Registry 

or startup folder). It’s the same list as in 

Task Manager, with one crucial difference: 

you can permanently delete entries (with 

care), as opposed to just disabling them.

Switch to “Scheduled Tasks” to review 

what tasks Windows and other programs 

have set up—you’ll find items such as 

backup tasks, program update tasks, 

and so on here. Again, you can disable or 

delete items. Select “Advanced” mode, and 

various Windows-related tasks are shown. 

These should be left alone, so leave the box 

unselected after reviewing it.

One final tab—“Context Menu”—is worth 

exploring. Frustrated at how programs 

clutter up the menus that appear when you 

right-click items in File Explorer? You’ll find 

these items here, referencing “Directory” 

(when you right-click a folder), “Drive,” 

and “File” (when you right-click a specific 

file type—sadly, the actual file isn’t listed). 

Disable or delete those you don’t want—

if they keep coming back, examine the 

program’s settings to see if you can disable 

them from there, or use its intransigence  

as an excuse to remove the app completely.

More Tweaks
The “Browser Plugins” tab works in a 

similar way to IObit Uninstaller’s “Toolbars 

& Plugins” section—it’s a matter of 

personal preference as to which one you 

use. Skip the Disk Analyzer and Duplicate 

Finder tools for now—we’ll look at these 

(and more powerful alternatives) later on.

System Restore lets you view all the 

Restore points on your PC. Each one is 

Need to free up more resources? With third-party tools, 
you can give Windows a more thorough clean

A MEDIUM SPRING 
CLEAN FOR YOUR PC

Use CCleaner to strip back your context 

menus to make them more manageable.

Remove unwanted browser add-ons to 

boost security, privacy, and performance.
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clearly labeled, and you can remove them 

individually or in groups (hold Ctrl as you 

click each one to select it) without affecting 

others. The most recent Restore point is 

always grayed out for safety reasons.

The final tool, Driver Wiper, makes it 

possible to wipe free space or (with the 

usual precautions) an entire drive securely. 

Instead of marking deleted files as space 

available for writing over, making them 

vulnerable to data recovery tools, you can 

securely wipe the space by overwriting it. 

This is slow, and should only be done 

when you have sensitive data to wipe. You 

can also wipe free space and mark non-

deleted files and folders for secure removal 

from CCleaner’s main Cleaner component—

scroll to the bottom of the “Windows” tab, 

and select each box (“Custom Files and 

Folders” refers to any files or folders you 

specify under “Options > Include”). If you’d 

like CCleaner to securely wipe all files from 

its Cleaner tool, go to “Options > Settings,” 

and select “Secure file deletion (Slower).”

4. ANALYZE AND CLEAN
Once you’re ready, click “Analyze” and 

wait while CCleaner performs a complete 

scan. When it’s complete, a summary is 

shown, listing all the components you’ve 

selected, complete with how much space 

you might save. As before, review individual 

components by double-clicking them.

1. CHOOSE WHAT TO SCAN
CCleaner’s Cleaner component comes with 

some settings pre-selected. It’s a good idea 

to review these thoroughly, unselecting 

those you don’t want to lose, and selecting 

the settings you’d like to clean. Unsure 

what files a particular setting might delete? 

Right-click it and choose “Analyze….”

5. CLEAN UP YOUR PC
Ready? Click “Run Cleaner.” A warning 

dialog pops up—this is your last chance to 

back out (files are deleted, not sent to the 

Recycle Bin). If you’re happy to proceed, 

click “OK,” and watch as CCleaner clears 

up gigabytes of hard drive space to give you 

some much-needed breathing space.

2. REVIEW ANALYSIS
CCleaner performs a limited scan on the 

chosen setting. To view exactly what it’s 

found, double-click the summary in the 

right-hand pane (such as “Microsoft Edge—

Download History”), and a list of all files 

is shown. Right-click files to exclude them 

from future scans or open the parent folder.

6. MANAGE EXCLUSIONS
Click “Options,” and select “Exclude” to 

review what items are excluded from your 

scans. You can remove files you’ve placed 

here (Ctrl-click those files to select them, 

then click “Remove”), or add files, folders, 

Registry keys (not relevant here), and file 

types to the list by clicking “Add.” 

3. CONTINUE CHECKING
Scroll down to view all Windows settings—

if in doubt, perform an analysis on the 

specific setting, or unselect it to exclude it 

from the full scan. When done, switch to the 

“Applications” tab to see which programs 

are supported. Scan these in the same way, 

unselecting those you wish to leave alone.

CLEAN OUT YOUR SYSTEM WITH CCLEANER

IObit Uninstaller provides you with a powerful tool for removing extra leftover elements.
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Your PC is hopefully noticeably 

zippier, but there’s still room for 

improvement. Before we tackle 

a really deep spring clean, let’s divert 

our attention for a moment to hard drive 

management. Unless you’re the most 

organized person in the world, it’s likely 

your filing system is a little haphazard. And 

if you’ve got multiple hard drives, it’s likely 

you have multiple copies of files, too.

First, consult the box below for general 

advice on what to look for when rooting out 

and removing duplicates—this could save 

you from potentially deleting the wrong file 

or files when you come to clean up.

Find Duplicates Quickly
CCleaner comes with a built-in file duplicate 

finder, but it’s not very sophisticated. It 

matches purely on file name, size, and  

date last modified. We want something  

more thorough, so download the free 

version of Duplicate Cleaner (www.

digitalvolcano.co.uk/duplicatecleaner.html), 

which has all the functionality you need.

First, choose what to search for—the 

default options search files by content 

rather than name, size, or date. You can also 

set filters—such as documents, pictures, or 

music—or files to include or exclude, plus 

limit your search to files of a certain size 

and date. For a system-wide sweep, leave 

the defaults as they are, and switch to the 

‘Scan Location” tab.

Next, elect where to search using the 

tools provided—whether it’s entire drives 

or specific folders. If you want to exclude 

a specific location, add it in the usual way, 

then right-click it, and choose “Exclude 

Selected Path(s).” When you’re ready, click 

the “Scan Now” button, and wait while 

Duplicate Cleaner does its work—it’s not a 

quick process, so be prepared to leave your 

PC on for several hours or even overnight, 

depending on the size of the folders you’re 

scanning. If necessary, minimize the scan 

window while you work on other tasks.

You can review the results on the 

“Duplicate Files” tab (“Duplicate Folders” is 

restricted to Pro users only)—they’re listed 

in no particular order. Focus on the largest 

files by clicking the “Size” column header 

twice. You can now go through the list, 

manually selecting the duplicates you wish 

to remove, or you can use the “Selection 

Assistant” buttons to speed things up. 

If you have a single folder or location 

where your original files sit, you can specify 

that with “Select by Location,” which tells 

Duplicate Cleaner to target files in other 

folders for deletion. Once done, you can  

select all other files by clicking the magic 

wand button, and choosing “Mark > Select 

by group > All but one file in each group.”

Duplicate Cleaner offers many matching 

tools to try to automate the selection 

process, but you may find it’s easier, 

quicker, and safer to go through the list 

by hand, weeding out unwanted files, and 

periodically clicking “File Removal.” From 

here, you can choose whether to delete the 

file completely, or send it to the Recycle Bin.

The program can be quite slow at times, 

and appear non-responsive. The trick is to 

be patient, and it soon comes back to life. 

If there’s a long list of files to clean, you 

may want to take a break. Simply close the 

program—when you next launch Duplicate 

Cleaner, your results are ready and waiting 

for you to continue processing.

Manage Your Photos
When it comes to managing your photos, 

you need a tool that can search for similar-

looking images, as well as identical 

matches. You’ll have to upgrade to the 

Pro version of Duplicate Cleaner for that 

functionality, so our favorite alternative 

is the free—and open-source—AntiDupl 

(http://antidupl.sourceforge.net/english/

index.html). Download the latest version, 

and double-click the .exe file to extract the 

program folder. Open this, and double-click 

“AntiDupl.NET.exe” to get started. The step-

by-step guide reveals the basic procedure 

you need to follow, but as always, it pays to 

Discover how to bring order to your chaotic hard drive

MAKE YOUR HARD 
DRIVE MORE 
MANAGEABLE

Backups of critical files are—of course—

important, so any file cleaning needs to bear 

this in mind. Also, you may have renamed a 

file without changing its content, so a good 

duplicate finder utility should not simply 

match files by their names (which could 

be disastrous if two completely separate 

files with the same name become linked 

together), but also by the file’s properties, 

too, from its size to the date it was last 

modified—that’s especially important with 

digital photos that have been downloaded 

from different cloud providers, each one 

naming them differently. And what about 

the legions of digital photos cluttering up 

space on your hard drive? It’s not uncommon 

to take five or more shots to ensure you 

get one usable one, but what about the 

rest? You only want to keep the best copy, 

but manually trawling through all your 

photographs can be a daunting task. Panic 

not—we’ll reveal a tool that makes this job 

that bit simpler.

The end result should be this: You have 

one master copy of your files, plus as many 

backups as you need. These could be stored 

as an exact backup copy in one backup 

folder (which you’ll need to identify to make 

sure it’s ignored by the duplicate file finder), 

or you might have them backed up using a 

tool such as Windows’ own File History, in 

which case, the backup won’t be touched 

by your file weeding. All other copies—or 

slight variations—then become candidates 

for removal.

What to Look for 
When Cleaning 
Duplicates

The scanning process can take some 

time—hours, in fact. Patience is a virtue.
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move slowly through each photo in the list, 

to be sure you’ve got the right match.

By default, AntiDupl assumes the 

first folder you added to it is the “master” 

folder—the one where the files are (by 

default) left untouched. When the search 

results appear, you’ll see a preview of 

each photo on the left, complete with basic 

information confirming the match. Next 

to each photo, you’ll see three buttons: 

taking the first photo, the top-most button 

deletes both copies, while the second icon 

overwrites the second copy with the first. 

The next button removes the top photo. 

Below the two arrow buttons, you’ll 

see three similar buttons, with the first 

one highlighted in red, indicating that the 

second photo is set to be deleted by default. 

Below this is a button allowing the second 

copy to overwrite the top one, and the final 

button—the hand signal—allows you to 

mark this match as a “mistake,” ensuring 

it’s ignored in future.

Click a button, and the desired action 

is performed now, and the next item is 

selected, ready for you to act on. You’ll see 

similar buttons appear under the menu 

bar—if you select multiple entries together 

using Ctrl-click, you can click these buttons 

to perform the same action on all the 

matches. There’s also a “Process selected 

results automatically” button for applying 

the default action to all of the results—not 

something we recommend, unless you’re 

feeling very brave or working on a small set 

of results.

As you go down the list, you’ll come to 

photos that aren’t exact matches, allowing 

you to remove similar photos, too. All 

deleted photos are sent to the Recycle Bin 

by default, giving you a fail-safe in case you 

make a mistake, so be sure to empty the Bin 

once you’re happy to free up the space.

1. SET SEARCH PARAMETERS
Launch AntiDupl, select “Search > 

Options,” and select “Search rotated and 

mirror image dupls” if you wish (click 

“OK”). Now select “Search > Paths.” Click 

“Add Folder” to add a folder or drive to 

search—repeat for as many locations as 

you need. Click “OK.”

2. REVIEW RESULTS
Click the play button and wait while 

folders are searched and compared (click 

“Background Mode” to minimize to the 

System Tray). When the scan finishes, 

AntiDupl lists all found duplicates and 

similar files. See the main text for advice 

on what settings to choose for each find.

3. PERFORM CLEANUP
As you click a button for each result, it 

disappears from the list, and the next item 

comes into view. Work through the list—you 

can select multiple items at once using 

Ctrl-click. If you close the program, you can 

relaunch it later, and the results are saved, 

ready for you to resume working.

STREAMLINE YOUR PHOTO COLLECTION

You can configure Duplicate Cleaner to refine its search for specific content only.

Speed up selection by having Duplicate Cleaner select all but one file in each lot of duplicates.
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A t last, we reach the final curtain. 

If your PC still isn’t running as 

smoothly as you’d like, let us take 

more drastic steps to bring it under control 

in this last section on cleaning, diving 

deep to squeeze out every last possible 

optimization we can find. We’ll also reveal 

some final tips for optimizing drive space, 

to ensure your hard drive doesn’t fill up too 

quickly going forward.

First, you’ll notice that we haven’t 

included Registry cleaning as part of this 

feature. Registry cleaners would like you 

to think they can perform minor miracles 

when it comes to performance. They can’t. 

Even if they weren’t justifiably shunned 

for their ability to delete critical Registry 

entries along with genuinely redundant 

ones, the act of simply deleting Registry 

entries isn’t enough in itself to speed things 

up. The fact is, Windows 10 is more than 

capable of managing and optimizing the 

Registry, so leave it well alone.

Defrag Your Drive
These days, more and more people have 

SSD drives, which don’t require defragging. 

Older platter-based (HDD) drives do, 

however, and it’s likely that you have at least 

one of these installed, either internally 

or attached via USB. Windows’ built-in 

defrag tool should be adequate for most 

people’s needs, but if you want to push the 

boat out further, download and install the 

free version of Defraggler (www.piriform.

com/defraggler). 

Defraggler can differentiate between 

SSD and HDD drives, so it only defrags the 

latter. Go to “Settings Options > Defrag 

tab,” and you can optimize your drive by 

moving larger files to the end of the drive, 

which can help boost performance that 

bit more. It’s also possible to analyze and 

defrag individual files via the “File list” tab, 

or by right-clicking the file in File Explorer—

handy for a quick boost when working with 

specific large files.

Manage Services
Startup programs aren’t the only things 

launching with Windows, extending your 

boot time, and grabbing resources—system 

(and third-party) services do, too. You can 

manually review and optimize these via 

the Services management console (type 

“services” into the “Search” box), but for a 

quick and easy optimization, download the 

free version of PC Services Optimizer (www.

smartpcutilities.com/servicesoptimizer.

html). Once installed, launch the app. After 

visiting Services Manager, waiting while 

the services list is populated, and clicking 

“Backup,” select “Automatic Tuneup,” and 

answer a series of questions split into four 

sections: “Hardware,” “Security,” “Internet 

& Network,” and “System Functions.” Click 

“OK,” and any unnecessary services are 

promptly disabled, providing you with a 

minor speed boost.

Gamers should also check out Gaming 

Mode. This enables you to temporarily 

disable services by switching Gaming Mode 

on to maximize performance for gaming 

or similar processor-intensive tasks, such 

as HD video editing. Click “Preset,” and 

experiment with “Minimum,” “Normal,” or 

“Maximum” settings, or manually select 

which settings to apply. Don’t be surprised 

if Windows changes appearance—when 

you switch off Gaming Mode, things should 

return to normal.

If things appear to go wrong after you’ve 

made your tweaks, simply click the “Rescue 

Center” button, and select your backup to 

undo your changes.

Visualize Drive Space
Running out of drive space, but unsure 

what’s gobbling it all up? CCleaner offers 

a Disk Analyzer under “Tools” that can 

provide you with a quick summary for 

individual or collected drives, split into 

various categories (such as pictures, 

documents, or everything). When the scan 

completes, a pie chart divides everything 

Tweak System Restore so it doesn’t take up 

too much space on your hard drive.

Still not satisfied with your cleaning efforts? Read on 
for a collection of more advanced cleaning tips

PERFORM A HEAVY-
DUTY SPRING CLEAN

Why let programs take more resources than 

they need? Instead of installing a program 

on your PC—letting it scatter itself all over 

your hard drive, and take up valuable space 

in the Registry—look to see if a portable 

alternative is available. Portable apps are 

programs that restrict themselves to a 

single folder; everything they need to run 

can be found inside that folder, so not only 

do you keep them in check (delete the folder, 

remove the program—completely), you also 

get to choose where they reside.

Portable apps are a particularly good 

choice when you have Windows installed 

on a small system drive—such as a 64GB 

or even 32GB SSD. You can store the apps 

on another drive, and leave enough space 

for Windows to run smoothly. Not only 

that, but if you have to reinstall Windows 

from scratch, the portable apps (and your 

settings) survive intact. You can even 

store portable apps on a USB thumb drive, 

enabling you to port them—and your 

preferences—to another computer.

A great place to start when building 

a portable app collection is www.

portableapps.com. Install the PortableApps 

Platform tool, which provides a custom Start 

menu for easy access to your portable apps, 

plus makes it easy to install and update 

apps from its own extensive collection. You 

can add other portable apps—including 

those portable tools we’ve covered in this 

feature—by extracting them into folders 

inside the main PortableApps folder, and 

choosing “Apps > Refresh App Icons.”

Switch to Portable Apps
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up, while the largest files are listed below, 

complete with a checkbox enabling you to 

select specific files to delete via the right-

click menu.

An alternative tool to try is SpaceSniffer 

(www.uderzo.it/main_products/space_

sniffer). This portable tool (be sure to right-

click it, and choose “Run as administrator” 

to access all files on the selected drive) 

provides a visual view based on folder, 

rather than type, giving you insights into 

where all the space has gone, rather than 

what type of content is gobbling it up. Click 

a folder to peer inside it, or double-click to 

go inside, and drill down deeper until you 

locate what’s taking all your space. 

More Cleaning Tips
Type “restore point” into the “Search” 

box, and click “Create a restore point.” 

Verify System Restore is switched on—if 

not, select your system drive, and click 

“Configure” to do so. When you come to 

allocate space, consider limiting it to 5GB 

or 5 percent, whichever is smallest. This 

provides a good balance between giving you 

usable Restore points and not swallowing 

up too much drive space.

One obvious way to free up space without 

deleting any files is to compress them. The 

obvious solution would be to right-click 

the file (or folder), and choose “Send to > 

Compressed (zip) folder,” but while you 

can easily browse their contents in File 

Explorer, third-party apps can’t access the 

content unless you unzip it. An alternative 

is to use NTFS Compression instead, 

which compresses a selected folder while 

retaining its content. The folder is a little 

slower to process, but is more convenient 

to use. To do this, right-click the folder, 

and choose “Properties.” Click “Advanced” 

under “General,” and select “Compress 

contents to save disk space.” Remember, it 

only works on NTFS-formatted hard drives.

One handy time-saving function is Jump 

Lists, which appear when you click “>” next 

to an application in the Start menu, or right-

click its taskbar entry. It pays to take the time 

to manage these thoroughly—click the pin 

icon next to an entry to pin it permanently to 

the top of the list, or right-click a redundant 

entry and choose “Remove from this list” to 

get rid of it. You can quickly clear all Jump 

List entries using CCleaner (look in the 

“Windows Explorer” section of the cleaner).

Finally, if you want to take full control of 

the startup procedure, download and run 

Autoruns (https://bit.ly/autoruns). Switch to 

the “Logon” tab, and you’ll find significantly 

more startup entries than those provided 

by Task Manager or CCleaner. Unselect an 

entry to disable it, or right-click it for more 

options, including deleting it and checking it 

for possible malware. 

CCleaner and SpaceSniffer enable you to visualize your hard drive usage in different ways.

The act of running multiple programs (never 

mind numerous background processes) 

is a delicate one, requiring a fine balance 

to keep everything running smoothly. It 

doesn’t always work, which is why your PC 

may sometimes seemingly grind to a halt or 

act sluggishly for a few minutes.

If you’re running Windows 10 on an older 

PC or low-powered tablet or laptop device, 

you may find it frequently sticks, due to the 

competing demands of different processes. 

One solution is to scale back what you do—

keep open programs to a minimum, and 

trim startup back, too. 

If this doesn’t help, then downloading 

and installing the Free version of Process 

Lasso (https://bitsum.com/processlasso) 

will, and it can even help on more powerful 

setups as well. When prompted, leave the 

default options as they are, and the main 

window opens to show you what’s running  

on your device, and how Process Lasso 

is balancing it. Its ProBalanced tool is up 

and running from the start, ensuring no 

process can overwhelm the system with 

its demands. A summary tells you how 

it’s working, and the log reveals which 

processes have been neutered when their 

demands get too high (click “Insights” for a 

handy summary). 

You can also tweak things further: Open 

the “Main” menu, and choose “SmartTrim” 

to free up physical RAM when it’s safe to 

do so. Select “IdleSaver” if you’d like to cut 

energy usage, and choose “Gaming mode” 

for those times when you want to play games 

or perform other CPU-intensive tasks, such 

as ripping or encoding HD video.

Rein in Unruly Programs
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Nothing is lost until you’ve looked for it, 
says Alex Cox

IMAGINE WITH US: The worst has 

happened. Everything you held dear 

is gone. You ignored the clicking of the 

hard drive, those error messages, that 

suspicious-looking file for too long. 

You clicked the thing you shouldn’t have 

clicked. You emptied the Recycle Bin out 

of habit after letting your kids near your 

PC. And now? Now your photos are gone, 

your documents are dust, those precious 

family videos cast to the wind. Windows 

has gasped its last breath. All is lost.

Except that isn’t necessarily the case. 

Data has a habit of hanging around. And 

if you’re very lucky, and very careful, 

you could—in this hypothetical scenario 

—get all, or the vast majority, of your data 

back. Note that we’re not going to be able 

to help you a huge amount in the case 

of massive hardware failure or physical 

damage, so if you’ve inadvertently sent 

120V to that SSD, or unwisely dunked 

your laptop in the bath, you’re either 

going to be on the hook for specialist 

clean room data recovery—which could 

set you back thousands of dollars, if it 

works at all—or completely out of luck.

If you’re not just imagining things, 

and everything does appear to have 

gone, stop using your PC immediately, 

and read on. And if everything seems 

fine, read on anyway. You might learn a 

few things that’ll save your bacon one 

day, and we’ll help you get your hands 

on some tools that every home computer 

pro should have waiting in their back 

pocket for the worst of times.

And don’t worry—we’ve not 

discounted the possibility that Windows 

has simply collapsed under its own 

weight, rendering your precious data 

comfortably stored, but otherwise 

inaccessible. By accessing your drive 

from another operating system entirely, 

you’ll be able to get all that stuff back, 

too. And hey, if you fancy doing a bit of 

digital forensics, but your drives are 

currently in a good state, why not delete 

a few old files from a USB stick and 

follow along?

RECOVER 
YOUR DATA
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BEFORE WE CAN EVEN THINK about 

doing any kind of data recovery, it’s 

worth knowing how data is stored 

on the typical drive. Every situation 

is slightly different, of course, and 

we’re taking an incredibly basic 

look at NTFS formatting here; other 

filesystems work in different ways, 

although with the right software, 

you should be able to affect a 

recovery from just about anything.

The typical drive is broken into 

partitions. These aren’t physical 

breaks, they’re logical—a certain 

portion of the drive’s bits are 

allocated, in a contiguous manner, 

to split the drive apart into 

individually managed sections, 

known as volumes. Information 

about these volumes—their size, 

location on the drive, and the like—

is stored in the drive’s Partition 

Table, which sits alongside the 

Master Boot Record (MBR) in the 

first sectors of the drive. The MBR is 

accessed when you boot your PC, so 

the BIOS knows where it’s heading. 

Each volume is invisibly broken 

into more sections. The Master File 

Table (MFT) is the most important of 

these. It’s a database that contains 

information about every file and 

folder on your drive, pointers to 

them, and, in some cases, even 

entire files, if they’re smaller than 

about 512 bytes. Before the MFT 

is a boot sector, which holds a bit 

more specific information about 

the volume—most importantly, 

it points to where the MFT is 

located—and, if the partition is 

both active and designated as a 

primary partition, loads NTldr to 

kick off the boot process. The same 

sector is also duplicated at the very 

end of the volume, in case the first 

one goes bad, as is the MFT itself.

Sandwiched between these tiny 

sections is the filesystem data 

itself—the stuff the MFT points to. 

These are your files. When you start 

a fresh NTFS drive, they’re stored 

quite neatly; a few months or years 

into the drive’s life, they really are 

not. Files are placed into whatever 

space the MFT designates as free, 

and while the system makes a good 

stab at doing this sensibly, it often 

needs to break your files apart, and 

spread them over several areas of 

free space, with the references to 

each of the parts stored in the MFT. 

This is why mechanical drives tend 

to slow down; the read head needs 

to jump around the drive to hit each 

bit of the thing you’re trying to load. 

SSDs don’t have this problem, since 

they can jump between sectors 

almost instantaneously (relatively 

speaking, at least).

STAYING SAFE
So what does this all mean for you? 

Well, consider this: When Windows 

deletes a file, it doesn’t do anything 

to the filesystem data. It merely 

scrubs the reference from the MFT, 

and allocates the file’s space as 

“empty.” The data itself is still there, 

almost in its entirety. For now. If the 

MFT later chooses to store a new file 

in the same space? Some or all of 

that deleted file’s data will be gone.

This means the first critical step 

of any data recovery effort (and a 

PREVENT DATA LOSS 
Recovering files is our 

aim here, but all of this 

can be avoided with a 

sensible computing 

regime. If you care 

about your data, build 

in a backup routine. The 

prevailing wisdom states 

that you should follow 

the rule of three (three 

copies of your data, 

stored on at least two 

kinds of media, at least 

one of which is kept off-

site), and it makes sense 

to get as close to this as 

you can. Start duplicating 

your critical files to a 

cloud backup service 

such as CrashPlan, and 

using external media to 

keep secondary copies 

of the most important 

items. Copying them to 

another partition on the 

same drive—or another 

physical drive in the 

same machine—is not 

adequate. Move your 

backup away from your 

main machine—to a 

different floor of your 

house, perhaps, or even 

off-site. If you’re hit by 

a flood or a fire, your 

insurance might buy you 

a new PC, but it won’t 

cover your files.

An automated 

process is best—

again, something that 

CrashPlan and its ilk 

offer—because it pulls 

vital files when you’re 

not using your machine, 

ensuring they’re 

duplicated when disaster 

strikes. If you don’t want 

to pay for a subscription, 

it’s plausible to back 

up small pockets of 

files on free services 

such as Google Drive or 

Microsoft’s OneDrive, but 

unless you’re organized 

with your local and 

mirrored folders, you’re 

one step away from a 

forgetful accident. If you 

want to take it further, 

and customize your own 

backup solution, check 

out Linux app rsync 

(https://linux.die.net/

man/1/rsync), which has 

a Windows wrapper in 

the form of DeltaCopy 

(www.aboutmyip.

com/AboutMyXApp/

DeltaCopy.jsp)—you 

won’t find a more 

versatile app when it 

comes to cloning data.

DeltaCopy makes 

scheduling backups 

quick and easy.

Don’t let 

Windows update 

if you’re missing 

crucial files.
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point we’re going to keep making) 

is to stop what you’re doing 

immediately, and power down the 

drive. Don’t risk any of your data 

being inadvertently overwritten, 

because if you want it back, you 

want it intact. Usually, you’d 

shut down your machine using 

the regular Windows shutdown 

procedure, which is certainly the 

optimal choice if your problem is 

hardware failure, rather than a 

filesystem glitch. It means your 

drive’s heads (if it has them) are 

properly and safely disengaged, 

and any write operations completed 

properly, thus avoiding potentially 

corrupted files. 

But there’s an issue with this: If 

you have Windows updates waiting, 

shutting down in the regular way is 

essentially giving Microsoft license 

to begin overwriting swathes of 

your drive’s precious bytes with 

patches that are, at least in the 

current circumstances, less than 

helpful. So if you’ve headed for the 

Start menu to shut down, and you’re 

getting the dreaded “and update” 

suffix, it’s time to do something 

we’d ordinarily never recommend: 

cut the juice. Don’t even hold down 

your power button for 10 seconds—

cut the power at the wall, flick the 

switch on your PSU, or pull the 

battery if you can. The next time 

we use this drive, it’ll ideally be in 

read-only mode, which mitigates 

most of the risk to your data.

VITAL PREPARATION
What’s gone wrong? We don’t 

know for sure. You might, though. 

The structure of your drive means 

there are a few potential points of 

failure—the MBR, the partition 

table, the MFT, a problem with bad 

sectors in the file storage area—and 

that’s not to mention mechanical 

issues, a problem with your 

motherboard’s drive controllers, a 

malicious attack, or the ultimate 

destroyer of files: you. We’ll come to 

human error later on. For now, we 

need to help the people who haven’t 

done something silly. 

If you have a donor machine 

you can hook the drive up to (as a 

secondary drive), that’s the ideal. 

If you don’t have that luxury, you 

need to cross your fingers that 

your file loss isn’t being caused 

by a malfunction on your current 

machine. Keep it powered down 

for now. Whatever the situation, 

have a fresh external drive ready to 

transfer any recovered files to, and 

STOP RECOVERY FOR GOOD 
We’ve discussed the 

ways in which your drive 

stores files, and how they 

don’t really get removed 

when you delete them 

or format your drive. 

What if there are files 

on there that you really 

want to stay deleted, 

and be excluded from 

any recovery efforts? 

We can use a little of 

our knowledge of file 

storage to work out how 

to obliterate old data—

the best way to make 

sure files don’t rise from 

the dead is to ensure 

that “free” space on 

your drive is completely 

overwritten. You could 

painstakingly write files 

to your drive until it’s 

full, but that’s madness. 

Better to use a secure 

deletion tool.

You have a few choices 

here, but we tend to 

favor Eraser (https://

eraser.heidi.ie), which 

goes overboard in its 

efforts, overwriting 

your files several 

times with specific 

random data patterns 

in order to remove 

them—and, on magnetic 

drives, the microscopic 

traces they leave 

behind—completely. We 

recommend you keep it 

hanging around—you 

can securely delete files 

just by dropping them 

on the app, or even have 

it grind through any 

unused space on your 

partitions, applying its 

algorithms to that space 

to scrub it clean of any 

ghostly data. 

If you really want to 

get rid of all the data on a 

drive—if you’re passing 

your hardware on or 

recycling it, say—System 

Rescue CD includes 

the tool Wipe (http://

wipe.sourceforge.net), 

which does an intense, 

thorough, repeated 

overwriting of every byte 

of data on a drive. Or if 

the hardware doesn’t 

matter, and you’re 

absolutely desperate to 

get rid of it, do as one of 

Maximum PC’s alumni 

once did: Take a hammer 

to your drive, and throw 

it in a lake. But think of 

the fish before you do it.

Eraser can make up to 35 

passes over your data for 

absolute removal.

Expand your 

Recycle Bin’s 

storage limit via 

the “Manage” 

option.
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be aware that you may need to do a 

little manual cleaning up after.

Now, head to a second machine. If 

you’re reading this and you haven’t 

actually suffered any data loss as 

yet, follow this advice anyway: 

As any good Boy Scout knows, one 

must always be prepared. On your 

second machine, download the x86 

version of System Rescue CD from 

www.system-rescue-cd.org, and 

write it to a CD or USB stick. There 

are many rescue-focused distros 

of Linux, but this one—ugly text-

based interface and all—is ours.

PARTITION RECOVERY
Time to get some stuff back. Plug in 

your large external drive, and boot 

your affected machine from your 

System Rescue CD media. You may 

have to head into your UEFI menu 

and disable Secure Boot before it 

works. Hit Return to boot with the 

default options, and you’re thrown 

straight to a command prompt. 

OK, not the most welcoming 

introduction, but we don’t need 

graphical finery for these tasks. 

You may see a suggestion to mount 

your drive at this point—don’t do it. 

This is a trap for young players; if 

your partition table is hosed, you’re 

going to want to work on the raw 

disk first of all. So type “testdisk” 

and you can begin taking a look 

at your connected hardware. Don’t 

worry about creating a log file at 

this point. 

You’re first given a list of all the 

connected storage devices—with 

luck, you’ll see the affected drive. If 

you don’t, you can safely diagnose 

your problem as physical: Meaning 

there’s a cable loose, a power failure, 

or your drive controller has gone up 

in smoke. Presuming you do see the 

drive, take a note of its designation 

(sda, sdb, and so on) as we’ll need 

this a little later. Ensure it’s 

selected, and hit Return, selecting 

the “Intel” partition type unless 

you’re working on a particularly odd 

drive. Now choose “Analyze.” One of 

two things is going to happen now: 

If your drive is properly structured, 

it finds the partition table, and lists 

the partitions—again, take note 

of these, and those of the external 

drive you’ve plugged in for your 

recovered files. If the partition 

table of the rogue drive is missing 

or damaged (TestDisk looks for 

a particular byte at a particular 

point on the drive to discover this), 

you can select “Quick Search” to 

have it scan your drive, cylinder 

by cylinder, for the telltale signs 

of partition divisions. With any 

luck, it’ll find something, and you’ll 

be given the option to restore the 

partition table. If not, you can 

choose to do a deeper scan, which 

is a last-ditch effort; it takes a long 

time, and stresses a failing drive, 

but if you have no other option, it’s 

worth a try.

CONNECTING DRIVES
With a healthy partition table, your 

drive should be in good enough 

shape to work with—you can 

now start hunting for your files. 

TestDisk usefully comes with a 

companion program, Photorec, the 

name of which is somewhat out of 

date—it doesn’t just recover photos, 

but a host of known file types from a 

selection of over 480. But before we 

can use it, we need to mount your 

secondary drive to give it a location 

to send the files to. Mounting, 

essentially, is the process of linking 

a partition of your drive to a Linux 

file—absolutely everything in 

Linux is a file—and telling Linux 

exactly how it should be accessing 

that drive. 

Presuming your backup drive 

is NTFS formatted, we can use a 

program called ntfs-3g to do the 

mounting. First, create a mount 

point—the folder location that’ll 

represent your drive—by typing   

 mkdir /mnt/ntfs  at the prompt. 

Then (replacing “sdb” with the 

partition designation that you 

made a note of earlier) type  

 ntfs-3g /dev/ sdb1 /mnt/ntfs  to 

solidify the link between the two 

locations, and bear in mind that you 

will need the backup drive to be in 

good working order, too—if ntfs-3g 

detects bad sectors or NTFS errors, 

it forces it into read-only mode. 

Now  fire up Photorec by typing  

 photorec  at the prompt. 

FILE RECOVERY
This is the real meat of file recovery. 

Photorec uses technical knowledge 

of partition anatomy and the exact 

If you see 

this ominous 

message in 

TestDisk, your 

partition table 

is hosed.

Type “startx” to 

fire up System 

Rescue CD’s 

GUI, and access 

gparted.

Piriform Recuva 

is a good low-

effort solution 

for deleted data.
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WHAT ABOUT RAID?
RAID drives, as you 

might imagine, can 

be tricky beasts to 

recover data from, and 

certain configurations 

introduce issues of 

their own. Run a striped 

set in RAID 0 formation, 

for example, and you’re 

asking for trouble—

yes, you’ll have some 

of the fastest storage 

going, but if one of 

your drives goes 

down, you’re stuck. 

There are various 

options that claim to 

be able to recover files 

from RAIDs 0, 5, and 

10—ReclaiMe (www.

freeraidrecovery.

com) is the most 

prominent—but don’t 

hold your breath for 

any decent results. On 

the flipside of the 

coin, RAID 1 and 

similar mirrored 

configurations 

positively aid in data 

recovery; if one of your 

drives goes down, you 

may need to invest a 

little time and money in 

remirroring with a new 

drive, but catastrophic 

failure is only going to 

come from your own 

hand or a malware 

attack. If this is the 

case, you have the 

same chance to recover 

files as you would with 

a single drive.

The other issue 

RAID introduces 

is the controller 

itself. If whatever’s 

managing your RAID 

configuration—your 

NAS, your main 

computer, or specialist 

RAID hardware—goes 

bad, it could throw your 

drives into a position 

where recovering data 

is entirely impossible. 

It’s not unknown for 

specialists to be able to 

engineer specific tools 

for specific instances 

of RAID failure, but 

this is a highly costly 

procedure, with no 

guarantee of success.

We don’t have an 

answer for the irony of 

RAID being both safer 

and more dangerous 

than storing on a single 

drive, other than to 

suggest, again, that you 

always keep stringent 

backups away from 

your regular hardware.

Want speed 

and security? 

Run four drives 

in Raid 1+0.

Opened up a 

drive like this? 

Then don’t 

expect to get 

your data back.

bytes that make up certain file 

types to skim through your drives 

and automatically pull off corrupted 

or lost files. And while its interface 

is incredibly ugly, it’s the most 

effective tool going. Once you’ve 

started it up, pick your affected 

drive (Photorec only works in read-

only mode, so it’s safe), choose the 

partition that you noted earlier, 

and select “Search.” Photorec asks 

for a location to save its restored 

files to—navigate through the 

Linux file tree to find the mount 

point we made earlier, and pick a 

folder on your drive if you have one 

prepared. Hit C when you’re done. 

Photorec now sifts through your 

drive looking for broken, deleted, or 

incomplete files, and does its best 

to recover them fully—grab a cold 

one, because this is going to take 

a while. All being well, you should 

have the majority, if not all, of your 

stuff back at this point.

There are simpler ways to get 

the job done. You’re welcome to 

stick within Windows and try 

running the portable version of 

Piriform’s Recuva from a USB stick 

(www.piriform.com/recuva/builds), 

which offers a pretty interface 

and the option to select precisely 

what you’ve lost, rather than just 

batch-copying everything, but 

it’s more limited to inadvertently 

deleted files, and isn’t particularly 

helpful if you have an ongoing 

malware issue. There are also 

overkill methods—for instance, 

you could, at the other end of the 

spectrum, use partimage (included 

with System Rescue CD) to pull off 

a full bit-for-bit copy of your affected 

drive, preserving it for later forensic 

analysis. Check the guide at www.

partimage.org/Main_Page to see 

how it’s done—you can compress 

the image as it goes, fitting it on 

to a smaller drive than the source, 

and later restore it if you suspect 

hardware failure.

System Rescue CD has one 

more niche use, too. If Windows 

itself has given up the ghost, and 

is blocking your access to your 

otherwise perfectly stored files, 

you can mount both your original 

and backup drives, and copy them 

off directly. Alternatively, and this 

may be a slightly more comfortable 

option, you could boot up another 

Linux live distro—the likes of 

Ubuntu—and manually back up 

using a graphical interface. 
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GPU VRAM
Memory seems to be one of the most 

over-marketed products within the PC 

enthusiast’s arsenal of componentry. 

Whether it’s SSD cache being used to 

speed up ageing hard drives, enticingly 

large supplies of GPU memory on 

a $150 card, or desktop DDR4 with 

frequencies up into the 4,000MHz 

range, it tends to be obscured by a 

barrage of baseless promises.

For example, MSI recently stated 

that by increasing DDR4 frequencies 

from 2,400MHz to 4,000MHz, you’d 

see an in-game improvement in The 

Witcher 3 of average frame rates from 

94.1 to 114.1. In tests in our March 2016 

issue, we saw zero difference in frame 

rates across 10 memory kits with a 

800MHz difference between them.

But my issue lies with graphics 

memory, and how much is “enough.” 

We had an argument with Asus’s PR 

team regarding the appropriate level 

of VRAM for various cards. The 4GB 

1050 Ti doesn’t make sense to us, 

when the 3GB 1060 is about $30 more, 

yet performs almost three times 

better. Asus’s argument is that games 

require ever larger VRAM caches, and 

you’d be future-proofing yourself by 

getting a 4GB 1050 Ti over a 3GB 1060. 

We disagree. If you game at 1080p, 

3GB of VRAM is plenty for any game 

today. Larger textures don’t provide 

any more detail, and if you’re looking 

to upgrade to higher resolutions, the 

GPU will become the bottleneck. Don’t 

fall for marketing lies—buy a card 

with an appropriate amount of VRAM 

for the resolution and games you play, 

and build a system around that.

DON’T INSTALL GEFORCE EXPERIENCE
For people concerned about privacy, the latest Nvidia update 

brought an unwelcome visitor in the form of required account 

creation to access any features. To counter this, head to www.

geforce.com/drivers, manually enter your conditions, and 

click to download the latest drivers as an EXE. On installation, 

deselect “GeForce Experience,” and you’re good to go. Check 

back monthly or whenever you hear about a new driver release.

↘ submit your How To project idea to: comments@maximumpc.com
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About iFixit
iFixit is a global community of tinkerers dedicated 

to helping people fix things through free online 

repair manuals and teardowns. iFixit believes that 

everyone has the right to maintain and repair their 

own products. To learn more, visit www.ifixit.com.

PlayStation 4 Pro
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BACKGROUND
The world of video game platforms has been changing quickly. 

Manufacturers have resorted to mid-gen refreshes to keep up 

with 4K TVs and VR headsets, and here’s the third iteration of 

the PS4 generation. We may be amateur gamers, but we’re 

revved up to tear the PlayStation 4 Pro down, professionally. 

MAJOR TECH SPECS
•  Eight-core AMD “Jaguar” X86-64 CPU, clocked at 2.1GHz  

(up from 1.6GHz).

•  4.2Tflops AMD Radeon-based graphics.

• 8GB GDDR5 RAM and 1GB DRAM.

•  1TB removable and upgradable hard drive storage.

•  802.11a/b/g/n/ac, Ethernet, and Bluetooth 4.0 (LE).

•  Blu-ray x6 CAV, DVD x8 CAV.

KEY FINDINGS
•  The triple-decker design is a little different from the “first” 

PlayStation 4, but that doesn’t stop us—without wasting time, 

we flip the console over, pop the first panel, and hit pay dirt! A 

single, standard Phillips #0 screw stands between us and 

hard-drive-swapping glory. 

•  We’re gonna have to remove the “Warranty void if seal 

removed” stickers to go any further. Adding insult to injury, 

the screws hidden beneath are Security Torx screws—

designed to stop you getting in. With the case cracked open, 

we can remove a large metal shield. Unfortunately, all this 

does is give us a view of the motherboard’s backside.

•  With the beast on its back, the opposite panel pops off after 

some prodigious prying—but no “warranty void” stickers! 

Alas, removing this panel isn’t the panel-cea we were hoping 

for. We can pull out the power supply, but nothing else. While 

you can’t remove the fan, you could certainly clean it from 

here—maybe that’s why we’re granted this non-warranty-

voiding access zone. 

•  Thwarted by the lack of any more screw heads on the PSU 

side of the PS4 Pro, we flip it back over and turn our attention 

to the motherboard. Burrowing through a layer of shielding 

behind the CPU reveals a cool X-shaped retaining bracket, 

similar to ones we found in another console. And directly 

underneath it, we dig up a plastic-and-metal cover that 

seems to be the consumer electronics version of a pizza 

saver, protecting the back of the board from the heatsink 

retaining bracket. 

•  Repairability Score: 8 out of 10 (10 is easiest to repair). No 

adhesive makes disassembly and reassembly easy. The 

non-proprietary hard drive is simple to access and upgrade 

or replace—and doing so doesn’t void your warranty. While 

you can clean the fan, removing it—and other components—

requires lots of (warranty-voiding) disassembly. Security 

screws and tamper-evident seals discourage users from 

disassembling and repairing their PlayStation 4 Pro. 

Remarkably simple, 

although that’s not  

really surprising.

Fortunately, you can 

still swap out the hard 

drive, a PlayStation 

staple since the PS3.

We’re a huge fan 

of easy-to-remove 

components.



Set Up a Twitter Bot
On the Raspberry Pi

1 PRELIMINARY STEPS

Bots have practical uses, too. They can be programed to tweet 

at regular intervals, so can be used as a “dead man’s switch” to 

tweet a message unless you reset it every day. It’s also possible to 

schedule a tweet for a future date, so you can use the bot to send 

out reminders. 

>> If you find any of these possibilities intriguing, you need to set 

up a dedicated Twitter account for your bot. Do not be tempted to 

use your existing Twitter account for this if you have one, because 

repeated tweets could be mistaken as spam by Twitter, and your 

account could be suspended.

>> In order to proceed, we need a new Twitter account with a 

confirmed cell phone number. If you already have a Twitter account, 

visit https://support.twitter.com/articles/81940# and follow the 

steps there to delete your cell phone number from your account for 

the time being.

2 CREATE NEW TWITTER ACCOUNT AND APP

Next, visit www.twitter.com and choose “Sign Up.” You can 

use any email address you wish, provided it’s not already 

registered with Twitter. Choose a name that is appropriate for the 

bot. For the purposes of this tutorial, we’re creating a bot named 

Sherlock Bot, with user ID @holmesbot1 [Image A]. 

>> You are asked to provide your cell phone number, and then 

confirm it by SMS. Twitter requires this for bots to reduce the 

likelihood of spam. 

>> Once your Twitter account has been created, you may need to 

click “Continue” a few times at the top-right to skip invitations to 

import your contacts or follow other users. 

>> Next, we need to create a Twitter application that allows your 

Raspberry Pi to access your Twitter account. Go to http://apps.

twitter.com, then click “Create New App.”

THE SIMPLEST DESCRIPTION OF A TWITTER BOT is a program designed to produce automated 

posts on Twitter. The most common use for bots is spam. The bot examines key words—cleaning 

products, for example—then responds with a promotional link for people to click to be taken to the 

spammer’s website. The feature also has non-spammy uses, however. Bots can be programed to 

search for any word or phrase, and respond accordingly. One entertaining implementation of this was 

@BDZNappa, which searched for people tweeting the phrase “over 9,000,” to which it always 

responded, “WHAT!? NINE THOUSAND?” Bots can also tweet from a text source, such as 

@SunTzuBot, which tweets daily quotes from The Art of War. More sophisticated bots, such as 

@JustDiedBot, actively search the Internet for source material. @JustDiedBot searches Wikipedia 

for information about recent deaths, and tweets RIP announcements as they happen. –NATE DRAKE

YOU’LL NEED THIS

RASPBERRY PI
The brilliant mini-computer 

costs under $45. See  

www.raspberrypi.org.

3 INPUT DETAILS

You are asked to fill in the “Application Details.” 

For this tutorial, we’re creating a bot that regularly 

tweets the Sherlock Holmes stories, but you’re welcome to 

change the “Name” and “Description” as you see fit.

>> Under “Website,” for now simply put “http://www.

twitter.com.” Leave the field named “Callback URL” blank. 

Check the box to say you agree to the Twitter Developer 

Agreement, then click the gray button marked “Create 

your Twitter Application.”

>> Make sure “Access Level” reads “Read and Write.” 

If not, click “Modify App Permissions” to change it. Next, 

click on “Manage Keys and Access Tokens.” Scroll to the 

bottom of the page, and click the gray button marked 

“Create My Access Token.”

>> You see a message saying the access token has been 

generated. Keep a copy of this page in a safe place, or leave 

it open in your browser, because we’ll need it shortly. 

4WORKING ON THE PI

Next, open the terminal app on your Raspberry Pi or 

connect to it via SSH. We need to install some extra 

software by using the following command:

 sudo easy_install pip

>> Next, create a directory for the bot and open it:

 mkdir holmesbot1 && cd holmesbot1

>> For this example, we’re going to use a Python library 

created by Edwin Dalmaijer, named Markovbot. The 

software essentially takes some text from a source (in this 

case, The Adventures of Sherlock Holmes) and randomly 

constructs plausible-looking sentences with it. 

>> You need to download and unzip the software with the 

following command:

 wget https://github.com/esdalmaijer/markovbot/

 archive/master.zip && unzip master.zip

>> Move to the new directory with  cd markovbot-master  

and install more required software with these commands:

 wget https://bootstrap.pypa.io/ez_setup.py && sudo

 python ez_setup.py

 sudo easy_install twitter

>> Next, we need to download a text file to use as the 

source for our bot’s random tweets. This file comes from 

the Project Gutenberg website, but feel free to use any TXT 

file you like:

A

62 MAXIMUMPC

R&D

SPRING 2017 maximumpc.com



 wget http://www.gutenberg.org/cache/epub/1661/pg1661.txt

>> Then we create an empty file to place our code. You can choose 

any name you like, provided you use the extension  .py  at the end:

nano sherlock1.py

>> Enter the following code in the new file:

import os

import time

from markovbot import MarkovBot

# # # # #

# INITIALIZE

# Initialize a MarkovBot instance

tweetbot = MarkovBot()

# Get the current directory’s path

dirname = os.path.dirname(os.path.abspath(__file__))

# Construct the path to the book

book = os.path.join(dirname, u‘pg1661.txt’)

# Make your bot read the book!

tweetbot.read(book)

 # # # # #

 # TWITTER

 # The MarkovBot uses @sixohsix’s Python Twitter Tools, 

 # which is a Python wrapper for the Twitter API. Find it on 

 # GitHub: https://github.com/sixohsix/twitter

 # ALL YOUR SECRET STUFF!

 # Make sure to replace the bits in quotation marks below with 

 # your own values, or try to find a more secure way of dealing 

 # with your keys and access tokens. Be warned that it is NOT 

 # SAFE to put your keys and tokens in a plain-text script!

 # Consumer Key (API Key)

 cons_key = ‘yourconsumerkeyhere’

 # Consumer Secret (API Secret)

 cons_secret = ‘yourconsumersecrethere’

 # Access Token

 access_token = ‘youraccesstokenhere’

 # Access Token Secret

 access_token_secret = ‘youraccesstokensecrethere’

 # Log in to Twitter

 tweetbot.twitter_login(cons_key, cons_secret, access_token, 

 access_token_secret)

 # Start periodically tweeting. This will post a tweet 

 # every minute. 

 # (You’re free to choose your own interval, but please 

 # don’t use it to spam other people. Nobody likes spammers 

 # and trolls.)

 # This function operates in a Thread in the background, 

 # so your code will not block by calling it.

 tweetbot.twitter_tweeting_start(days=0, hours=0, minutes=1, 

 keywords=None, prefix=None, suffix=‘#IamSherlocked’)

5 
ENTER YOUR PERSONAL VALUES

Once the code has been entered, you need to use your 

arrow keys to navigate to  ‘yourconsumerkeyhere’ , 

 ‘yourconsumersecrethere’  ,  ‘youraccesstokenhere’ , and 

 ‘youraccesstokensecrethere’ , and replace these with the values 

from Twitter’s website that you noted down earlier. Leave the 

quotation marks. You’ll also notice the file name  pg661.txt  under 

the words  Construct the path to the book , so change the 

file name to your own text file also. 

>> Now scroll down to the bottom of the code and note 

that, by default, this code will tweet once every minute. 

Change this if you wish—for example, to once a day: 

 days=1, hours=0, minutes=0 . Finally, you may wish to 

change the suffix placed after every tweet to something 

else or to  None .

>> Press Ctrl-X when done, then Y, then Return to save. 

You can run your script at any time with the command:

 sudo python sherlock1.py

>> Be sure to substitute  sherlock1.py  with the actual 

name of your file. The terminal will show the tweets but 

you can also check on the website. 

6 GOING FURTHER

There are many more possible Python projects 

you can do with Twitter, including responding to 

keywords, automatic retweets, and even grabbing values 

from web pages, such as stock market prices. Head over to 

www.raspberrypi.org/blog/tag/python/ to see some of the 

exciting projects that have been achieved with Python. 

Bots have been around for several years, and some have 

thousands of followers. Some of them simply react to words 

in tweets. For instance, anyone using the phrase “illegal 

immigrant” can expect a response from @DroptheIBot saying, 

“People aren’t illegal. Try saying ‘undocumented immigrant’ 

or ‘unauthorized immigrant’ instead.”

The @everyword bot began tweeting every word in the 

English language in 2007. It tweeted a new word every half-

hour until it completed its task in 2014, after 109,157 words. 

There are also bots that exist for political parody. 

Mentioning the words “communism” or “socialism” provokes 

the ire of @RedScareBot Robot J McCarthy himself, who tells 

you the “Red Storm is rising” and to “circle the wagons.”

@DeepDrumpf is a Twitter bot created by MIT, which uses 

neural network technology to analyze data and post tweets in 

the supposed speaking style of Donald Trump. The developers 

claim the bot was trained via transcripts of Trump’s speeches.

The twitter bot @factbot1 makes good use of images. 

Creator Eric Drass programed the bot in response to the 

tendency of some people to believe unproven facts, provided 

they’re accompanied by an image. The bot regularly tweets 

nearly true and nonsensical facts. One such “fact” is that the 

Canadian government derives 38 percent of its income from 

the sale of donuts. This is plausible, given the ubiquity of Tim 

Hortons cafés in the land of the maple leaf, but sadly false.

BOTS OF NOTE
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Colorize Black and
White Photos

1 CHANGE COLOR FORMAT

Open your image file in Photoshop. If you’ve scanned a black 

and white photo or photographed it, you’ve probably got a file 

that uses the RGB color format, which means each pixel is defined 

by values of red, green, and blue. We’re going to change this to 

CMYK, the format used in printing things like this magazine, for 

no other reason than we were messing around with the file, and 

we discovered it works better this way. Head to “Image > Mode 

> CMYK color” [Image A] and make the change—nothing should 

happen to your image, but the color format information up by the 

file name alters.

2 CREATE A SKIN TONE

Now we’re going to create the colors that will be used in 

the image. First, go to the History palette, and create a new 

snapshot of your original image. To do this, right-click the most 

recent History state (probably “CMYK color”), and select “New 

Snapshot.” Select “Merged Layers” from the drop-down, give it 

a name (such as “Original”), and click “OK.” Now, on the right of 

Photoshop’s interface, you should find the Channels palette. If it’s 

not there, open it from the Window menu. In the palette, select 

the Cyan channel, and select a “Brightness/Contrast” adjustment 

from the Adjustments palette (find it in the Window menu if it’s not 

visible). Use this to brighten the channel and increase its contrast, 

and hopefully you should get something resembling a skin tone 

(we’re assuming that your photo has a person in it, because these 

are the most common subjects for the colorization treatment). 

Close the window when you’re done. 

ONCE, THE WORLD WAS BLACK AND WHITE. Created by MGM for The Wizard of Oz (a film cruelly 

overlooked at the Oscars in favor of Gone With the Wind, which invented wind), color wouldn’t become 

mainstream technology until halfway through the 20th century, and even then pockets of resistance 

lingered, where people refused to install the relevant upgrades, claiming that monochrome was 

good enough, and that they didn’t trust the free update not to give their eyes typhoid.

Pity the PC owner in this world of perpetual twilight. The twinkling LEDs in his keyboard could 

only show shades of gray, Hercules made all graphics cards (they were fairly high res though), and 

people weren’t really certain about dithering. Artifacts of this time still exist in the form of black 

and white photos, but we can bring them into the present with a little image editing. Colorizing a 

mono photo can never bring back the true colors from the moment it was taken, but it can have a 

charming look all of its own. –IAN EVENDEN

YOU’LL NEED THIS

PHOTOSHOP 
Available from www.adobe.com.

MONOCHROME IMAGE
Scour your family collection.

3 MAKE MORE COLORS

Create a new snapshot just as you did in step two, 

and call this one “Skin.” You’ll see the snapshots 

stack up above the History palette as you work. Next, 

create some colors that would be appropriate for the 

other objects and areas in your photo. We’re going to make 

them for the gentleman’s suit, his hair, his sweater, and a 

general background color, but you can make as many as 

you need. To do this, we’re going to use the Adjustments 

palette again, but this time using the “Color Balance” 

adjustment, the icon for which looks like a tiny pair of 

scales [Image B]. When you open it, you’ll find color sliders 

that are paired off, so you can slide them between cyan and 

red, for example, or yellow and blue. 

4 COLOR EACH AREA

Look at the area you want to color, and mess with 

the sliders until it’s the hue you want, or at least 

an acceptable color if finding the exact shade is proving 

difficult. You’ll notice that your changes affect the entire 

image, changing the skin tone color you created earlier, but 

this doesn’t matter. When you’ve finished, create another 

new snapshot, naming it appropriately. Go on to do this for 

every color you want to use. Planning ahead is essential at 

this stage, because it’s tricky to come back later and create 

a new color without undoing a lot of your work. It’s worth 

making sure that the snapshot with the largest areas of 

coloring on is created last, because this saves time.
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5 USE THE HISTORY BRUSH TOOL

The next stage requires a steady hand and can take some 

time. We’re going to use a paintbrush tool to merge all the 

snapshots we created into one image, making sure the colors 

go in the appropriate places. Thanks to the mono nature of our 

source, the shading is taken care of for us—we just have to make 

sure we don’t paint over the edges too much. Select the newest 

snapshot in the stack, usually the one at the bottom, and make sure 

that you’ve selected an image layer in the Layers palette, and not an 

adjustment layer. Back in the History palette, click the checkbox at 

the side of one of the other snapshots—it should appear like a brush 

with an arrow next to it; this is the History Brush tool. 

6 START PAINTING

Now, as you paint, the colors from the checked layer should 

be painted on to your selected layer [Image C]. Paint in short 

D

bursts, so you can use Ctrl-Z to undo any mistakes you 

make, and use a selection tool to help you stay in the right 

area if you need to. Feathering the edge of the selection 

(Shift-F6) by a few pixels [Image D] can create a soft border 

between colors if it’s looking a little harsh. Make sure you 

save repeatedly as you go, and it can be worth creating 

extra Full Document snapshots as you work, because 

the History Brush process can do strange things to your 

History palette. 

7 FINISHING TOUCHES

This can be a painstaking process, but it’s worth 

doing for a result you can proudly present to an aged 

relative. When you’ve finished, save the layers as a PSD 

file, then flatten it, convert back to RGB, and export as a 

JPEG ready for printing. 

C

CMYK is used in commercial printing, and splits an image 

into cyan, magenta, yellow, and key (black), which represent 

the inks mixed on the press to create any other color. Most 

images designed to be viewed on a screen are RGB, which 

uses a mixture of red, green, and blue light, to achieve the 

same effect. Monitors, which operate in RGB, don’t always 

accurately represent CMYK colors, especially where reds 

are concerned, but a system of color profiles and screen 

calibrators means colors can be kept consistent across 

screens and on to the press. We’ve only used CMYK here, 

because it made one step easier—you’ll want to convert back 

to RGB before you finish, and not just because CMYK files can 

be significantly larger than RGB ones.

CMYK COLOR
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Boost Your NAS With
Link Aggregation

1 CHOOSE THE RIGHT DRIVE

If your NAS drive [Image A] 

has twin Ethernet ports, 

check its manual or specs to see 

what forms of link aggregation 

it supports. Most drives should 

offer LACP support, although 

the terminology varies between 

manufacturers: QNAP and 

Synology drives refer to 

“802.3ad dynamic,” for example. 

If your drive doesn’t support 

LACP, check to see whether it 

provides its own proprietary 

form of load balancing—see the 

“Wot, No Link Aggregation?” box on the right for details.

>> If you’re in the market for a LACP-compatible drive, look for  

a higher-end SOHO or small business model—QNAP’s TS-231+ is 

around $170 diskless, for example.

2 BUY THE RIGHT SWITCH

Most home routers don’t come with link aggregation 

support on board. The most cost-effective way to add link 

aggregation support to your home network is through a managed 

switch [Image B]. It’s important that you carefully check the link 

aggregation features offered by your chosen switch, because 

cheaper models may not have all the features you need (as we’ve 

discovered to our cost). For example, TP-Link’s TL-SG108 model 

DOES YOUR NAS DRIVE come with two Gigabit Ethernet ports? When plugged into a compatible 

switch, the two ports enable you to combine the two connections using technology called “link 

aggregation” or “port trunking.” Link aggregation is a catch-all term for various methods of 

providing a parallel network connection through multiple Ethernet ports. One basic use is 

to provide a layer of redundancy—if one port fails, the other can still be used. But a more exciting— 

and practical—use for link aggregation is LACP (Link Aggregation Control Protocol).

LACP increases the throughput of your NAS drive, which means you can speed up the shoveling 

of data to and from the drive. Hurrah, you cry: double the transfer speed! Sadly, no. You can’t 

increase the speed of a single network connection using LACP, but you can increase the available 

bandwidth for multiple connections. This helps when two or more users attempt to access the drive 

at once—for example, uploading and downloading files at the same time, or attempting to run two 

movie streams simultaneously, which is why it’s often referred to as “load balancing.” Read on to 

discover what equipment you need, how to configure it, and how to test your tweaks. –NICK PEERS

YOU’LL NEED THIS

LACP-CAPABLE NAS
Look for two Ethernet ports on 

the back.

SMART SWITCH 
This needs to support LACP, too.

costs under $30, but doesn’t support LACP. Instead, you 

need to shell out $69 for the next model up, TP-Link’s SG-

T2008, which we’re using as the focus of this tutorial. If 

you’re using a different model, you need to adapt the steps 

according to your switch’s instructions.

3 BENCHMARK THE DRIVE

Take a rough and ready “before” benchmark by 

copying a large multi-gigabyte file, such as a drive 

image, to or from the NAS. Make a note of the transfer 

speed. Now repeat the process using two separate PCs 

or Macs, and you should find the transfer speed is roughly 

halved on each device, illustrating the current bottleneck.

4 IDENTIFY IP ADDRESS AND LOG ON TO SWITCH

First, verify that your NAS’s Ethernet cables don’t 

need to be plugged into specific ports for link 

aggregation support (any ports can be used on the TL-

SG2008, so we’ve plugged our NAS into ports 7 and 8, the 

two closest to the power switch). 

>> Smart switches are managed one of two ways: either 

through a third-party utility, or (in the case of TP-Link’s 

TL-SG2008 model) through your web browser. Type its IP 

address into your web browser, then log on using the required 

credentials (if you haven’t previously logged on to the switch, 

use the manufacturer defaults, then change them for 

security reasons). If you’re struggling to identify your switch’s 

IP address, use a tool such as Fing (www.fing.io) to locate it.
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5 
SET UP LACP

Once logged in, click “Switching” on the left to expand the 

submenu, then click “LAG.” You’ll see three tabs across the 

top—switch to the “LACP Config” tab. Check the two ports your 

NAS is plugged into (“7” and “8” in our case), set the “Status” drop-

down menu to “Enable,” and click “Apply.” Check both boxes again, 

set mode to “Passive,” then click “Apply” again [Image C].

>> Ports 7 and 8 should now have “LAG1” under the “LAG” column. 

Switch to the “LAG Table” tab, and verify it’s set to “Passive LACP,” 

and the “Hash Algorithm” drop-down is “SRC MAC + DST MAC.”

>> Again, the steps vary for other setups—consult your switch’s 

documentation to see how to implement a passive LACP system on 

the switch for the ports your NAS is plugged into.

6 
SET UP NAS

Open a new tab and log into your NAS through your browser. 

Locate the link aggregation or port trunking section—QNAP 

users should go to “Control Panel > System Settings > Network & 

Virtual Switch,” then select “Interfaces,” and click “Port Trunking.” 

Click “Add,” check both adapters, click the “Port Trunking Mode” 

drop-down, and select “802.3ad dynamic” [Image D]. Click the edit 

button and verify “Layer 2 (MAC)” is selected. Click “Apply.” 

>> Synology users can find step-by-step instructions at www.

synology.com/knowledgebase/DSM/help/DSM/Tutorial/home—

D

look under “Control Panel > Connectivity > Network > 

Link Aggregation.”

7 
TEST CONNECTION AND TWEAK SETTINGS

Repeat your benchmarks—there’s now little or no 

difference when one PC accesses the drive, but the 

drop-off when two PCs are connected should be greatly 

reduced (if not eliminated). If this isn’t the case, double-

check your settings—LACP should be enabled, but passive, 

on the switch side, and just enabled on the NAS side.

8 
SPEED UP SINGLE CONNECTIONS

We lied when we said it isn’t possible to speed up 

transfer times between your NAS and a single PC 

using LACP, but it requires a lot more effort. Find out 

more with our editor-in-chief’s handy online guide at 

www.pcgamer.com/how-to-set-up-nic-teaming-link-

aggregation—just ask yourself if it’s worth it, though.

>> One tip if you go down this route—if you’re using the 

TL-SG2008 to set up multiple LACP connections, assign a 

different Admin Key to each separate LAG pairing you set 

up [Image E]. When repeating step five of the walkthrough, 

set the Admin Key to “2” for this new grouping, which 

should identify itself as LAG2 when done. 

E

Even if your switch or router doesn’t support link aggregation, 

your NAS drive should still be able to support some limited 

form of load balancing through its twin Ethernet ports using 

proprietary technologies built into the NAS itself. Check the 

port trunking or link aggregation settings for a load balancing 

option that doesn’t require link aggregation: WD MyCloud 

users should try the “Round Robin” setting, while Synology 

boxes refer to “Adaptive Load Balance,” and QNAP users 

should look for “Balance-alb.” These settings should support 

load balancing and redundancy, so if one port fails, the other 

continues to function. Attach each port to a different switch, 

and the connection is maintained even if one switch fails.

WOT, NO LINK  
AGGREGATION?
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From Crashing

1 LAUNCH EVENT VIEWER 

If you’re running Windows 8 or 10, the simplest way to open Event 

Viewer is to press Win-X, or right-click the “Start” button and 

select it from the Quick Access menu. If you’re running Windows 7, 

press Win-R to open the Run dialog box, then type “eventvwr” 

and press Enter. If prompted by User Account Control, click “Yes” 

or “Continue.”

2 GET A SUMMARY

The main Event Viewer screen appears [Image A]. The 

middle pane should display three sections of information—

concentrate on the “Summary of Administrative Events” section 

at the top, which displays a list of each type of event logged in the 

past hour, 24 hours, and seven days. Pay particular attention to 

WHY IS IT THAT YOUR PC always seems to develop problems at the most inopportune moments? 

While Windows is pretty good at fixing its own problems, there are still frustrating times when its 

own built-in tools, from self-healing to troubleshooters, fail to do the job.

There’s still no substitute for the self-help approach, and one of the best tools for this is the Event 

Viewer. It’s where you’ll find Windows’ log files, a record of everything that’s going on, including 

symptoms of problems both evident and still hidden away. By carefully examining these logs, you 

can find out what’s causing all kinds of glitches, from obvious—if cryptic—error messages to more 

vague issues, such as sluggish behavior or periodic freezes. This tutorial can help you decipher 

these logs and find a solution to your problem. –NICK PEERS

YOU’LL NEED THIS

A WINDOWS PC 
Running Windows 7, 8, or 10.

the “Critical,” “Error,” and “Warning” sections (but don’t 

panic—yet!). 

3 BROWSE EVENTS 

Click “+” next to a section to expand it and view a 

summary of the events [Image B]. Focus on event 

types that last occurred around the time your problem 

manifested itself (within the hour, 24-hour, or seven-day 

ranges). Double-click an event to open its Summary page, 

then try to identify possible events that correlate to the 

problem you’re investigating.

>> Review all instances of the event type, focusing on the 

time and date each instance occurred. This can help link 

the event to your problem, but go through all event types 

under “Critical,” “Error,” and possibly “Warning” to see 

whether there are multiple events linked to the problem. 

Make a note of each one, then read on to discover how to 

examine them in more depth.

4 GET HELP ONLINE

Make a note of the description—the “Details” tab 

provides more technical data. You’ll notice an “Event 

Log Online Help” link at the bottom of the “General” tab, 

which if you click throws up a message—sadly, this doesn’t 

work in Windows 10, but don’t worry; instead, open your 

browser and go to www.microsoft.com/technet/support/

ee/ee_advanced.aspx.

>> Select “Windows Operating System” for “Microsoft 

Product,” but leave “--All Versions--” selected. Type the 

Event ID number into the “Event ID” box, and the same 
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source as listed in Event Viewer into the “Event Source” box (for 

example, “Application”) [Image C]. Click “Go” and a list of matching 

results is shown. Click one to read more about the problem; if there 

are multiple entries, try them all.

5 
BROADEN OR NARROW YOUR SEARCH

TechNet may return no results (or simply return some 

generic information about the fault that doesn’t really 

help). Don’t give up, though. Make a note of the Event ID, Source, 

and description under the “General” tab in Event Viewer, then type 

these into a search engine, and see what results come up. You may 

find more troubleshooting information via a web page or forum.

>> If too few results are returned, search for fewer words or 

omit the Source or Event ID from your terms. If too many results 

come back, narrow it down by including more information. Include 

specific references to file names in the event log, for example, 

or provide more general information, such as your version of 

Windows, hardware device, or software program.

6 
BROWSING & FILTERING LOGS

What happens if you can’t find the information you’re looking 

for? It’s likely the events you need to track are buried away. 

Manually browse the logs to narrow your search. Expand “Windows 

Logs” in the left-hand pane, where you’ll find logs in categories. Use 

“Applications” to search for program-related problems [Image D], 

and “System” for Windows and hardware.

>> Logs record all manner of information, much of it irrelevant—

at least when troubleshooting a problem. Click the “Filter Current 

Log” button in the right-hand pane to filter the list a number of 

different ways: by the time it occurred, the type of event (focus on 

“Critical,” “Error,” and “Warning”), event sources, IDs, keywords, 

or any combination. Click “OK” when done.

E

7 
CREATE AND SAVE YOUR CUSTOM VIEW

If you want to create a filter that provides you with 

information across multiple logs, or wish to create a 

filter you can easily access in future, click “Create Custom 

View” under “Actions.” It works in the same way as the 

filter—to monitor more than one log with your custom 

view, click the “Event logs” drop-down menu, and check 

the logs you wish to include [Image E].

>> Click “OK,” then give your custom view a suitable 

name, and choose where to save it within the “Custom 

Views” tree in the left-hand pane. Going forward, you’ll be 

able to access this view at any time directly from here—

it’s the perfect shortcut for targeted troubleshooting that 

takes an extended period of time to monitor and act upon.

8 
CREATE AND SCHEDULE ALERTS

Change the name to something that will help you 

recognize it in Task Scheduler, and click “Next” 

twice. Neither email nor “display a message” options 

work, so leave “Start a program” selected, and click 

“Next.” Type “msg” into the “Program/script” box, then 

type “*” followed by your message (for example, “*Error 

Alert”) into “Add Arguments.” Click “Next > Finish > OK.”

>> Event Viewer also lets you create alerts that are 

triggered when specific events occur. This can be useful 

for troubleshooting underlying problems, as you may find 

a seemingly unrelated event is triggering the error, or get 

early warning that something nasty is about to happen. 

Once you’ve located the event you wish to monitor, right-

click it and choose “Attach Task to This Event.”

9 
REMOVE ALERT

Eventually, you may no longer want that alert 

popping up (because you’ve fixed the problem!). To 

remove it, open Task Scheduler—type “scheduler” into the 

“Search” box, and click “Task Scheduler” when it appears, 

or press Win-R, type “control schedtasks,” and click “OK.” 

Expand “Task Scheduler Library > Event Viewer Tasks,” 

right-click the alert, and choose “Delete,” then “Yes.”

10 
TROUBLESHOOTING MADE EASIER

Now you’ve discovered the basics of how Event 

Viewer works, you can use it to help you track 

down problems in the future. By examining your system 

logs using its interface [Image F], you should be able 

to locate the information you need to go out and not just 

diagnose what’s ailing your PC, but also hopefully find a 

solution to bring it back to good working order, too. 

D F

69MAXIMUMPCmaximumpc.com SPRING 2017



Audio Recordings

1 GET AUDACITY

Visit www.audacityteam.org/download/windows and select 

the first option: “Audacity 2.1.2 installer.” This version contains 

additional help files, in case you need them later on. The download 

starts automatically; ignore the links that appear on the following 

page. Run the software installer, leaving the default settings as 

they are.

2 MICROPHONE CHECK

Launch Audacity and take a look at the microphone and 

speaker settings at the top. Make sure these are set 

correctly, so you aren’t recording from your webcam, rather than 

your USB microphone, for example. If you’re not sure which device 

is selected, click the area marked “Click to start monitoring,” and 

the input from the selected microphone is shown as a green bar.

WITH AN INEXPENSIVE PC MICROPHONE, it’s easy to record your own podcasts, music, audio 

books, or narration for videos. The results can sound great, but by taking a little time to enhance 

them, you can bring them up to professional standards. Audacity is the perfect software for this; it’s 

powerful, but easy to use, and it’s free.

Audacity does an excellent job of cleaning up audio, but there are a few steps you can take to 

ensure you get the best possible recording quality in the first place. First, make sure the input 

volume is set correctly by right-clicking the speaker icon in the System Tray, selecting “Recording 

devices > Microphone > Set up microphone,” and following the instructions.

It’s also worth using a pop filter to prevent noises being created by the rapid movement of air as 

you sing or speak. Make your own by following the guide at http://bit.ly/1Y2JwWh. –CAT ELLIS

YOU’LL NEED THIS

AUDACITY 
You can download it from  

www.audacityteam.org.

SPITFISH 
An Audacity plugin available 

from http://bit.ly/1i1zfRG.

3 MAKE YOUR RECORDING

Click the red button or tap Shift-R to start 

recording. Try to keep a constant distance from the 

microphone, and don’t worry if you trip over a word—pause 

for a second and say that part again. You can easily cut any 

mistakes afterward. Once you’re done, click the rewind 

button, then click play to see how it sounds. It’s best to use 

headphones for this. 

>> If you notice background noise in your recording, select 

a quiet bit of the track by clicking and dragging on a flat part 

of the blue waveform. Click “Effects > Noise reduction” 

[Image A], then click “Get noise profile.” Tap Ctrl-A to select 

your recording, click “Effects > Noise reduction” again, 

then use the sliders and preview to adjust the strength of 

the effect. When you’re happy, click “OK.”

4 TRIM TO SIZE 

If there’s a pause at the start of your recording that 

you don’t want, click and drag to select this part 

of the waveform, then tap Delete. You can also use this 

technique to remove any sections of audio where you made 

a mistake and had to repeat yourself. If you only want to 

keep a small part of the recording, select that section, then 

click “Trim Audio” beside the “Paste” button.

5 ADJUST LEVELS

Did you accidentally move away from your 

microphone while you were recording? If so, some 

parts of the resulting audio might be louder than others. If 

that’s the case, tap Ctrl-A to select everything, then click 

“Effects > Leveling,” and experiment with the options 
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[Image B], checking them with the “Preview” button (the amount of 

leveling required depends on your own recording).

6 
ELIMINATE PROBLEMS

If there’s a single particularly loud part of your recording, 

select it, then tap Ctrl-1 repeatedly to zoom in and isolate 

the specific waves that are causing it. Make sure you have just 

these waves selected, then click “Effect > Amplify,” and reduce the 

volume by a few decibels. Use the “Preview” button to check how it 

sounds before clicking “OK.” Tap Ctrl-T to zoom back out. 

>> Harsh “s” sounds are a common problem in home audio 

recordings, but there’s a plugin for Audacity called Spitfish that can 

reduce them. Download it from http://bit.ly/1i1zfRG. Extract the ZIP 

archive to “Program Files (X86) > Audacity > Plugins.” Return 

to Audacity, click “File > Export Audio,” save your audio in WAV 

format, then restart the program.

7 
TONE DOWN HARSH SIBILANCE

Re-open your file, selecting the option to make a 

copy in case you need to undo your changes. Now 

select “Effects > Add/remove plugins > SPITFISH > 

Enable > OK.” Tap Ctrl-A, then click “Effect > Spitfish  

de-esser,” and experiment with the settings to tone down 

the sibilance [Image C]. 

8 
EXPORT AND SAVE

Your audio should now sound much better! Click 

“File > Export Audio,” and choose a file type. If 

you’re planning to edit it again later, or use it as a soundtrack 

for a video, save it in WAV format to keep the quality high. 

If it’s finished, and you’re ready to share it, save it in MP3 

or WMA format; these provide compression to reduce file 

size, and are supported by most media players. 

1. RECORD AND PLAY
Use these buttons to make and listen to 

recordings. Hover your mouse over each 

one to see its corresponding keyboard 

shortcut and any variations. 

2. QUICK CONTROLS
These buttons are used to cut, copy, and 

paste sections of audio. You can also 

mute a section (“Silence”), or cut away 

everything before and after it (“Trim”).

3. EFFECTS
In this section, you’ll find all of Audacity’s 

tools for refining recordings, plus 

creative options, such as “Auto Duck,” 

which enables you to speak over a music 

track by lowering its volume.

4. SELECTION
Click and drag on the waveform to select 

part of the recording. If you want finer 

control, tap Ctrl-1 to zoom in.

5. WAVEFORM
A representation of your recording.  

Audacity records in stereo by default, so 

there are two tracks (left and right) with 

identical waveforms.

6. RECORDING AND PLAYBACK
Make sure you have the correct input and 

output devices selected, to ensure you 

aren’t recording via your webcam instead 

of your USB microphone, for example.

ENHANCE YOUR RECORDINGS WITH AUDACITY

1
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ZAK STOREY, REVIEWS EDITOR

LENGTH OF TIME: 2-3 HOURS

Just How
s?Many Cores?

m

SINCE THE LAUNCH of Intel’s Core 

series processors, way back in 2009, 

there’s been one simple rule associated 

with its mighty lineup of chips: If you’re 

into gaming, to avoid bottlenecks, you’re 

going to want to equip yourself with a 

Core i5, minimum. Four cores are king—

any more, and you’re wasting your hard-

earned dollar; any fewer, and you’re in 

for a world of frame rate hurt. 

However, a lot has changed since 

2009. And although the incremental 

processor performance increases Intel 

has staggered out of the gates since 

then have been somewhat lackluster, 

cumulatively they’ve provided us 

consumers with about a 70–80 percent 

increase in computational performance.  

So we got to thinking: As game devs 

still haven’t managed to take advantage 

of the multiple cores we already have, 

does that old saying still ring true? Do 

you still benefit from having a quad-

core, high-clocked i5, over a dual-core 

i3? Or have those IPC improvements 

lead us into an age when you can get 

away with a cheaper Pentium for all your 

1080p gaming needs? With Kaby Lake 

finally introducing Hyper-Threading on 

its Pentium range, allowing for dual-

core and four-thread budget offerings, 

we decided to put it to the test in this 

quad-optioned mid-range build.

THE CONCEPT

LEVEL OF DIFFICULTY: MEDIUM 

Is it time to ditch the old gaming adage?
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CORE VARIANCES 
DUE TO PAGE LAYOUT RESTRAINTS, we can’t put all four variants 

of our system in the table on the right. However, as it’s only the 

processor that changes during testing, we’ll list them here. 

Our base system features the Pentium G4600 listed in the table, 

with two cores, four threads, and a 3.6GHz clock speed (no turbo) 

for a total of $1,236. The next uses Intel’s Core i3-7300, with two 

cores and four threads, still sans turbo, packing an impressive 

4.0GHz, taking the total to $1,278. The next step up is substantial: 

the Core i5-7600K, a four-cored, four-threaded turbo behemoth, 

capable of hitting 4.2GHz at stock, and bumping the price up to 

$1,361. And, finally, the Core i7-7700K. Four cores, eight threads, 

and a 4.4GHz maximum turbo brings the total skyrocketing up to 

$1,438—a difference of $202 from Pentium to Core i7.

We decided to take advantage of Corsair’s Carbide 270R. This 

budget chassis checks all the boxes for our mid-range build. It’s 

accessible, comes with just enough hard drive support to keep 

us happy, and provides a clean-looking aesthetic inside and out. 

Cooling support is strong, and the addition of a clean PSU cover 

made it a no-brainer. For GPU, we chose Nvidia’s GTX 1060 6GB. 

We could have gone with an AMD RX 480 8GB, but the GTX 1060 

provides more frames per dollar than the RX 480, so it wasn’t a 

tough call to make. On top of that, two SSD hard drives and 16GB 

of DDR4 pull this beauty right into 2017 with a bang.

COOLER MASTER’S LATEST 240MM AIO was a headache, 

as it deviates from the traditional Asetek mounting 

design. With most coolers, you secure the backplate to 

the motherboard using double-ended screws of varying 

sizes, depending on whether you’re attaching it to a 2011 

board, a 1150/51 board, or an AMD offering. Then you 

place the CPU block on the four screws, and secure it 

with four thumb screws. With the MasterLiquid Pro, 

Cooler Master has removed the screw between the 

board and the backplate, so you have to position the 

backplate through the board, with long pre-attached 

screws. Then, while holding the backplate in place, 

you position the block on the screws. Finally, while 

somehow holding it so it doesn’t move, you use the 

thumb screws to secure it. Pro tip? Find a buddy or, as 

we did, literally use your head to hold the block in place.

ONE OF THE FEW COMPLAINTS we have about Corsair’s 

270R stems from the uppermost fan mounts—

primarily that they lack any form of dust cover. Being 

an awkward size and not supporting 360mm radiators 

either, regardless of its dimensions, makes things even 

more frustrating when you’re on the hunt for a dust 

filter. Your best bet, if building in this particular chassis, 

would be to use two 120mm fans to blow air out of the 

top of the chassis. This should at least prevent too much 

dust entering your system while it’s running, although it 

will need some loving maintenance to keep it truly clean 

in the long term.

1

2

COOLING ISSUES

DUST CONUNDRUMS

INGREDIENTS

PART
STREET 
PRICE

Case Corsair Carbide 270R $70

Motherboard Gigabyte Z270X-Ultra Gaming $165

CPU Intel Pentium G4600 $87

Memory 16GB (2x 8GB) Crucial Tactical @ 2,666MT/s $102

GPU Nvidia GeForce GTX 1060 6GB $245

PSU Corsair RM650X $109

Storage 1 Sandisk Ultra II 240GB SSD $80

Storage 2 Crucial MX300 1TB SSD $260

Cooling Cooler Master MasterLiquid Pro 240  

& 1x Corsair ML120 Pro Red $118

Total $1,236
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OH, THE PROBLEMS of using bits and pieces from our storage 

cupboard: We wanted to use a custom cable kit in conjunction 

with our Corsair RM650X power supply, just to spruce it up a 

bit, but our only kit had already been cannibalized for our 

editor’s Dream PC from two issues ago, so there were only a 

few bits remaining. A single CPU power, one spare ATX power 

(specifically designed for the RMX, as the HXi has different 24-

pin requirements), and a single GPU cable. The GPU cable in 

question, however, was a dual connector, so we were left with 

one part hanging out just below the GPU, which we couldn’t hide 

around the back, or behind the cable cut-out situated below.

COLOR CO-ORDINATION wasn’t at the front of our minds 

when we built this machine, but we’re actually quite 

impressed with how it turned out. We threw in a Corsair 

ML120 Pro in red in the back to spice it up a little, and help 

the air shift around efficiently inside, but the combination of 

the red motherboard with the blue cooler and green GPU 

actually kinda works, especially considering the price. The 

Z270X-Ultra Gaming does come with additional strips if you 

do want to change out to another color—but, hooey, that’s a 

lot of effort for not a lot of gain.

3 5

4 6

GPU CABLE ISSUES PSU COVER

CABLE MANAGEMENT SORTED LED CORNUCOPIA

ALTHOUGH CORSAIR still doesn’t have quite as clean and 

beautiful a PSU cover as a lot of its competitors, it’s damn 

good to see one included here. Three-quarter sized, it 

provides plenty of ventilation for multiple orientations of 

power supply, and easily lets us hide the vast majority of our 

excess cables below. One thing that still haunts us from our 

water-cooling days, however, is fan orientation. We always 

advise that you install your power supply with the fan facing 

down wherever possible, because a leak from the AIO or a 

GPU block, for instance, is likely to kill it.

WE WENT ALL-OUT with this little build to get the cable 

management just right. Using a plethora of cable ties, we 

secured what we could to the back of the chassis, to make sure 

airflow wasn’t restricted, and to ensure that the rear side panel 

was easier to replace—and, to be honest, to keep everything 

looking a little tidier. Take your time on this bit: Figure out which 

cables go under what, and where you can hide stuff, without it 

being too much of a major issue.
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1
Although you can’t see it from the 

front, it’s entirely possible to mount 

two 3.5-inch hard drives in the back. Strip 

out the crazy 1TB SSD here and replace it 

with an HDD instead, and you could easily 

save $200.

2
We had issues with the fans running 

in push configuration in this chassis. 

Cooler Master’s fan design allows the fan 

blade unit to move forward, eventually 

scraping against the chassis at higher 

speeds. We added rubber spacers to stop 

this from happening.

3
Gigabyte’s Z270X-Ultra offers 

extra spacing between front panel 

headers, making it easy to identify where 

to install your power cables. Additionally, 

we never install the HD audio pass-

through, because quality generally tends 

to be far worse than via the rear I/O.

WELL, THERE YOU HAVE IT FOLKS: a double 

whammy mini feature buried within Build It. 

So, is this the end of the road for Intel’s Core i5 

series processor? Probably not. Legacies are 

always difficult to quash, and just as AMD’s 

Ryzen has one hell of a stigma to overcome 

in the mind of the average PC enthusiast, so 

does the concept of the Core i5 not being the 

king of gaming.

Take a glance at the Internet, and you’ll see 

dozens of commentators purporting that the 

Core i5 is the way to go, and that even going up 

to the Core i7 isn’t worth the cash, because you 

only gain 10 percent performance in games. 

The reality, on the other hand, is very different. 

Across the board, from one of Intel’s lowest 

$80 chips all the way up to its mainstream 

rendering powerhouse at $350, there’s 

absolutely no difference in game. It seems 

those IPC improvements have been making a 

difference to the ecosystem after all—just not 

in the way we might think.

Building this particular system was actually 

considerably frustrating—mostly due to the 

cooler being so incredibly annoying to install. 

The backplate, coupled with the fans scraping 

the front of the chassis, and the pipes being 

far too resistant to movement, really gave us 

pause for thought as to whether this was the 

right cooler for us. We even had to unplug and 

reinstall the PWM pump fan header at first, 

because it refused to pump water around 

the system, forcing our Intel Core i7, that we 

tested first, to install Windows 10 on to the 

SSD at 99–100 C, at a paltry 200MHz. Although 

it was certainly impressive to witness, it was 

also excruciatingly frustrating.

Cooler problems aside, it turned out to be 

a pretty clean-looking build. Keeping all the 

storage around the back of the motherboard 

tray actually makes a world of difference. And, 

although the PSU cover is only a 75 percent 

case fit, it does leave plenty of room for 

radiators and cooling up front, and it grows 

on you after a while. Is there anything we 

would change? Well, if this were genuinely 

a build for purchase, not designed for that 

wide range of processor testing, we would 

probably drop the 1TB SSD in favor of an HDD, 

potentially go down to a B250 motherboard to 

save a bit of cash, use a lower specced PSU, 

and potentially even 8GB of DDR4, depending 

on budget constraints. That would bring 

this particular build down to around $630, 

including shipping. 

THE END OF THE ROAD FOR THE CORE i5?

2

1

3

Best scores are in bold. All games were tested at the highest possible 1080p settings, bar Deus Ex (tested at Very 
High graphical profile). 

INTEL PENTIUM 
G4600

INTEL CORE  
i3-7300

INTEL CORE  
i5-7600K

INTEL CORE  
i7-7700K

Cinebench R15 Single/Multi 

(Index)
148/388 172/437 182/699 191/960

CrystalDisk QD32 Sequential 

Read/Write (MB/s)
538/514 535/510 541/516 537/515

3DMark Fire Strike (Index) 9,179 9,542 10,606 11,184

Deus Ex Mankind Divided  

(Avg fps)
25 25 25 25

Rise of the Tomb Raider 

(Avg fps)
39 39 38 39

Far Cry Primal (Avg fps) 66 67 67 67

Attila: Total War (Avg fps) 37 38 39 39

Steam VR Performance Test 

(Index 0–10)
8.2 8.2 8.3 8.0

BENCHMARKS
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The Velox nearly matches Digital 
Storm’s massive Aventum 3—for 

several thousand dollars less.

in the lab
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ABOUT SIX MONTHS AGO, we put the giant 

blue box that was Digital Storm’s Aventum 3 

desktop to the test. It was a beastly gaming 

machine, but heavy as hell, and just as 

expensive. We’re thinking of the Velox as 

the Aventum’s little brother, and for a little 

more than half the cost, it performs nearly 

as well as its elder sibling.

A big part of the Aventum’s $8,500 price 

tag was due to its Hyper-Threaded Core i7-

6950X, which checks in at $1,700. The Velox 

makes up for skipping on the enthusiast-

class CPU route thanks to Intel’s new Kaby 

Lake processors. Our unit was outfitted 

with a Core i7-7700K, overclocked to 

4.9GHz, one of the highest desktop core 

clocks we’ve seen on a prebuilt system. 

While it doesn’t quite keep up with the 

6950X in Cinebench R15 or x264, which 

really take advantage of Hyper-Threading, 

the 7700K was hot on the Aventum’s heels 

in PCMark 8 Creative, with a score of 9,404. 

To complement the Kaby Lake CPU, the 

Velox features an Asus Maximus IX Hero 

Z270 motherboard. Slotted in there is 32GB 

of DDR4-2666 RAM, and a 512GB Samsung 

960 Pro SSD, connected via NVMe. For 

additional storage, the 960 Pro is backed 

up by a 3TB Toshiba HDD. A Corsair H115i 

liquid cooler keeps CPU temperatures 

down, while the case is outfitted with 

Thermaltake Riing fans for everything 

else. Finally, graphics are handled by a 

pair of GeForce GTX 1080s, outfitted with 

EVGA’s ACX 3.0 cooling solution.

Size-wise, the Velox’s all-metal chassis 

is exactly what we like to see from a top-

end gaming desktop: big (22 x 19.5 x 10 

White-hot performance
Digital Storm Velox

inches) but not excessive, with a large side 

panel through which to see its glorious 

innards. Even better, the side panels attach 

via metal pegs fitted into rubber sockets, in 

lieu of thumb screws. The panels attach and 

detach with a snap, making it exceptionally 

easy to access the mobo and hard drive 

cages. There’s a lot of empty space, giving 

things a minimalist aesthetic, but it also 

means the case can only accommodate one 

additional HDD in the main cage, and two 

SSDs behind the motherboard. That’s not a 

lot of expandability for this level of system, 

but it should be enough for most users. 

Either way, Digital Storm uses custom-

color sleeved PSU extension cables and 

cable combs to keep things tidy, combined 

with remote-controlled LEDs, making it all 

very pretty to look at. 

BEAUTY AND BEAST
Aesthetics are one thing, but they don’t 

count for much without performance to 

match. Luckily, the Velox plays games as 

good as it looks. The pair of EVGA GeForce 

GTX 1080s handled all the difficult tasks we 

threw at them with aplomb, but sometimes 

faltered at the seemingly easier tasks: 

rendering games at the paltry resolution of 

1080p. We measured an average of 113fps 

across Rise of the Tomb Raider’s three-

part benchmark in 1080p at max settings, 

while The Division registered 150fps at the 

same settings. Far Cry Primal, on the other 

hand, pulled in only 82fps at 1080p—a low 

score for what should be an easy task.

This can largely be accounted for by SLI 

not playing nice with lower resolutions, 

9
VERDICT Digital Storm Velox

 BROTHERLY LOVE Beautiful 

build quality; outstanding 

high-resolution gaming 

performance; way less 

expensive than the Aventum 3.

 ESTRANGED FAMILY Few empty drive bays; 

poor 1080p performance.

$4,737, www.digitalstorm.com

and all of our tests fared much better at 

higher resolutions. Far Cry Primal, for 

instance, actually scored the same in 4K 

as it did in 1080p, with its best frame rate 

showing up in 1440p (95fps). RotTR and The 

Division scored 104 and 114fps in 1440p; 

76 and 70fps in 4K, respectively, all at max 

settings. This is thoroughly impressive, 

because even big brother Aventum 

sometimes struggled to keep 4K frame 

rates consistently above 60fps. 

Even at half the Aventum’s price, the 

Velox is still an expensive machine. Like 

most custom-built systems, you could 

probably shave $1,000 or more off the price 

by building it yourself, but Digital Storm 

brings a lot to the table here. Between 

build quality and all the benefits of having 

a warranty and customer service, the 

Velox delivers on the promise of a top-end 

gaming machine. –BO MOORE

Our desktop zero-point has a Core i7-6700K overclocked to 4.6GHz, an XFX Radeon R9 Fury X, 32GB of Kingston 
HyperX Savage DDR4-2400, and a 256GB Samsung 950 Pro, mounted on an Asus Z170i Pro Gaming mobo.

SPECIFICATIONS

Processor Intel Core i7-7700K  

@ 4.9GHz

Graphics 2x SLI EVGA ACX 3.0 

GeForce GTX 1080 8GB

RAM 32GB Digital Storm 

Performance Series  

DDR4-2666

Motherboard Asus Maximus IX Hero 

(Z270)

Primary 
Storage

512GB Samsung 960 Pro M.2 

NVMe SSD

Additional 
Storage

3TB Toshiba

Cooling 
Solution

Corsair H115i 280mm liquid 

CPU cooler, Thermaltake 

Riing case fans

PSU 850W EVGA SuperNOVA

Case Digital Storm Velox Chassis

Warranty Lifetime Expert Care with 

three-year limited warranty  

(three-year labor & one-year 

direct part replacement)

BENCHMARKS
ZERO- 
POINT

Cinebench R15 (Index) 987 1,047 (6%)

TechARP’s x264 (fps) 21.93 23.59 (8%)

PCMark 8 Creative (Index) 7,675 9,404 (23%) 

CrystalDiskMark 4K Read (MB/s) 54.85 58.79 (7%)

CrystalDiskMark 4K Write (MB/s) 171 215.3 (26%)

Far Cry Primal (fps) 76 82 (8%)

The Division (fps) 78 152 (95%)

Rise of the Tomb Raider (fps) 41 113 (176%)

3DMark Fire Strike (Index) 15,026 25,974 (73%)

0% 10% 20% 30% 40% 50% 60% 70% 80% 90% 100%
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RGB mobos? We 
still don’t get it.

in the lab
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WITH THE VAST MAJORITY of boards, as far 

as average users are concerned, providing 

little beyond greater connectivity and 

expandability, forking out the cash for 

flashier mobos often makes little to no 

sense. Performance differentials are 

almost non-existent, and taking a GTX 1080 

and a Core i7-7700 from a $70 B250 mobo 

all the way up to the $300 kings of Z270 

will likely provide practically no difference 

beyond increased connectivity, better 

looks, and a flashier UEFI BIOS. Unless 

you’re on the liquid-nitrogen cooling train, 

with a full-fledged arsenal of Core i7s 

beside you, you’re unlikely to see much 

difference, as the PC ecosphere tends to 

lend itself more to silicon limits within the 

processors themselves than anything the 

motherboards can muster.

So, Gigabyte’s Z270X-Ultra Gaming 

impressed us from the get-go. On the 

outside, it certainly looks like a high-

end choice. A quick glance, and you’ll see 

brushed black aluminum heatsinks, the 

now ever-present RGB lighting, a rear I/O 

shield, and a cornucopia of connectivity, 

including a single M.2 PCIe x4 slot, a U.2 

connector, a bank of four SATA ports 

(including SATA Express), two separate 

SATA 6Gb/s ports, and two internal USB 

3.0 headers as well. No doubt a premium 

offering, then? Well, perhaps not—the 

A badass budget-busting bombproof board

Gigabyte Z270X-Ultra  
Gaming

Z270X-Ultra Gaming is currently available 

for a meager $165. That’s $30 less than the 

ITX board we picked up from MSI this issue, 

and half the price of MSI’s overclocking 

pro Z270 XPower Gaming Titanium we 

reviewed the issue before.

Does it show? Sort of, but not in the 

places you might expect. Performance 

across the board was actually pretty 

impressive. At stock, it easily outpaced 

every single motherboard we’ve tested 

to date, scoring a pleasing 21.16fps 

in X265, and a staggering 995 points 

consistently in Cinebench R15. Memory 

latency was also top-notch, coming in at an 

incredible 54.0ns.

However, it’s not all plain sailing, and 

it’s only when you start looking at how the  

board handles voltage, in particular, that 

you realize just where it’s coming unstuck. 

By default, the Ultra Gaming auto-fixes 

CPU Vcore voltage between 1.3 and 1.35V—

at most, 0.1V higher than Intel’s prescribed 

settings, and more than 0.05V higher than 

most other competitors. Not only does this 

improve general stability, but it also allows 

Gigabyte to optimize CPU performance 

across the board at stock.  The downside, 

however, is that it draws notably more 

power from the wall under load, with our 

figures showing 156W maximum, with only 

the XPower coming close out of the five 

boards we’ve now tested, at 131W. And, 

alas, that isn’t the end of the Ultra’s voltage 

problems. During our overclocking spree, 

and similar to all the boards previously 

tested, it still managed to achieve the 5GHz 

silicon limit, but at a noticeably higher 

voltage than the others, at 1.33V, with 

only the Z270i Gaming Pro Carbon coming 

close, at 1.32V. Undervolting also failed to 

impress, with the Gigabyte again being the 

highest, at 1.12V at stock.

Overclocking is only a small part of 

the package, of course, and although 

tweaking voltages can reduce overall 

processor temperatures, it’ll probably be 

an afterthought for the majority of people. 

Voltages aside, the plethora of connectivity 

options, fantastic aesthetics, strong stock 

performance, and price make the Z270X-

Ultra Gaming phenomenally good value 

for money. And similar to the offerings 

Gigabyte mustered last generation, we 

can’t see many, if any, mobo manufacturers 

ousting Gigabyte from the top spot of best 

bang for buck just yet. –ZAK STOREY

9
VERDICT Gigabyte Z270X-Ultra Gaming

 GIGATON HAMMER Vast 

feature set; great aesthetics; 

RGB lighting if you want it; strong stock 

performance; impressive price.

 GIGGLEBYTE Voltages slightly high; 

potentially higher temps because of that.

$165, www.gigabyte.com 

Best scores in bold. Our test bench consists of an Intel Core i7-7700K (separate chip to our Asus Maximus IX Hero 
review), 16GB of Corsair Dominator Platinum @ 2,400, GeForce GTX 1080, and 250GB Samsung 960 Evo PCIe SSD.

Gigabtye Z270X-Ultra Gaming Asus Maximus IX Hero

X265 Benchmark (fps) 21.16 21.02

Cinebench R15 (Index) 995 977

FryRender (m:s) 3:32 3:36

AIDA64 Memory Latency (ns) 54.0 59.5

CrystalDisk Sequential Read/Write (MB/s) 3,073/1,562 3,131/1,546

Power Draw Idle/Peak (W) 42/156 43/126

Far Cry Primal @ 4K (Average fps) 43 43

3DMark Fire Strike Extreme (Index) 9,532 9,442

Maximum Overclock Achieved (GHz) 5.0 5.1 

Lowest Undervolt @ Stock (V) 1.12 1.07

Lowest Voltage @ 5GHz (V) 1.33 1.28

BENCHMARKS

SPECIFICATIONS

Chipset/Socket Z270/LGA 1151

Form Factor ATX

Memory Support 64GB DDR4 @ 3,866MT/s

M.2/U.2 Support
1x M.2 PCIe x4,  

1x U.2 PCIe x4

SATA Support
6x SATA 6Gb/s,  

2x SATA Express

Max PCIe Support 3x PCIe x16 (x16, x8, x4)

Rear I/O

5x USB 3.1, 2x USB 2.0,  

1x USB 3.1 Type C,  

1x Intel Gigabit Ethernet, 

1x PS/2 combi port,  

1x DVI-D, 1x HDMI,  

1x S/PDIF out, 5.1 audio
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SPECIFICATIONS

Chipset/Socket Z270/LGA 1151

Form Factor Mini-ITX

Memory Support 32GB @ 3,800MT/s

M.2/U.2 Support 1x M.2 PCIe x4

SATA Support 4x SATA 6Gb/s

Max PCIe Support 1x PCIe 3.0 x16

Rear I/O Wireless ac, 2x USB 2.0, 

3x USB 3.1 Type A,  

1x USB 3.1 Type C,  

Intel Gigabit Ethernet, 

5.1 audio, SPDIF out, 

HDMI, DisplayPort

IN THE EARLY NOUGHTIES, an interesting 

concept arose from our fervent pursuit 

of more powerful technology: As 

transistor size shrank, efficiency per watt 

increased, and die size fell, manufacturers 

aggressively pushed for smaller and 

smaller devices. The ITX form factor was 

developed in 2001 by VIA Technologies as 

a way of shrinking desktop computers to 

a more manageable size, and it has since 

become a staple for enthusiasts looking to 

build a tiny desk-sitting powerhouse.

MSI’s Z270i Gaming Pro Carbon is the 

first in the latest line of Kaby Lake boards 

we’ve seen that deals with ITX. And we’ll 

be honest: Although the on-board support 

is as good as, if not better than, it has ever 

been, the rear I/O gives us pause. This 

isn't limited to MSI, though—Gigabyte, 

Asus, and ASRock have all stripped down 

the rear I/O of their ITX offerings, and put 

about 25 percent less stuff on it. Because, 

you know, ITX system users have fewer 

peripherals, or something. Yeah, we 

don’t get that logic either. Anyway, let’s 

compare the Z97i Gaming AC against the 

Z170i Gaming Pro and the Z270i Gaming 

Pro Carbon. The Z97i has four USB 3.0 and 

Z270 ITX offering

four USB 2.0 connections, giving a total of 

eight. The Z170i has four USB 3.1 and two 

USB 2.0, for a total of six. And the Z270i has 

three USB 3.1 and two USB 2.0—a total of 

just five. It sounds like a petty complaint, 

but look at the plethora of peripherals that 

connect via USB, and it’s easy to see how 

quickly those connections can be taken 

up. A mouse, a dual-port keyboard with a 

pass-through, a webcam, a USB headset—

that’s five ports taken up immediately. Got 

a wireless dongle? Too bad. A wireless 

controller? Not any more. 

PIN POINTS
USB woes aside, MSI’s Z270i Gaming Pro 

Carbon is a solid board. It’s nice to see the 

ITX layout get finalized, with 24-pin and 

8-pin power getting concrete placement, 

and SATA and USB being more accessible 

than before. The reinforced DDR and PCIe 

ports, although laughable, do give you a 

little more assurance—the weight of a GPU 

isn’t going to shatter them. And the M.2 

PCIe x4 slot on the back keeps us happy 

when it comes to super-fast storage.

Performance was consistent, as 

always, with little variance between many 

of the benchmarks. Memory latency took a 

hit, and our X265 benchmark was the worst 

of the boards we’ve tested so far, but that 

was made up for by the lower power draws. 

Overclocking was a little under par—

our lowest undervolt from stock was 1.1V, 

the highest of the boards we’ve tested, and 

we managed 5GHz at 1.32V, compared to 

the 1.3V of last issue’s more overclocking-

oriented XPower Titanium. It is a solid 

offering—it’s just a shame that the rear I/O 

is shrinking at such a rate. –ZAK STOREY

MSI Z270i 
Gaming Pro 
Carbon AC

7
VERDICT MSI Z270i Gaming Pro Carbon AC

ANACONDA Solid performance; 

M.2 port on rear.

 EARTHWORM Limited overclocking; 

disappointing rear I/O.

$180, www.msi.com

Best scores are in bold. Our test bench consists of an Intel Core i7-7700K, 16GB of Corsair Dominator  
Platinum @ 2400, a GeForce GTX 1080, and a 250GB Samsung 960 Evo PCIe SSD.

MSI Z270i Gaming  
Pro Carbon

MSI Z270 XPower Gaming 
Titanium

X265 Benchmark (fps) 20.57 21.15

Cinebench R15 (Index) 982 984

FryRender (m:s) 3:31 3:36

AIDA64 Memory Latency (ns) 66.3 59.7

CrystalDisk Sequential Read/Write (MB/s) 3,160 3,249

Power Draw Idle/Peak (W) 41/117 45/131

Far Cry Primal @ 4K (Avg fps) 43 42

3DMark Fire Strike Extreme (Index) 9,508 9,595

Maximum Overclock Achieved (GHz) 5.0 5.0

Lowest Undervolt @ Stock (V) 1.1 1.09

Lowest Voltage @ 5GHz (V) 1.32 1.3

BENCHMARKS
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SOLID-STATE STORAGE is one of the wonders 

of the modern world. Thinking about it, 

we’re reminded of the immortal words of 

Arthur C Clarke, the great science fiction 

writer. He reckoned that any sufficiently 

advanced technology seems like magic.

Go back 100 years, and what would 

anyone make of, for instance, a 256GB 

MicroSD card? The notion something so 

tiny could store hundreds of thousands of 

books would surely seem like witchcraft. 

Nowadays, it’s pretty impressive that you 

can bag a 128GB USB stick for under $25.

Despite that, SSDs aren’t yet the default 

option for mass storage. That will happen 

eventually. But not yet, not even thanks to 

Crucial’s 2TB MX300. It’s about as close 

as you’ll get to a really big SSD aimed at 

a mainstream audience. At $549, however, 

it’s getting on for 10 times the price of the 

cheapest 2TB magnetic hard drive.

Of course, the MX300 still majors on 

capacity rather than performance. That’s 

because it’s a SATA drive, rather than a PCI 

Express model, which brings limitations in 

terms of the peak bandwidth on the SATA 

interface and the inefficiencies of the AHCI 

protocol it uses. The latter never being 

designed with solid-state storage in mind.

Thus, we’re talking peak claimed 

performance around 500MB/s for reads 

and writes, and IOPs a fair bit below 

100,000. The 2TB MX300, incidentally, 

has the same claimed performance for 

sequential throughput and IOPs as the 1TB, 

The cheapest  
2TB SSD in town

750GB, and 525GB MX300 models. Only 

the entry-level 275GB model differs with 

slightly lower performance. It also shares 

the familiar Marvell 88SS1074 controller 

with the rest of the MX300 family.

Similarly, this 2TB model uses the 

same 384Gb TLC 3D flash memory dies 

as previous MX300s. It’s that unusual 

capacity per die that leads to the MX300 

range having odd sizes, with this drive 

serving up 2,050GB. The MX300 range also 

has a dynamic write acceleration mode 

that switches a portion of the memory to 

SLC mode for increased performance. For 

the 2TB model, the amount of memory that 

can be switched to SLC mode is increased. 

The MX300 also comes with Crucial’s 

SSD management software, which enables 

you to tweak settings and performance. 

Among other features, you can update the 

firmware, monitor the health of the NAND 

chips, and toggle the Momentum Cache 

feature, which uses system memory to 

buffer random writes.

If all that reads like a feature list without 

much real-world analysis, the truth is that 

the MX300’s real-world performance isn’t 

all that interesting. SATA SSDs such as 

this are a fairly mature technology, and 

the limitations we mentioned mean there’s 

zero chance of this drive setting any new 

records. What you want is a reliable drive 

with no performance nasties. That’s what 

the 2TB MX300 largely delivers.

In our synthetic performance tests, it 

delivers pretty much exactly what you’d 

expect, with peak performance around 

500MB/s, and 4K results in the mid-20MB/s 

area for reads, and 120–140MB/s for 

writes, depending on the benchmark app 

in question. It’s a similar story of generic 

SATA drive performance in our real-world 

compression and copy benchmarks. All of 

which means the MX300 ultimately trades 

on price, which is handy, because it’s 

comfortably the cheapest 2TB SSD you can 

currently buy. –JEREMY LAIRD

Crucial  
MX300 2TB

8
VERDICT Crucial MX300 2TB

BIG LEAGUE Mass-storage 

class capacity; very competitive 

pricing; no performance nasties.

ALTERNATIVE FACTS Mega money 

compared to a magnetic drive; PCI Express 

drives are far faster.

$549, www.crucial.com

Best scores are in bold. Our test bench consists of an Intel Core i7-7700K, an Asus ROG Maximus IX Hero, 16GB 
Corsair Dominator Platinum 2,400MT/s, and an Nvidia GeForce GTX 1080.

Crucial MX300 2TB OCZ Trion 100 960GB Samsung 850 Pro 2TB

AS SSD Incompressible 

Sequential Read/Write (MB/s)
469/480 513/436 513/499

AS SSD 4K Random  

Read/Write (MB/s)
24/119 31/92 41/126

ATTO Sequential  

Read/Write (MB/s)
526/535 564/517 404/427

5GB Zip (Seconds) 185 194 194

30GB Internal Copy (Seconds) 197 263 160

BENCHMARKS SPECIFICATIONS

Capacity 2,050GB

Memory Type TLC 3D NAND

Controller Marvell 88SS1074

Form Factor 2.5-inch

Interface SATA

Read Performance 530MB/s

Write Performance 510MB/s

4K Reads 92,000 IOPs

4K Writes 83,000 IOPs

Warranty Three years

in the lab
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IT’S VERY LIKELY end of days for Intel’s CPU 

strategy as we know it. We don’t mean that 

in an apocalyptic sense. Intel isn’t about to 

suffer an existential calamity. But AMD’s 

Ryzen processor is coming, and we’re 

confident it’s going to shake things up.

That’s the context into which Intel’s 

Pentium G4600 arrives. Based on the 

latest Kaby Lake microarchitecture, it’s 

very much a child of the last five years 

or so, when Intel ruled on the high seas, 

across the land, and up in the air. Within 

that narrative, the fact that Intel has 

bequeathed the G4600, plus two other 

new Kaby Lake Pentiums, with Hyper-

Threading capability constitutes news.

Hyper-Threading is the ability for each 

CPU core to process two software threads 

in parallel. And it’s been baked into every 

Intel Core processor since Nehalem in 

2008. Actually, it’s rumored that it was also 

in the Core 2 Duo, just not enabled. And, of 

course, it was first seen in the Pentium 4 

Netburst chip way, way back in 2000.

The point is that it’s always in any 

desktop CPU model you buy from Intel; it’s 

just enabled or disabled to help cook up a 

few different chip models. It’s the sort of 

ruse you can get away with when you have 

little to no competition—a situation that 

prevails today, but isn’t going to last.

Anyway, the Pentium G4600 slots in at 

$82, and offers up two Hyper-Threading 

enabled 3.6GHz cores, supported by 3MB 

of cache memory. And that’s pretty much it 

Hip, hip, hooray for 
Hyper-Threading

for the CPU side of things. There’s no turbo 

mode, and the CPU multiplier is locked, so 

overclocking is essentially a non-starter.

Like all mainstream desktop CPUs, the 

processor cores are only half the story—

literally, as integrated graphics make up 

almost half of the G4600’s 14nm CPU die. 

In this case, it’s an Intel HD Graphics 630 

GPU, at the top end of the smaller of the 

two graphics cores Intel is sticking in its 

Kaby Lake chips. It has 24 execution units 

to the 48 of the Iris Plus cores. So, even by 

integrated standards, it’s nothing special. 

But for $82, you aren’t getting special.

What you are getting is very good 

single-threaded performance. The G4600 

cranks out 151 points in Cinebench R15 in 

single-threaded mode. The Core i7-7700K 

manages 182. Put another way, if all you 

were interested in was single-threaded 

performance, and overclocking wasn’t in 

your vocabulary, there’d be little reason to 

spend more than 82 bucks on a G4600.

Flick the multi-threading switch, on 

the other hand, and those numbers jump 

to 385 and 970. The 7700K is only a quad-

core chip, of course. The 10-core Core i7-

6950X monster will spew out about 1,750 

points in Cinebench. Then again,  it costs 

about 15 times as much. Arguably, then, 

what matters is that for general-purpose 

computing, the G4600 gets the job done. 

It feels perfectly zippy for web browsing, 

playing back HD video content, and most 

anything else you’re likely to do day to day.

It even turns in decent numbers in 

games, showing that the age-old problem 

of coding games to scale beyond a few 

cores remains. Just don’t try to use it to 

re-encode hours of 4K video or render a 

pro-level 3D scene. In the current reality, 

then, the G4600 is appealing. But change 

is in the air, and the measure by which CPU 

value is assessed could be very different 

within just a few weeks. –JEREMY LAIRD

Intel Pentium 
G4600

8
VERDICT Intel Pentium G4600

VALUE PROPOSITION Excellent 

single-threaded performance; 

very cheap for an Intel Core-based chip; it’s 

got Hyper-Threading!

INDECENT PROPOSAL Feeble multi-

threaded performance; locked CPU 

multiplier; might not look so cheap once 

AMD shakes things up.

$82, www.intel.com

Best scores are in bold. Our test bench consists of an Asus ROG Maximus IX Hero, 16GB Corsair Dominator 
Platinum 2,400MT/s, and an Nvidia GeForce GTX 1080.

Intel Pentium G4600 Intel Core i5-7600K

X265 Benchmark (fps) 7.8 15.9

Cinebench R15 Single/Multi Core (Index) 151/385 179/663

FryRender Benchmark (m:s) 8:56 5:46

AIDA64 Memory Latency (ns) 61.3 58.1

Power Draw Idle/Load (W) 46/69 44/103

Total War: Attila @ 1440p (fps) 36 40

Far Cry Primal @ 1440p (fps) 76 77

3DMark Fire Strike Dedicated GPU (Index) 11,679 15,762

3DMark Fire Strike Integrated GPU (Index) 1,003 1,159

BENCHMARKS SPECIFICATIONS

Base/Turbo Clock 3.6GHz/NA

Cores/Threads 2/4

Lithography 14nm

Cache 3MB

Memory Support DDR4 2,400MT/s

Memory Channels Dual

Max PCIe Lanes 16

Graphics Intel HD 630

Graphics Clock 1,150MHz

TDP 51W
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THERE’S LITTLE WE LOVE more than a 

case that cuts that fine line between 

sophisticated and garish. Corsair has long 

been a master of balancing on that knife 

point, its chassis beautifully comprised of 

elegant panels shaped in a manner that 

would put Apple’s design studios to shame. 

But they’ve always come at a cost. Literally. 

Most of the high-end cases pass the $100 

mark by a mile, with only the Carbide 400C 

scraping in just under the margin, and 

anything else relegated to ITX lovers.

The Carbide 270R bucks that trend. 

Coming in at a reasonably affordable $70, 

it’s the first Corsair case that incorporates 

the look and feel of the more sophisticated 

400C but at a more aggressive price 

point. The front panel curves down into a 

smooth, brushed aluminum-effect plastic 

finish, with the front I/O tucked away down 

the side in a recess. You’re not spoilt for 

choice there, though, with a single power 

button, two USB 3.0 ports, headphone and 

microphone pass-throughs, a hard drive 

operation indicator, and a single reset 

button. On either side (once you get past 

the front I/O), you’ll find a large section 

of filtered fan intakes, around one inch 

deep—more than enough to keep your 

choice of front system fans well fed.

Speaking of cooling, there’s room 

for a 360mm/280mm radiator in the 

front (3x 120mm fans or 2x 140mm), a 

240mm/280mm radiator in the roof (2x 

120mm/140mm), and a single 120mm 

radiator in the rear. Pretty neat, if water 

cooling is your thing. The vent on the roof is 

something of a nuisance, though. It’s really 

long—at first glance, you’d be forgiven for 

thinking you could mount three 120mm 

fans there. Unfortunately, it’s just shy of 

being the right size for that, although with 

a touch of modding and some seriously 

secure screws, it wouldn’t be too hard to 

mount a 360mm radiator in the top, then 

mount additional fans on to it. However, 

at that point, it may be worth just buying 

Classy chassis 
comprised of 
compromise

another chassis. Our biggest gripe with 

the top fan mount lies with the fact that it’s 

huge and has zero dust-filtering. If you’re 

running any setup other than exhaust, 

you’re going to have a bad time when it 

comes to keeping the inside of your chassis 

dust-free, and for a windowed case, that 

can be a real deal-breaker.

CONSPICUOUS BY ABSENCE
The rest of the chassis is very spartan. 

There’s no 5.25-inch drive bay, no hard 

drive cages in the front, and a simple three-

quarter-length power supply cover across 

the bottom of the rig, with a cable cutout to 

route those pesky front panel connectors. 

Turn the case around, and you’re greeted 

by one huge CPU cutout, two 2.5-inch SSD 

mounts on the back of the motherboard 

tray, and two 3.5-inch hard drive mounts 

on the left-most panel closest to the front. 

Cable tie points are plentiful, but there 

are no rubber grommets protecting the 

cable routing holes. Although not hugely 

important, it can help hide cable mess, and 

is something we’d have liked to have seen.

We can’t help but go back to that price, 

too, and compare it to the competition. 

For $70, you could get NZXT’s S340 case, 

which looks crisper and cleaner, and has 

substantially better dust filtration systems 

than the 270R. It is, however, more limited 

in its cooling support. But if that’s a 

problem, you could swap over to the Fractal 

Define S instead, coming in at $80, which 

provides you with full unhinged access to 

up to two 360mm radiators top and front—

but with an increase in size, and the lack 

of a PSU cover. The Corsair Carbide 270R 

is a happy medium between the two. It’s 

not perfect, but for the price, it’s damn 

impressive, and definitely one of our top 

three mid-range chassis. –ZAK STOREY

Corsair 
Carbide 
270R

8
VERDICT Corsair Carbide 270R

CARBON FIBER Stylish; good 

cooling support; easy to build 

in; PSU cover; intuitive storage design.

 CARBONITE Lack of dust filtering; 

confusing top cooling mounts; lack of 

rubber grommets.

$70, www.corsair.com 

SPECIFICATIONS

Form Factor Mid-tower

Motherboard Support ATX, microATX, 

Mini-ITX

Colors Available Black

Window Options With or without

3.5-inch Support 2

2.5-inch Support 2

Radiator Support 280mm front, 280mm 

roof, 120mm rear

Fan Support 3x 120mm front,  

2x 140mm roof,  

1x 120mm rear

Dimensions 20 x 8.3 x 18.1 inches

Graphics Card 
Clearance

14.6 inches

CPU Tower Clearance 6.7 inches

Weight 16lb

in the lab
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THIS IS NOT THE FIRST time Razer has 

unleashed the Kraken, and it’s not the 

first time we’ve faced it down. Its first go-

around, when we reviewed the shiny white 

Kraken Pro V1 in December 2015, didn’t 

exactly impress; its bass-above-all-else 

sound stage was a bit much, and we had 

trouble with the mic. Can this 7.1 model, 

which sits alongside the newly-tuned Pro 

V2, offer us something more palatable? 

We’ll address the issues we had with 

the original shortly—let’s begin with the 

benefits (or not) that the 7.1 offers over the 

Pro model. The most obvious difference is 

the lack of a four-pole jack, consigning the 

7.1 to USB-based use only. There’s also a 

bit of added virtual surround technology, 

Razer’s Chroma LED lighting, a MEMS 

microphone in place of the Pro’s more 

standard electret number, and active noise 

canceling through Razer’s Synapse app. 

Like the V1 before it, this Kraken is a 

mighty aluminum monster—light, strong, 

and padded to within an inch of its life. It 

has even fatter circumaural ear pads—

replaceable with oval models, which would 

suit larger ears, but only if you’re willing to 

pay for the upgrade—and despite its snug 

fit, this is a headset that you can wear 

from dawn to dusk without worrying about 

squeezing or discomfort. 

The 7.1 virtual surround is, frankly, a 

bit weird. It’s highly adjustable through 

the app, but so subtle that it might as 

well not be there. When you do happen to 

catch a moving sound, it feels as though 

the Kraken is painting more of a vertical 

than horizontal picture, a disconcerting 

sensation, which throws one out of the 

game somewhat. The Chroma lighting, 

similarly, might as well not be there, 

seeing as you’ll ideally be wearing this 

headset rather than looking at it. It’s all 

about making a statement to those around 

you; if you’ve been dying to state “my ears 

are glowing purple,” more power to you. 

Here’s something the Kraken 7.1 V2 

does oh-so-right, though: its 5V-powered 

microphone. Retractable into the 

earphone and perfectly poseable, the 

microelectromechanical, fully silicon-

based construction of the mic pulls in a 

Exploring the 
depths of bass

clear, rich, quality sound that’s leagues 

above any tiny electret in this price 

bracket. The noise canceling is decent, too. 

This is an utterly, utterly impressive piece 

of gear. We’d like to see MEMS spread 

all the way across the mid-level headset 

market, and it’s a valid reason—one that 

isn’t silly pretty lights—to settle for USB-

only headset solutions.

BASS CAMP
That’s one check in the box, then. So 

what of that all-important sound stage? 

We were a bit concerned when Razer 

described it as “louder” than its older 

sibling, which we diagnosed with acute 

Gamer Syndrome, as it leaned so heavily 

on the bass. Let’s begin with the good 

news: through Razer’s 50mm drivers, 

the crackles of treble and burbles in the 

middle are present and sound perfectly 

correct. You won’t be dragging anyone in 

to listen to your new headset, but there’s 

nothing missing, and a rich, satisfying level 

of sound reproduction is on offer. But then 

the bass kicks in, and those clear tones get 

hammered down by a relentless assault of 

low-frequency sound, boosted to within an 

inch of its life, and sometimes beyond the 

point of clarity. It’s more pleasant than its 

predecessor, and you can futz with the EQ 

controls in Synapse to calm it down a little 

(or, if you’re a real masochist, switch on the 

unnecessary bass boost), but this headset 

is positioned as a skull-shaker, and that’s 

precisely what it does. And, overall, it is 

objectively a better headset than the first 

wave of Kraken cans. 

The microphone is out of this world, the 

padding luxurious, the gimmicks ladled on, 

and the sound, er, enhanced. But you’ll find 

a much more balanced sound elsewhere 

in the market. This is an explosive gaming 

headset, and if you’re not consistently 

immersed in a world of combat, you’ll 

be disappointed. –ALEX COX

Razer Kraken 
7.1 V2

7
VERDICT Razer Kraken 7.1 V2

CRACKIN’ Tremendous mic; 

supremely comfortable; 

tweakable sound.

 CACKIN’ Over bass-heavy; poor 7.1; 

pointless lighting; USB only.

$99, www.razerzone.com

SPECIFICATIONS

Driver Type 50mm neodymium

Impedance 32 ohms

Frequency Response 12Hz–28KHz

Design Style Closed back

Microphone Type MEMS

Connectivity USB 2.0

Weight 12.3oz

Cord Length 6.6 feet
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STEELSERIES: a legend in the hardware 

world. Its reputation is only trumped by 

its own new products supplanting itself 

on the way to the top of the peripheral 

hill. The company is neither the huge 

production foundries of Logitech, churning 

out hundreds of thousands of products 

each year, nor the niche-audience-slaying 

design houses of Mionix or BenQ Zowie, 

but a happy mix of the two. And that 

balance speaks volumes. With a legacy 

encompassing products such as the 

Sensei ambidextrous gaming mouse, the 

HV3 lineup of headphones, and even the 

first ever Rival, SteelSeries has definitely 

cemented its place in our hearts when 

it comes to those additional little input 

methods we use on our prized systems. 

That said, mouse development seems 

to have come to a grinding halt, certainly 

as far as innovation is concerned. With 

high-dpi optical sensors now perfected, 

RGB lighting mastered, and a plethora 

of mice in a variety of shapes, sizes, and 

button complements, it’s hard to imagine 

where the pointy rodent will go next. Well, 

that’s what we thought, until two mice 

in particular caught our attention in the 

last 12 months: Mionix’s vital-statistics-

tracking Naos QG, and SteelSeries’s 

extravagant flagship, the Rival 700. We 

didn’t manage to get the latter into the mag 

at the time—not for lack of trying, mind 

you. We initially had our hands on a sample 

in the office way back in April 2016, when 

we thought it was absolutely fantastic. 

However, due to SteelSeries’s concerns 

with the braided cables being too “grippy,” 

the company (frustratingly) delayed the 

release, and took the mouse back to the 

drawing board for another four months, 

to redesign the cable—yep, SteelSeries is 

that serious.

THINKING OUTSIDE THE BOX
So, here we are at last, with the mythical 

beast sitting in front of us. The SteelSeries 

Rival 700. We rarely speak about the 

unboxing experience in our reviews, but 

with the Rival, it’s something else. You get 

a small rectangular box, split diagonally. 

Opening it up on its hinge reveals nothing 

Perfection in non-
ambidextrous form

more than the mouse itself and a small 

cardboard box. You’d be forgiven at this 

point for thinking that the Rival 700 is a 

wireless mouse—it’s only when you dig a 

little deeper that you begin to understand 

what’s going on. In short, the choice of 

cable rests with the consumer. You get 

one six-foot braided cable, one six-foot 

plastic-coated cable, plus a plastic-coated 

three-foot cable. On top of that, you can 

also swap out the cover on the rear belly 

of the mouse to either a glossy black or an 

anti-sweat soft-touch variant instead ($15 

for the pack). 

And then, of course, there’s the sensor. 

By default, the Rival 700 comes with 

an optical PixArt 3360, pumping out a 

whopping 16,000 dpi if needed, with zero 

hardware acceleration. However, if optical 

is simply not your jam, you can grab 

yourself the PixArt 9800 laser module 

instead for $25. Simply unscrew the four 

Phillips-head screws underneath, place 

your new sensor inside, and wham-bam-

thank-you-ma’am, you’re all set.

Customization aside, there’s a few little 

extras that really make the Rival 700 stand 

out. You can’t quite seen the OLED screen 

in the above shot, but it enables you to slap 

any number of small GIFs or images on 

the side of the mouse, alongside in-game 

notifications—not particularly useful, 

granted, as you should be looking at the 

screen. But what’s most impressive is the 

inclusion of rumble feedback—you can 

assign tactile feedback to any of the seven 

buttons, in a variety of ways. Although not 

hugely useful for the two main buttons, 

having a tactile response from whichever 

button you press helps train your brain to 

use buttons that you would otherwise get 

confused about, making it one neat and 

surprisingly useful addition. The vibrations 

themselves are exceedingly precise, 

and don’t cause any jitter in your mouse 

positioning. We bound this feature to one 

of our focus buttons in Sniper Elite V3, and 

had no trouble picking off targets at our 

usual rate.

All in all, the SteelSeries Rival 700 is a 

well-tuned, customizable gaming mouse 

at the pinnacle of its field, designed to 

incorporate absolutely everything in 

today’s gaming mouse market. It does cost 

$80, which is a lot for a pixel-pointer, but 

it’s well worth it in our eyes. –ZAK STOREY

SteelSeries 
Rival 700

9
VERDICT SteelSeries Rival 700

TRUMP VS. HILLARY Fantastic 

optical sensor; strong 

ergonomics; no hardware 

acceleration; classy design; 

strong software suite; tactile 

feedback; swappable cables and sensor.

MCDONALD’S VS. BURGERKING A touch 

too pricey.

$80, www.steelseries.com

SPECIFICATIONS

Sensor Optical

Sensitivity 100–16,000 dpi

Sensor Model PixArt Technologies 

PMW3360

Polling Rate 125Hz, 250Hz, 500Hz, 

1,000Hz

Programmable 
Buttons

7

LEDs Two-zone—16.8 

million colors

Cable Lengths 6ft and 3ft

Weight 4.8oz

in the lab
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WE LIKE ASHAMPOO. It’s hard to hold anything 

against a software company whose slogan 

is “We make software!” And we admire its 

directness—even if we’re not totally sure 

about that name. 

We respect it, too, for still making 

burning software in 2017, when the world 

has long since moved on to flash or cloud 

storage for transferring files. There are 

a great many uses for those shiny disks, 

however, and with BDXL discs capable of 

holding 100–128GB of data, the market for 

them as an archivable backup solution is 

strong. But in a world where you can find 

DVD burning apps for free on the Internet, 

why go to the effort of paying for one?

 Fans of the Burning Studio series will 

no doubt be wondering why Ashampoo has 

done a Microsoft and skipped a number, 

going straight from Burning Studio 16 to 18. 

Something to do with 17 being an unlucky 

number, apparently, and anyone who’s felt 

better for noticing that a building lacks a 

13th floor will surely sympathize with that. 

So, what’s here that’s worth paying 

for? Free apps tend to be limited in scope, 

so having every feature in one place is 

certainly nice. Along with the standard 

burning of data folders to a disc, and the 

production of audio CDs, you get a mode 

that tunes a disc especially for the model of 

For those who haven’t dumped the optical drive
stereo in your car. Now, we’ve never had a 

problem getting in our Benz and worrying 

that a CD might have been made with a 

Ford in mind, but we’re talking about MP3 

CDs here, and not all car stereos want the 

same folder structure from a disc, so it’s a 

thoughtful inclusion. The app also includes 

an equalizer for tweaking the output of your 

music files when burning as a standard 

audio disc.

Movies get a similar level of attention 

to detail—with MPEG-4, H.264, and AAC 

added to the list of supported formats, the 

masterpieces you shoot on your cell phone 

can be committed to shiny polycarbonate 

for posterity. That these are also common 

formats found on torrent sites (or so we’re 

told) is merely a happy accident. The app 

wants to be an editing suite, too, bringing in 

cuts and transitions, sound effects, photo 

slideshows, and a cover designer.

It’s also a backup app. Large amounts 

of data can be stored across multiple 

discs, thanks to disc-spanning, and there’s 

compression and password-protection, 

too. The main reason you’d want to do this 

rather than chuck everything on a suitably 

sized external hard drive is longevity—while 

most disc formats offer only a lifespan of up 

to five years, Millenniata’s M-Discs claim 

up to 1,000 (although this is difficult to test; 

we’re working on communicating with some 

cyborg future-Zak to find out if they live up 

to their promise). That’s the kind of long-

term data archival capability untouched by 

hard drives.

You’re mainly buying convenience and 

peace of mind when you purchase an app 

like this. With so many functions bundled 

into one package, you’d have to skip across 

several free apps to get the same level of 

service, and deal with a dearth of updates, 

or poor coding, or a lack of compatibility 

with disparate hardware. If disc-burning 

is still something that’s important to you, 

Burning Studio 18 is packed full of features 

and works well. Anyone else should just buy 

a big USB drive. –IAN EVENDEN

Ashampoo Burning Studio 18

Ashampoo Burning Studio 18

THE BURN Comprehensive 

features; useful backup 

capabilities; straightforward 

to use.

THE BIRD Many PCs now sold without 

optical drives; 2TB hard drives are cheap .

RECOMMENDED SPECS Dual-core 1.8GHz 

CPU; 2GB RAM; at least 128MB VRAM; 

Windows 7 or newer.

$60, www.ashampoo.com

7
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We can see our house from heeeeeeerrrrrrre! 
Steep
THERE’S A POINT in Steep when the 

mountain starts talking. It has an echoing, 

female voice, the sort of thing you’d expect 

from millions of tons of rock if it had 

been possessed by the spirit of Galadriel, 

perhaps seeking a winter getaway. 

It’s odd, because you’re not expecting 

it—up to this point, you’ve been encouraged 

to jump off things, and whoop it up—and 

what the mountain says cuts to the heart 

of what Ubisoft intended with the game. It 

describes itself as a playground, a place to 

make memories, and takes things too far by 

pretending to be puzzled by the weird “skis” 

people are using on its slopes. 

Skiing is one of four sports in the 

game—five, if you count walking. There’s 

snowboarding and paragliding, too, or you 

can ease into a wingsuit, dragging one of Far 

Cry 4’s more distinctive modes of transport 

out of the closet, and jump off a mountain 

whenever the mood takes you. 

Graphically, there’s a lot of white, 

although special mention has to be made 

of the crunchy snow simulation, even 

if it sometimes appears too “digital”—

your board leaves a distinct pattern of 

depressions, rather than cutting smoothly 

through—and the curious lack of feedback 

from running over someone else’s trails. 

The ability to change the time of day is a nice 

touch, as are the hot air balloons, anchored 

somehow in the air above the Alps to provide 

additional launching points for wingsuiters.

Imagine a Far Cry game with no main 

quest drawing you to specific areas. Instead, 

wherever one side-quest takes you, you 

pick up three more. You can go where you 

want, and progress is made by completing 

events, scoring points by performing tricks, 

discovering areas, missing obstacles, and 

finding creative routes down the mountain. 

As you advance, more areas unlock, and you 

get a feel for the mountains. They really are 

a playground, with no penalties for messing 

up, and speedy restarts if you really can’t 

get back to the course.

We had a few moments when we 

couldn’t, the game finding it impossible to 

decide what to do with our boarder when he 

encountered the back of a building, or one of 

the interminable snow fences that litter the 

Steep

 DEEP Good sense of speed; 

plenty to discover; well-

calibrated controls.

 WEEP Occasional glitches; inconsistent 

collision detection; patchy signposting.

 RECOMMENDED SPECS Intel Core i7-3770K 

@ 3.5GHz or AMD FX-8350 @ 4.0GHz; 8 GB 

RAM; GeForce GTX 970 or Radeon R9 390.

$50, http://steep.ubisoft.com, ESRB: T

8
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Events sometimes see you 
joined by NPCs, or you can 
team up with human players.

Complete an event, and you 
keep going, ready for the next.

Trudging uphill to a 
start point is a pain.

Skiing backward is 
easy, and trees don’t 
mind if you hit them.

landscape. Instead, it decided to spin him 

around, flipping from left to right so fast 

that the game couldn’t keep up (the frame 

rate was locked at 60 for most of our time 

with the game, sacrifices being made in the 

fidelity of distant objects rather than let the 

fps dip). And once Steep crosses the line 

from a game about barreling down hills as 

fast as you can to one of pure analog control, 

that mountain’s words start to make a lot 

more sense. This is a playground, and it’s 

through exploration and having fun that you 

can make it your own. –IAN EVENDEN

in the lab
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Shadow tactics: stand by wall with sun behind you

Shadow Tactics:  
Blades of the Shogun
FROM A ROOFTOP, you see it all. The guards 

move in predictable patterns, their vision 

cones making it explicit what they can and 

can’t see. Your samurai partner is in some 

bushes just behind a guard and his officer, 

though neither is looking in his direction. 

Up high across the map, a sniper awaits 

your command. All you have to do is spin 

the winch, and a crane will drop its load 

on three guards, while your samurai cuts 

down his two, and the sniper drops the 

remaining witness. They carry out their 

orders simultaneously, and there’s nothing 

left to stop you entering the next area.

Shadow Tactics’ name reveals its 

purpose. A top-down stealth game, 

rendered in a lovely, painterly style, it’s 

probably not pushing your GPU as hard as 

Dishonored 2 would, but taxes the wetware 

between your ears just as much. Its world is 

one of predictable patterns and overlapping 

attention spans. Opportunities overlap, 

coalesce, and dissolve as you watch, until 

you judge the moment is right to strike. 

With up to five characters under your 

control, attacks can get complex. You can 

use your heroes one at a time, but entering 

Shadow Mode allows you to set up moves 

in advance, which are then carried out 

at the press of a key, and this can lead to 

perfectly timed ambushes or, more likely, 

abject failure. So load and have another 

go. The game absolutely encourages you to 

quicksave, even going as far as assigning 

it a button on the controller, if you’re using 

one. It nags you if you’ve spent as much as 

an entire minute without saving, but only 

offers your last three saves for reloading. 

This makes it a game in which trial and 

error are the way forward, but one that’s 

not going to punish you too badly for making 

the latter, despite its occasionally punishing 

difficulty level.

It may be set in Edo-period Japan, with 

shogun, samurai, and shinobi taking major 

roles, but Shadow Tactics evokes a later 

period in world history and an earlier one 

in videogames: the WWII-set Commandos 

games. This isn’t a bad thing, as it’s 

always good to see fresh ideas pumped 

into a stale genre. It’s been 14 years since 

Commandos 3: Destination Berlin, which 

Shadow Tactics:  
Blades of the Shogun

 LIGHT Engaging tactical 

gameplay; appropriate art style; simple 

control scheme.

 DARK Can obscure the way ahead; 

animations rely too much on bobbing 

heads; quicksaving may annoy purists.

 RECOMMENDED SPECS Intel i3 fourth-gen 

3.5GHz or AMD quad-core 3.9GHz; 6GB RAM; 

Nvidia GTX 570 or AMD Radeon HD 6950.

$40, www.shadow-tactics.com, Not ESRB rated

8
VERDICT

Being discovered brings extra guards 
running from nearby buildings.

now sounds rather like a movie portraying a 

bachelor party, in which someone thinks it’s 

hilarious to dress up as a Nazi, rather than a 

gritty wartime tactics game.

In doing this, Shadow Tactics feels like 

something new, even if it’s just the latest 

point on a line that stretches back to the 

original Syndicate. It would be easy to 

imagine this harsh but mostly fair game in 

third-person, à la Hitman, but we’re glad it’s 

remained the way it has. –IAN EVENDEN 
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JARRED WALTON, SENIOR EDITOR

I’VE BEEN HEARING about AMD’s Zen, now 

Ryzen, for what feels like forever. The Zen 

architecture was first mentioned in 2012, 

and ever since, the repeated refrain of AMD 

CPU apologists has been “just wait for Zen.” 

That wait is finally over, and Ryzen is now 

available. But as we go to print, I still don’t 

know exactly what AMD’s Ryzen lineup will 

be in terms of core counts, clock speeds, 

and pricing. It’s quite the contrast compared 

to AMD’s open discussion of the Ryzen 

architectural details, not to mention Intel’s 

routinely leaked product roadmaps.

Here’s what I do know. AMD is planning 

on a full release of Ryzen processors, all 

multiplier unlocked. Ryzen uses a quad-

core module as its building block, with 

SMT providing eight threads, similar to 

Intel’s Hyper-Threading, and 8MB L3 cache. 

AMD claims a 40 percent improvement 

in IPC compared to its existing Excavator 

architecture, with clock speeds of at least 

3.7GHz on the eight-core part. Architectural 

changes include a reworked, more efficient 

pipeline. Each core is a six-wide superscalar 

design (four-wide fetch), compared to the 

previous four-wide design, the branch 

prediction is more accurate, and cache 

latencies and bandwidth are both improved. 

The result is that Ryzen should be much 

more competitive with Intel’s CPU offerings.

Interestingly, AMD apparently won’t have 

a six-core model; instead, it will have an 

eight-core chip without SMT as its mid-tier 

offering. That means that at each product 

segment, AMD will deliver double the cores/

threads as Intel. Intel will almost certainly 

maintain its lead in per-core performance, 

but if 4C/8T Ryzen SR3 goes up against 

Core i3’s 2C/4T design, or 8C/8T Ryzen SR5 

versus Core i5’s 4C/4T, even with slightly 

lower clock speeds, Ryzen should come out 

ahead in many benchmarks. We’ll have the 

full skinny next month.

Double the cores, double the fun, but no six-pack

AMD’s Ryzen 
Looks Promising

There’s this trend in the PC 

space called “gaming.” What 

does that mean? Contrary 

to what you might think, it’s 

hardware that puts aggressive 

aesthetics and RGB lighting 

before useful innovation. 

Manufacturers are marketing 

the living diodes out of 

hardware, and attaching the 

word “gaming” to just about 

anything. Unsurprisingly, a 

Why don’t we include the price 

of the operating system in our 

builds and system features? 

It’s a question that often 

comes up in the office. For 

the most part, we shy away 

from the decision, because 

the needs of the individual vary 

massively across all of our 

readers—some use Ubuntu, 

others Debian, Windows 7, 10, 

and so on. That said, if you’re 

lot of “gaming” gear doesn’t 

do anything for actual gaming 

performance. It just means 

you’re going to pay more for 

something made cheaply, to 

cash in on the gaming train. 

This isn’t about choice or 

taste. It’s about the definition 

of gaming. Give me quality and 

performance over marketing 

hype and gimmicks any day. I’ll 

take the cost savings, too.

resolutely stuck on Windows, 

but don’t want to cough up 

$100 for the latest version, 

there is another option: the 

Windows Insider Program. 

Simply create a Windows Live 

account, sign up to the Insider 

Program, download and install 

the Windows 10 technical 

preview, and you get a fully 

unlocked version of Windows 

10 for free.

TUAN NGUYEN 

Editor-in-Chief

ZAK STOREY 

Reviews Editor

Making AMD CPUs competitive again.
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WE HAVE A PENCHANT at Maximum PC for 

high-quality audio. Although there are 

some pretty snazzy gaming headsets, 

they tend to meander well into the $250-

plus range for anything close to decent 

sound reproduction.

Turn your head to audiophile offerings 

without a microphone, however, and 

you can easily find pairs for under 

$150 (Audiotechnica’s ATH-M50Xs, 

for example). For the vast majority, 

no mic is no problem, but for gamers, 

lacking a way to communicate with your 

buddies can be a deal breaker. And for 

those unwilling to chunk out for a $200 

dedicated desktop microphone, there’s 

not a huge deal of choice.

Except, maybe there is. Antlion saw 

this gap in the market, and jumped in 

with this fantastic modular microphone.

Available in two models, the 4 and the 

5 (the 5 has both a four-pole and a USB 

adapter), the ModMic attaches to the 

side of any headset with a small adhesive 

magnetic clip. Don’t need the mic today? 

Pull it off your headset, and place it in 

its faux leather case. Sound quality is 

impeccable, and the mic supports up to 

24-bit 192KHz without worry, delivering 

some fantastically crisp and clean sound; 

not too bass-heavy, not too tinny. The 

adhesive sticker is easy to remove, and 

it comes with a variety of clips to secure 

the ModMic’s cable to your standard 

headphone cable, too. There’s very little 

to dislike—we just wish it rotated a bit 

better on that magnetic mount. –ZS 

$50, www.antlionaudio.com

Antlion Antlion
ModMic4

TRON V9.9.0

Being my family’s on-

call tech support, I’ve 

run into my fair share of 

systems compromised 

by a pile of bloatware, 

unnecessary toolbars, and viruses. Most 

of us know the standard system recovery 

utilities—CCleaner, Malwarebytes, and their 

ilk—but there’s an even better option, before 

going nuclear, and reinstalling the OS. 

Tron is an open-source script that 

automates the full process of cleaning and 

disinfecting a Windows system. First, it 

preps your system, creating a restore point, 

and running tools and scripts that ensure 

the rest of the process runs smoothly. Next, 

it runs cleaning utilities such as CCleaner 

and BleachBit, followed by de-bloating, 

ditching OEM bloatware, toolbars, and other 

pre-installed apps (excluding useful stuff 

such as Calculator and Paint). Disinfection 

is handled by Malwarebytes, KVRT, and 

Sophos, while a series of scripts check and 

repair Windows. Finally, Tron updates and 

optimizes your system, patching Adobe, 

Java, and whatever else needs updating.

It’s an impressive list of tasks that should 

take care of almost any problem. Even 

better, it’s a single download that, once 

started, runs itself—though it can take six to 

eight hours to finish.

Free, www.bmrf.org/repos/tron

DISKDIGGER  

My smartphone recently 

decided that it no longer 

liked my microSD card. 

I can’t remember if it 

was after a restart or 

update, but my screen displayed a prompt 

saying that the Samsung microSD wasn’t 

recognized, and would I like to try to format 

it? An offer that the phone couldn’t deliver 

on, as it appeared to have been corrupted. 

Long story short: No matter how many 

machines, adapters, tools, and OSes I tried, 

I couldn’t get the card to play nicely again. 

A dead microSD card is hardly the stuff 

of nightmares, particularly as the data that 

really matters was automatically uploaded 

to my Google account. Even so, it’d be good 

to take a look at what’s on the card before I 

consign it to the big trash bin in the sky. 

The problem is that Android 6.0 has 

changed the way it handles SD cards, so 

plugging the card into Windows (or Linux) 

reveals nothing. So I turned to file recovery 

tools to see what was lurking beneath its 

seemingly blank surface. One tool that did 

well, and was free to try, was DiskDigger—a 

portable app that scans for a selection of 

files, and allows you to save them off with 

minimum fuss. It took a while to scan the 

entire card (30 minutes for 32GB), but did 

recover a few MP3s and a couple of log files.

$15, www.diskdigger.org

Bo Moore, technology editor, and Alan Dexter, 
executive editor, share their latest tech loves

Editors’ Picks: 
Digital Discoveries
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comments you write, we respond

WE TACKLE TOUGH READER QUESTIONS ON...

Cooler Fans
Zak’s piece on his upgrade 

build had me reading it at 

least six times to make sure 

I learned all there was to 

be learned (“The Ultimate 

Upgrade,” Feb 2017, pg. 68). 

There was one confusing 

part, though: I could not tell 

if he replaced the very good 

stock fans on the new NZXT 

Kraken cooler with Corsair 

MLs, or if he added them to 

the inside of the radiator, 

meaning the radiator would 

have four fans in push-pull. 

I can’t tell if the two stock 

fans are there on the front of 

the case, or if he discarded 

them and replaced them 

with the Corsair MLs.

For a new builder, fan 

placement and control is 

very confusing.

My first build is about to 

be the Kaby Lake i7-7700K, 

Be Quiet! Dark Base Pro 

900, and I just switched the 

cooler from the Corsair H115 

to the NZXT Kraken X62, 

which he loved in his build 

(you used the 52, but also 

said 240 radiators now had 

less appeal, and suggested 

280 radiators, with 140 

fans). I’m also using the MSI 

GeForce 1080 Seahawk X 

GPU, which has a radiator 

and included Corsair fan.    

That means I have three 

brands of new PWM LED 

fans to deal with: the three 

Be Quiet! fans on the case, 

the Corsair fan on the GPU 

radiator, and two NZXT fans 

on the Kraken cooler. All of 

these stock fans are LED 

and PWM. I was tempted to 

change them for matching 

Corsair MLs with white 

LEDs, but decided not to. 

Zak added two Corsair fans 

to the inside of the Kraken 

radiator. Did he replace the 

two stock fans on the Kraken 

radiator with the two Corsair 

MLs, or are there four fans 

in push-pull? –Greg Johnson

REVIEWS EDITOR ZAK STOREY 

RESPONDS: The fan situation 

was a mixed bag. I knew 

I wanted to use Corsair’s 

ML120s, because I wasn’t 

massively fond of Corsair’s 

old-school SP series, due 

to the excessive noise they 

produced. The ML120s drop 

well below 500rpm, and 

produce Noctua-rivaling 

figures, so they were 

definitely my preference.

Originally, due to the 

lack of available airflow in 

the S340 Elite, I intended 

to run the Kraken X52 in a 

push-pull configuration, 

like you said. I actually went 

out and bought another 

two ML120 Pros—but just 

the standard ones. Theory 

being, I could place them in 

push configuration, at the 

front of the radiator, out of 

sight, and then have the LED 

variants pulling air through, 

while on display. 

Unfortunately, the cable 

tidy bar NZXT includes 

stops you from installing 

an additional pair of fans 

inside the chassis, because 

the bar sticks out at an odd 

angle at the top, preventing 

the radiator or fans coming 

back any further. On top of 

that, you can’t mount them 

outside the chassis in the 

inch of space given by the 

front panel for airflow, as 

you’ll suffocate them, and 

there’s also the magnetic 

dust filter in the way, too.

I’m a bit particular when 

it comes to cooling, and 

prefer all the fans to be the 

same model, as (I like to tell 

myself) it gives me a greater 

understanding of the noise 

and airflow I’m passing 

through the system. I also 

love consistency when it 

comes to aesthetic decisions 

like that. So, I’m not actually 

using push-pull, but if I 

could, I would. 

Apples and Oranges
On page 53 of the February 

issue, the table says 

the Core i5-7600 is 31 

percent faster than the 

Core i7-7700T (3.8 versus 

2.9Hz). This surprised me. A 

few years ago, I got a Core i7 

with a Lenovo T440P, and 

was never that impressed 

with the speed. I just 

assumed it would be faster 

and better than any Core i5. 

Now I’m confused about 

what to buy when I next 

upgrade in a year or two. I’m 

a business user, with some 

heavy computing with Visio 

plugins, running semantic 

web inference engines, 

and I use Lightroom a fair 

bit, but no video editing. 

I’m not a gamer. The last 

game I played was Q-Bert 

at a grocery store in 1980. I 

got addicted and quit, cold 

turkey. –Michael Uschold

EXECUTIVE EDITOR ALAN 

DEXTER RESPONDS: The 

frequency of a processor 

shouldn’t be confused with 

its performance. A single-

core CPU running at 5GHz 

will be thrashed in most 

metrics by a quad-core 

chip running at 2.5GHz. 

Generational improvements 

can also be a factor—a 

modern chip running at the 

same frequency as an older 

model will outperform it, 

especially with laptops—a 

lot of Intel’s advances have 

focused on mobile.

As far as your specific 

comparison goes, it is a bit 

> Replacing Fans
> Core i5 vs. Core i7
> sOwnCloud Woes

↘ submit your questions to: comments@maximumpc.com
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more complex, because 

you’re pitching a full-

fledged desktop Core i5 (the 

7600K has a TDP of 91W) 

against a low-power Core i7 

(the 7700T has a TDP of just 

35W). So while the Core i5-

7600K does run at 3.8GHz, 

and the Core i7-7700T runs 

at 2.9GHz, they’re designed 

with very different uses 

in mind—the Core i7 can 

be found in tiny NUC-sized 

machines, while the 7600K 

is for more bullish systems. 

Given what you use your 

machine for, though, I’d 

recommend a top-end Core 

i7, although which particular 

model you go for depends on 

what machine you’re looking 

to buy—your options for 

laptops are more limited by 

thermals than what you’ll 

see in desktops, and some 

of Intel’s naming conditions 

can be confusing (the Core 

i7-6500U, for instance, only 

has two cores), so it pays to 

look at the details. 

Raspberry Cloud
I am having trouble with 

the “Create a Pi Cloud with 

OwnCloud” feature from the 

November issue, and have 

spent hours trying to figure 

out issues on my own. I am 

having trouble installing 

OwnCloud (the current 

version is now 9.1.3). Yes, I 

did read the update in the 

“Letters” of the magazine’s 

Holiday 2016 issue.

Here is where I am stuck: 

 sudo chown -R www-data:

 /var/www/html/owncloud/

{apps,config,themes,updater,

.user.ini}

chown: cannot access ‘/var/

www/html/owncloud/apps’: 

No such file or directory

–Joseph Keller

EXECUTIVE EDITOR ALAN 

DEXTER RESPONDS: There’s 

no doubting the appeal 

of running your own 

cloud server, but getting 

a server up and running 

isn’t always easy. Even 

with a detailed tutorial 

that runs through the main 

installation, there’s going to 

be problems—in order for 

it to work, there are certain 

dependencies that need to 

be sorted, such as a working 

database to operate from, 

a web server to integrate 

with, and a whole host of 

permissions to sort out. 

While it looks like it’s file 

ownership that has tripped 

you up, the fact that you’re 

getting a “No such file or 

directory” error suggests 

it’s the previous step that 

has failed. Just to recap 

the process: You need to 

download the latest version 

of OwnCloud from https://

owncloud.org/install, making 

sure you get the OwnCloud 

server build, the one that 

has the “tar.bz2” extension. 

Next, go into a terminal 

window, and make your 

way to wherever you’ve 

downloaded it, then unpack 

that tarball with:

 $ sudo tar -C /var/www/html 

 -xf owncloud-9.1.3.tar.bz2

Make sure the files are 

unpacked by browsing to 

/var/www/html/, and 

making sure there is an 

“owncloud” directory, and 

there are files inside it. Only 

then can you change the 

ownership of those files. 

We ran through the 

whole tutorial again, just to 

make sure (using a laptop 

running Ubuntu 16.04, which 

forced us to do a few things 

differently), but it definitely 

does work. So keep going, 

and good luck!

Not an Upgrade
I do not agree with the fuss 

Alan Dexter made about 

Windows 10 activation, 

and, based on Windows 10 

licensing, I don’t believe he 

was eligible for activation of 

Windows 10 on his computer. 

What he describes as an 

upgrade is really a new PC. 

So, to expect Microsoft to 

recognize that he had done 

a simple upgrade to his PC 

is ridiculous. There was 

nothing left in the machine 

to identify the old computer.

It is also obvious that he 

was basing his complaint 

on an OEM license, which 

is not transferable to a 

new computer. The idea 

that he considered this an 

upgrade is baffling. I have 

done upgrades with a fresh 

install of Win 10 without a 

key, and Win 10 activated 

automatically because it 

recognized the computer.

Your magazine caters to 

advanced computer users, 

and your readers expect 

advanced technical info and 

advice. –William LeDuc

EXECUTIVE EDITOR ALAN 

DEXTER RESPONDS: We’ve 

upgraded lots of machines 

without issue here on 

Maximum PC, but that 

wasn’t the point of my 

rant—it was the fact that 

the process can go wrong, 

and when it does, it’s 

frustrating. For instance, 

when you say, “there was 

nothing in the machine to 

identify the old computer,” 

I assume we have to ignore 

the SSD? Or the fact that 

said installation was tied to 

a Microsoft Live account? 

Just to reiterate why 

I had to upgrade in the 

first place, it wasn’t on a 

whim; it was because the 

motherboard had failed. And 

as a seasoned upgrader, 

you’ll know that when your 

motherboard dies, it isn’t 

always easy to find direct 

replacements, so before 

you know it, you’re looking 

at a major overhaul. There’s 

nothing in the Microsoft 

licensing agreement that 

prevents this, at least on 

a full or upgrade license. 

As you say, an OEM license 

does prevent certain 

upgrades (and, indeed, 

direct technical support), 

but that wasn’t the case 

here—something underlined 

by fact that the machine was 

activated after talking to a 

support engineer. 

While you may not agree 

with the fuss I made, and it 

may not line up with your 

experiences, highlighting 

problems where they exist, 

and making our readers 

aware of potential problems 

(and their solutions) is 

part of what we do here on 

Maximum PC. 

95MAXIMUMPC

[NOW ONLINE]

WHICH GRAPHICS SETTINGS 
SHOULD I DISABLE?

We love cranking game 

settings up to 11. But even 

with top-end hardware, 

there are some settings that 

offer little visual difference 

but can have a large impact 

on your frame rate. And 

if you’re running on older 

hardware, you should 

turn these down to boost 

your frame rate without 

making everything look 

terrible. Graphics options 

and their impact vary from 

game to game, so it’s a 

good idea to check out a 

game-specific optimization 

guide, but we’ve come up 

with a selection of settings 

that generally provide 

the least “bang for your 

buck” in terms of detail 

versus performance.

http://bit.ly/2jpIvKh

maximumpc.com SPRING 2017



The home of technology

techradar.com



97MAXIMUMPCmaximumpc.com SPRING 2017

   

Sponsored by

KABY LAKE COMETH, and although it seems to have added very little 

to overall performance, it’s difficult to argue with a new chipset 

and slightly better performance for the same price. This month, we 

decided to piece together something of a themed build. This checks 

all those clichéd red and black boxes, the color scheme that’s 

become synonymous with gamers. We also decided to change a few 

things around in an attempt to bring the storage up to modern-day 

standards—or at least, more modern. Dropping Samsung’s 850 Evo 

250GB SSD, we went with Intel’s 600p M.2 PCIe SSD instead. At only 

$3 more, this budget offering tops out at nearly 1,600MB/s sequential 

reads for snappy program load times. Trying to scrape back a bit of 

cash, we dropped the WD Black drive for a Blue variant instead, saving 

us a sweet $25, and we also went for an ever so slightly cheaper kit 

of DDR4. 

WHAT A PRICE DROP THIS TIME AROUND! This issue enlightened us 

about one key tidbit of information when it comes to system building: 

In this day and age of supercharged IPC performance, the desire 

for a more substantial processor on a base system like this is null 

and void. As long as your GPU has the necessary heft, and you’re 

buying a modern CPU, you’re not likely to encounter any bottlenecks. 

This is where the Pentium G4600 comes in. At $90, it’s a wallet-

pleasing $115 cheaper than the Core i5 we recommended in last 

month’s issue—and, honestly, you won’t lose a lot by jumping ship. 

And if you’re just looking for a standard office PC, you can strip out 

the GPU, swap out the SSD for a 120GB variant, along with a 500GB 

HDD, and that’ll take this already paltry figure all the way down to 

an outstanding $438—not including a copy of Windows 10, of course 

(which we talk about on page 92). 

blueprinta part-by-part guide to building a better pc

INGREDIENTS INGREDIENTS

PART  PRICE

Case NZXT S340 Elite                                                  $100

PSU EVGA SuperNOVA 550 GS Gold                       NEW $80

Mobo MSI Z270 Gaming M3                                         NEW                               $160

CPU Intel Core i5-7600K                                             NEW $250

Cooler Corsair H100i v2                                                                       $103

GPU EVGA GeForce GTX 1070 SC Gaming ACX 3.0                                             $390

RAM 16GB (2x 8GB) G.Skill V Series DDR4-2400    NEW $92

SSD 256GB Intel SSD 600p M.2 PCIe                     NEW                     $100

HDD Western Digital Blue Series 1TB 7,200rpm  NEW $50 

OS Windows 10 Home 64-bit OEM                $100

PART  PRICE

Case Phanteks Enthoo Evolv ITX                                $70

PSU EVGA 450B Bronze                                               $45

Mobo MSI B250I PRO Mini ITX                                          NEW $90

CPU Intel Pentium G4600                                               NEW $90

GPU Zotac GeForce GTX 1060 Mini 3GB    $195

RAM 8GB (2x 4GB) Avexir Core Series DDR4-2400   NEW $52

SSD 240GB PNY CS1311                                                   NEW   $60

HDD 1TB Hitachi Deskstar 7,200rpm 3.5-inch SATA NEW $44

OS Ubuntu Desktop Linux 16.04 LTS 64-bit $16

Approximate Price: $1,425 Approximate Price: $662

MID-RANGEBUDGET
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Approximate Price: $2,769

INGREDIENTS

PART  PRICE

Case Fractal Design Define Mini C Windowed NEW $88

PSU EVGA SuperNOVA G2 750W    $100

Mobo EVGA X99 Micro 2                          NEW                               $183

CPU Intel Core i7-6800K   $440

Cooler NZXT Kraken X52 240mm AIO              NEW $150

GPU EVGA GTX 1080 SC Gaming ACX 3.0           NEW $590

RAM 32GB (4x 8GB) Corsair Dominator  

Platinum DDR4-2400        NEW $250

SSD 1TB Samsung 960 Pro M.2 NVMe SSD    $630

HDD 2x 2TB WD Black 7,200rpm 3.5-inch SATA     $238

OS Windows 10 Home 64-bit OEM                                                      $100

THIS MONTH HAS SEEN the biggest changes ever hit to our Turbo build. 

We decided it was time we appeased the small form factor gods by 

opting for this classy yet powerful microATX system. The decision 

came about primarily because of the phenomenal saving we could 

achieve on the EVGA X99 Micro 2. At $183, it’s over $40 cheaper than 

the MSI X99A SLI Plus from last issue, yet it still provides us with all 

the connectivity and power we were utilizing anyway. Because of this, 

we had to swap out the chassis to something more fitting—Fractal 

Design’s Define Mini C Windowed edition—shaving off another $82, 

and then managed even greater savings by swapping from MSI’s GTX 

1080 Gaming X to EVGA’s SC Gaming ACX, which propped us up with 

another $60 on top. This meant we could plump for some fancier 

accessories elsewhere, and still save a boatload. We bumped up the 

cooler to the stunningly beautiful NZXT Kraken X52 AIO, and could 

even afford to drop another $30 on Corsair’s legendary Dominator 

Platinums. We also saw a price drop of $84 on Samsung’s 960 Pro 

1TB. What this all adds up to, even with the splurge on prettier 

cooling and memory, is a saving of $186 over last issue. Pump that 

into the processor, and you could grab the slightly better specced 

Core i7-6850K to net an additional 12 PCIe lanes and a 0.2GHz core 

clock increase at stock. However, we’d advise you to just grab a 

custom cable kit and some better fans instead.  

UPGRADE OF THE MONTH

Choosing how to cool your prized processor is always a curious 

decision. For instance, forking out extra cash for what amounts 

to a slim 240mm radiator rarely offers any greater advantage 

over another model, outside of a better designed fan and 

easier mounting solutions. However, we just can’t get past 

how fantastic the Kraken X52 is. With a plethora of lighting 

options, it’s a meeting of minds between the gaming RGB craze 

that’s been forced upon us and a desire to retain a degree of 

professionalism that, arguably, all our readers wish to see in 

their purchases.

$150, www.nzxt.com 

NZXT KRAKEN X52
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